
 

PROCAD > PRO.FILE > Manual 

– 

 

 

Operation PRO.FILE advanced 
PRO.FILE Release 8.7 

June 2017 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Information contained in this publication may be changed or modified without notice, resulting in no obligation on the part of “PROCAD GmbH 

& Co. KG“. The software described in this document is made available under license agreement. The software may only be used and copied 

under the terms described in the agreement. 

The subject matter of the contract shall solely consist of the sold product with its properties and characteristics as well as the usage purpose 

according to the relevant product description. The user manual shall be considered as relevant source for the technical product description. 

Other or additional properties and/or characteristics or other usage purposes shall only be considered as agreed upon when expressly confirmed 

by us in writing. 

The document is protected by copyright. All rights, also those including the translation, re-printing and copying of the documents or parts thereof 

are reserved.   

No part of the documentation may be reproduced in any form (photocopy, microfilm or any other technique) or used for teaching purposes or 

processed, copied or distributed using any electronic form without the written permission of PROCAD GmbH & Co. KG. 

 

Registered Trademarks: 

PRO.FILE is a registered trademark of PROCAD GmbH & Co. KG 

These and all other product and company names mentioned in this publication are subject to the protection of brands and trademarks and 

belong to their respective owners. 

Responsible for Content: 

PROCAD GmbH & Co. KG 

Vincenz-Prießnitz-Straße 3  76131 Karlsruhe  info@procad.de  www.procad.de 

Copyright  PROCAD GmbH & Co. KG  All rights reserved 

 

mailto:info@procad.de
http://www.procad.de/


Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 3 of 241 

Table of contents 

Table of contents ........................................................................................................................... 3 

About this manual .......................................................................................................................... 9 

1 PRO.FILE Advanced – Creating, Managing and Changing ..................................................... 10 

2 The PRO.FILE objects: An overview ..................................................................................... 11 

2.1 For explanation: Documents and document types ....................................................................... 12 

3 The PRO.FILE GUI ........................................................................................................... 13 

3.1 The PRO.FILE Cockpit .............................................................................................................. 14 

3.2 Working with forms, lists and browsers ....................................................................................... 17 

3.2.1 Sidestep: Input masks and output masks .................................................................................... 20 

3.2.2 Working with forms .................................................................................................................. 20 

3.2.3 Working with lists ..................................................................................................................... 21 

3.2.4 Working with Browsers .............................................................................................................. 30 

3.2.5 Displaying thumbnails in lists and forms ..................................................................................... 39 

3.2.6 Printing forms, lists and structure displays ................................................................................... 40 

3.3 The file preview ........................................................................................................................ 40 

3.4 The dependent tabs in PRO.FILE................................................................................................ 42 

3.5 The PRO.FILE fields: How can I enter data? ............................................................................... 45 

3.5.1 Use multiline-fields to present multiline texts ............................................................................... 49 

3.5.2 Category fields ......................................................................................................................... 50 

3.5.3 Enhance reference lists directly in PRO.FILE ................................................................................ 52 

3.6 The PRO.FILE data fields: Working with SmartLinks ..................................................................... 55 

3.6.1 The context menu for opening, linking and copying a SmartLink .................................................. 56 

3.6.2 Creating links from SmartLinks via drag & drop .......................................................................... 57 

3.7 Tip: Customize the GUI to your needs ....................................................................................... 57 

3.7.1 Setting up the dependent tabs ................................................................................................... 58 

3.7.2 Arrange list views and save them ............................................................................................... 61 

3.8 Export the contents of lists and browser displays to Excel ............................................................. 64 

3.9 Tip: Customize the Cockpit ....................................................................................................... 66 

3.9.1 Adjust Cockpit "Layout" ............................................................................................................. 67 

3.9.2 Adjust Cockpit "Logo" ............................................................................................................... 68 

3.9.3 Adjust Cockpit "Full-text search", "Search", "Create" and "Recently used" ........................................ 69 



Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 4 of 241 

3.10 The buttons – an overview......................................................................................................... 70 

4 The PRO.FILE register tabs ................................................................................................ 72 

4.1 The menu "File" ........................................................................................................................ 73 

4.1.1 Viewing PRO.FILE system information ........................................................................................ 75 

4.1.2 Defining the PRO.FILE default actions ........................................................................................ 76 

4.1.3 Settings for the start and shutdown of PRO.FILE .......................................................................... 77 

4.1.4 Change the currently logged on PRO.FILE user .......................................................................... 78 

4.1.5 Change the PRO.FILE password ................................................................................................ 79 

4.2 The tab "Start" .......................................................................................................................... 80 

4.3 The tab "Edit" ........................................................................................................................... 81 

4.4 The tab "Search" ....................................................................................................................... 81 

4.5 The tab "View" .......................................................................................................................... 82 

4.5.1 Display a bill of materials for a selected part .............................................................................. 84 

4.5.2 Updating lists and forms ........................................................................................................... 86 

4.6 The tab "Window" ..................................................................................................................... 86 

4.6.1 Display tabs in a separate window ............................................................................................. 87 

4.7 The PROOM tab ...................................................................................................................... 89 

4.8 How do I access the PRO.FILE online help? ............................................................................... 90 

4.9 Tip: Quick access to functions via the Quick Access Toolbar ....................................................... 91 

5 Searching and finding: selecting data records ...................................................................... 92 

5.1 Searches using the search form ................................................................................................. 93 

5.1.1 Search for specific types of documents ....................................................................................... 96 

5.1.2 Search for specific part characteristics ........................................................................................ 98 

5.1.3 Narrow down a search result .................................................................................................... 99 

5.1.4 Narrow down the search for parts using the selection filter .......................................................... 99 

5.1.5 Usage of part characteristics in the selection mask of documents and CAD-data ........................ 101 

5.2 For data and files: the "Full-text search" .................................................................................... 101 

5.2.1 Start the full-text search from the "Search" tab ........................................................................... 102 

5.2.2 Start the full-text search from the PRO.FILE Cockpit .................................................................. 105 

5.2.3 Tips on using the search function "full-text search" ..................................................................... 106 

5.3 Note: Optimize your search by using wildcards ........................................................................ 108 

5.4 Search using relative dates ...................................................................................................... 109 



Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 5 of 241 

6 Functions of the favorites bar ........................................................................................... 114 

6.1 SmartSearch: Create your own form ........................................................................................ 115 

6.1.1 Access an existing SmartSearch ............................................................................................... 116 

6.1.2 Create a new SmartSearch ...................................................................................................... 119 

6.1.3 Transform a completed standard search into a SmartSearch ..................................................... 124 

6.1.4 Permanently change an existing SmartSearch ........................................................................... 126 

6.1.5 Delete a SmartSearch? ........................................................................................................... 126 

6.1.6 Rename a SmartSearch........................................................................................................... 128 

6.2 Saved searches and subscriptions ............................................................................................ 129 

6.2.1 What are saved searches and subscriptions? ............................................................................ 129 

6.2.2 Working with saved searches and subscriptions ........................................................................ 132 

6.2.3 Create a new saved search ..................................................................................................... 134 

6.2.4 Example: creation, enhancement and reduction of saved searches ............................................ 136 

6.2.5 Copy saved searches .............................................................................................................. 139 

6.2.6 Create a new subscription ....................................................................................................... 140 

6.2.7 Saved searches with relative time entries .................................................................................. 140 

6.2.8 Create folders to structure the favorites .................................................................................... 142 

6.2.9 Change the contents of saved searches ................................................................................... 143 

6.2.10 Delete saved searches and users from the list ........................................................................... 144 

6.2.11 Access other users’ saved searches .......................................................................................... 145 

6.2.12 Public saved searches ............................................................................................................. 145 

6.3 Working with folders ............................................................................................................... 146 

6.3.1 Folder types ........................................................................................................................... 146 

6.3.2 Create, edit and delete folders ................................................................................................ 147 

6.3.3 Data structure with folders....................................................................................................... 148 

6.3.4 Duplicate folder ..................................................................................................................... 148 

6.3.5 Display and manage folders in the favorites bar ....................................................................... 150 

6.3.6 Quick saving of files via drag & drop ....................................................................................... 151 

6.3.7 Configure folders for quick save .............................................................................................. 152 

6.3.8 Delete fast-check-in configuration of a folder ........................................................................... 154 

7 Working with documents in PRO.FILE ............................................................................... 155 

7.1 Create new document description ........................................................................................... 155 

7.1.1 Save files in PRO.FILE using drag & drop ................................................................................. 156 



Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 6 of 241 

7.1.2 Check in files and directly link them ......................................................................................... 157 

7.1.3 Create document description "New with data" .......................................................................... 157 

7.2 The PRO.FILE Checkin wizard ................................................................................................. 158 

7.2.1 Checkin wizard Step 1: Creation of the document description in PRO.FILE ................................. 158 

7.2.2 Checkin wizard Step 2: Assignment of the created document to a PRO.FILE project .................... 161 

7.3 Opening a document file ........................................................................................................ 162 

7.3.1 Change documents ................................................................................................................ 164 

7.3.2 Modify document description .................................................................................................. 164 

7.3.3 Check out document file for editing ......................................................................................... 165 

7.3.4 Note: Change document type ................................................................................................. 165 

7.4 Opening and editing a document file ...................................................................................... 166 

7.5 Further functions for document management ........................................................................... 167 

7.5.1 Delete documents .................................................................................................................. 167 

7.5.2 New version of documents ...................................................................................................... 167 

7.5.3 Status change of documents ................................................................................................... 167 

7.5.4 Export / Import of documents with PRO.FILE (Option) ............................................................... 168 

7.6 Note: Document management using drag & drop .................................................................... 173 

7.6.1 Retrieve files as a copy using drag & drop ................................................................................ 173 

7.6.2 Display documents in MS Excel or MS Word using drag & drop ................................................. 174 

7.6.3 Save entire folders .................................................................................................................. 174 

7.6.4 Drag & Drop from the documents list ....................................................................................... 175 

7.6.5 Drag & Drop from the Parts List ............................................................................................... 175 

7.6.6 Drag & Drop with the Bill of Material Editor ............................................................................. 175 

7.6.7 Drag & Drop for the transfer of PRO.FILE data to MS Excel ....................................................... 176 

7.6.8 Combined documents ............................................................................................................ 176 

7.7 Optional: Save encrypted files from Boxcryptor in PRO.FILE ...................................................... 177 

7.7.1 The configuration settings for Boxcryptor at your computer ........................................................ 177 

7.7.2 Initial saving of encrypted files in PRO.FILE............................................................................... 178 

7.7.3 Change encrypted files from PRO.FILE ..................................................................................... 179 

7.8 What happens if I exit PRO.FILE while documents are still checked out? ..................................... 180 

8 Working with parts in PRO.FILE........................................................................................ 182 

8.1 Create new part ..................................................................................................................... 183 

8.2 Modify part ............................................................................................................................ 184 



Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 7 of 241 

8.3 Delete part............................................................................................................................. 185 

8.4 Duplication of parts ................................................................................................................ 186 

8.5 Copy part master data ............................................................................................................ 189 

8.6 Copy node data ..................................................................................................................... 189 

8.7 Parts: working with the Bill of Materials .................................................................................... 189 

8.7.1 Add positions to the bill of materials ........................................................................................ 190 

8.7.2 Indenting, outdenting, moving up and down ............................................................................ 193 

8.7.3 Numbering ............................................................................................................................ 194 

8.7.4 Changing information on the position...................................................................................... 194 

8.7.5 Delete Position ....................................................................................................................... 195 

8.8 Link parts ............................................................................................................................... 196 

9 Locking and unlocking of PRO.FILE objects........................................................................ 197 

9.1 Locking and unlocking of part descriptions ............................................................................... 198 

9.2 "Lock" the document ............................................................................................................... 199 

9.3 The "Unlocking" of documents ................................................................................................. 200 

9.4 More information: the dependent tab "Status information" ......................................................... 200 

10 Copy and link PRO.FILE Objects ...................................................................................... 201 

10.1 Linking of PRO.FILE objects ..................................................................................................... 202 

10.1.1 Copy the object reference to the PRO.FILE clipboard ................................................................ 202 

10.1.2 Creating a link between PRO.FILE objects ................................................................................ 202 

10.2 Versions and link types: static and dynamic links ....................................................................... 202 

10.2.1 Document-Document links ...................................................................................................... 203 

10.2.2 Links between transmittals and documents ............................................................................... 203 

10.2.3 How to change the link type .................................................................................................... 204 

11 PRO.FILE status management: Support and Control your Workflow ....................................... 205 

11.1 Transfer of a document, part or project into another status ........................................................ 206 

11.1.1 Status change depending on several users ............................................................................... 206 

11.2 The functions "Seen and approved" or "Seen and rejected" ........................................................ 208 

11.3 Problems with status changes .................................................................................................. 208 

11.4 Status change top-down ......................................................................................................... 209 

11.5 Real-time simulation of the function "Status change top-down"................................................... 210 

11.5.1 Problems during Status change top-down ................................................................................ 211 



Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 8 of 241 

11.6 Notify .................................................................................................................................... 211 

12 Transmittal: digital dispatch list with PRO.FILE .................................................................... 212 

12.1 What is a transmittal? ............................................................................................................. 212 

12.1.1 Informal or referencing: What types of transmittal do exist? ....................................................... 213 

12.2 Working with "Transmittals" ..................................................................................................... 214 

12.2.1 Step 1: Creating a transmittal.................................................................................................. 214 

12.2.2 Step 2: Link documents to be transferred to the transmittal ........................................................ 215 

12.2.3 Step 3: Lock transmittal and send it ......................................................................................... 216 

12.3 Further Functions for transmittals ............................................................................................. 218 

12.4 Link between transmittals, documents and projects ................................................................... 219 

12.5 Delete a transmittal ................................................................................................................ 220 

12.6 Functions to lock/unlock a transmittal ...................................................................................... 220 

12.7 How to send a transmittal ....................................................................................................... 221 

12.7.1 Using the report interface (option) for transmittals ..................................................................... 221 

12.8 Via transmittal: Data exchange from PRO.FILE to PROOM ........................................................ 221 

12.8.1 Step by step: Data from PRO.FILE to PROOM .......................................................................... 223 

12.8.2 Step 1: Creating a transmittal.................................................................................................. 223 

12.8.3 Step 2: Link documents to be transfered to the transmittal ......................................................... 224 

12.8.4 Step 3: Lock transmittal and send to PROOM .......................................................................... 225 

12.8.5 Step 4: The "Publish" dialog .................................................................................................... 226 

12.9 Dependent tab: Information on the sending ............................................................................. 228 

12.10 Manage PROOM access ........................................................................................................ 230 

13 Optional: The PROOM Integration in PRO.FILE ................................................................. 232 

13.1 Settings for the PROOM access ............................................................................................... 232 

13.1.1 Initial settings for the PROOM access ...................................................................................... 232 

13.1.2 Change the settings for the PROOM access ............................................................................. 234 

13.2 Upload documents from PRO.FILE to PROOM ......................................................................... 234 

13.3 Create PROOM folder during file upload................................................................................. 235 

13.4 Download files from PROOM to PRO.FILE ............................................................................... 236 

13.5 Start the PROOM Web UI ....................................................................................................... 236 

14 Annex: Update of the PRO.FILE WindowsClients ................................................................. 238 

15 Index ........................................................................................................................... 239



Operation PRO.FILE advanced Table of contents 

PRO.FILE Release 8.7 
June 2017 Page 9 of 241 

About this manual 

This PRO.FILE manual uses various signs and icons in order to guarantee a good 

readability and comfortable handling. 

For quicker finding within the manual, step-by-step instructions are marked with a 

margin heading. 

Menu sequences and function calls 
Menu sequences and function calls explained in this 

manual are marked in bold and in quotation marks. 

 Example:  

"File" => "New" => 

"Document description" 

Buttons and keys 
Keys and buttons are highlighted by angle brackets. 

 Example:  

"Confirm with <OK>." 

Notes and warnings 
To highlight special information the following icons are used: 

 

 

Function call: 

"PRO.FILE" => "Extras" => "Options" => "Performance" 

 

 

Example: 

Boxes marked with this icon give subject-relevant examples for the usage of command 

lines, configuration strings and other software-relevant entries. 

 

 

Note: 

Boxes marked with this icon contain useful hints on the operation, configuration or 

installation of the PRO.FILE software. 

 

 

Attention: 

All information given in these boxes is very important and should be read carefully! 

Non-observance of these hints may lead to wrong functioning, display problems or 

other negative consequences. 

 

 

Important notes:  

The "stop sign" warns you of possible entry or operation errors, which may lead to loss 

of data! 

 

 

Attention – Undo not possible: 

All entries and configurations described in these boxes have to be made carefully, 

because they cannot be undone! 

 

Step-by-step 

instructions: 
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1 PRO.FILE Advanced – Creating, Managing and 

Changing 

 This manual builds upon the manual "PRO.FILE for Beginners – Search, find, open" and 

contains extended information in the following chapters: 

 The PRO.FILE GUI 

 The PRO.FILE register tabs 

 Searching and finding: selecting data records  

 Functions of the favorites bar 

 Working with documents in PRO.FILE  

 Working with parts in PRO.FILE 

 PRO.FILE status management: Support and Control your Workflow 

 Via transmittal: Data exchange from PRO.FILE to PROOM 

 Optional: The PROOM Integration in PRO.FILE 

 Fehler! Verweisquelle konnte nicht gefunden werden. 

 

 

Note: Working with PRO.CEED projects, processes and tasks 

The functions for PRO.CEED processes, projects and tasks described in the context of 

PRO.FILE require a separate PRO.CEED license. 
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2 The PRO.FILE objects: An overview 

For the classification of data, PRO.FILE works with different object types: 

Documents: All files saved in PRO.FILE are saved under the object type 

"Document". For this purpose, a document description is 

created, containing classification information of the data. See 

the following chapter "Working with documents in PRO.FILE". 

Parts: Parts only consist of a "part description" in PRO.FILE. Part 

descriptions classify a design part or element. By the 

connection and structuring of parts, the bill of materials of an 

assembly is composed. The object "part" in PRO.FILE 

corresponds to an "article", "article master" or "material 

master" as often referred to in other systems.  

See "Working with parts in PRO.FILE". 

Projects: Projects are "case binders". Within a project you can collect 

documents, parts, tasks and sub-projects according to your 

requirements, structures, orders or product groups.  

In the second step, special permissions can be assigned to 

projects. This is done via the role concepts of PRO.FILE.  

For further information, please see the manual "Operation 

PRO.CEED Base". 

Folders: Folders are objects that can be used as structure objects in the 

context of projects or standalone and that can be linked to 

create larger structures of documents, parts, tasks, etc. 

Folders can also be used for the quick saving of files in 

PRO.FILE with automated classification of the document 

description. 

Transmittals: Transmittals are digital dispatch lists. See "Transmittal: digital 

dispatch list with PRO.FILE". 

Tasks: Tasks describe a specific activity or work assignment with a 

clearly defined date, duration and work information to be 

assigned to a user. It is possible to link documents and parts 

from PRO.FILE to a task. Tasks can be created separately or 

within the larger context of a process or a project. If a task is 

created within a project, the time components of the task are 

reflected in the Gantt chart of the project. 

Processes: Processes describe order of tasks for the definition of a 

specific business process, including the time components of 

the tasks. An example would be a "service request" which 

includes different steps for processing. It is possible to define 

sub-processes, which can be run in parallel. A pre-defined 

process is started in separate process instances. For more 

information, see the manual "Operation PRO.CEED Base". 
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2.1 For explanation: Documents and document types 

Various document types such as drawings, test reports, invoices, images, bids, 

documentation, faxes received etc. require specific fields for receiving information 

relevant to them. Thus the field "Invoice receipt" will be relevant to an invoice, but less 

likely so to a CAD drawing.  

The varied information requests can be classified, sorted and managed via special 

document types so that not all masks need contain all fields. For example invoices could 

containonly data relevant to invoices and "drawings" only data relevant to drawings.  

To this end individual document types are provided for various types of documents in 

PRO.FILE. Classification of documents is then effected via these document types. 

Likewise, a document type controls the "handling" of the associated document 

description in PRO.FILE 

In the process, document characteristics can be assigned to each and every one of 

these "document types". The fields of the assigned document characteristic are available 

via the selection of a document type, in addition to the fixed document description’s 

fields (which are identical for all documents).  

 

 

The following 

figure illustrates 

this. You can 

access the 

associated 

document 

characteristics by 

selecting the 

document type 

"CAD document" 

in the fixed 

document 

description: 
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3 The PRO.FILE GUI 

After logging in to PRO.FILE, the Cockpit appears, which gives you faster and easier 

access to stored data. See chapter: 

 The PRO.FILE Cockpit 

 

Once you have accessed and selected parts or documents the PRO.FILE user interface 

will appear. This interface, which is shown below, is divided into different areas: 

 

 

 The title bar shows the name of the logged-in user. When working with projects, it 

also shows the activated project and the corresponding project role. 

 The PRO.FILE register tabs contain the various commands and functions for the 

work with PRO.FILE. 

 The leading tabs display the result of a search in different display types. Each 

search opens a new main tab. The name of the tab corresponds to the search 

criteria. 

 The dependent tabs in PRO.FILE allow the quick access to additional information 

relating to the PRO.FILE object selected in the main tab.  

 Saved searches and subscriptions – Via the favorites bar in PRO.FILE, documents, 

parts and projects can be summarized in lists, which can be accessed via favorites 

for direct access without having to perform a corresponding search manually. 
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3.1 The PRO.FILE Cockpit 

After logging on to PRO.FILE, the Cockpit appears which gives you faster and easier 

access to stored data. 

This Cockpit will remain open after the opening of further lists and form displays. The 

Cockpit is always available via the main tab "Cockpit".  

 

The Cockpit page offers different options for quick access to data: 

 The full-text search:   

(The system administrator has to activate the full-text search in order for you to be 

able to use this function!) The input field "Full text search" in the upper corner of the 

initial screen allows you to search the document descriptions as well as the 

attached files or part descriptions in PRO.FILE for a certain keyword. Simply enter 

the word you are searching for into this field and use the drop down menu  to 

select the desired object type.  

 Then, click on the corresponding 

icon in order to initiate the full-text 

search. Any document descriptions 

and attached files or part 

descriptions that match your query 

will be displayed in a list of the 

results. 
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 Selecting objects:   
In order to access data records and 

to display them in PRO.FILE, a 

selection has to be made. This 

selection can be made by clicking 

the corresponding icons on the 

PRO.FILE initial page. This function 

can also be found in the "Selection" 

menu in the PRO.FILE menu bar. If 

you repeatedly make a certain 

selection, the favorites will be of 

great help to you. Please refer to 

chapter: "Searches using the search 

form". 

 

 Creating documents, parts or 

projects: If you wish to create a new 

document description, parts 

description or project description 

after logging on to PRO.FILE, you 

can do this using the corresponding 

icons on the initial screen.   

The storage assistant will appear 

which will help you with the creation 

of the data record. This function can 

be found in the tab "Start" located 

within the PRO.FILE tab bar. Please 

refer to chapters: "Create new part" 

and Create new document 

description" for further information.  

 

 

 Accessing recently used objects: You can find a list of recently used documents, 

parts, projects, etc. in the lower area of the Cockpit. You can use the displayed 

tabs to select the object type that you want listed:   

 

 

 

The list will always contain 30 objects that were last used. Double-clicking a list 

entry allows you to access the data record in a form view. Within the list you can 

also use the context menu of the right mouse button to open a menu with 

presentation and editing options.  
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 The file preview for documents: 
If the list of recently objects is used to display documents, a preview can be 

displayed for the selected document with a configured viewer.  

 

 

 

 

Note: Access to recently used documents via the PRO.FILE Jumplist 

In the Windows taskbar, the list of recently used documents 

can be accessed via the PRO.FILE program icon. 

Click on the PRO.FILE icon with the right mouse button and 

select the desired document from the list "Recently used". 

The selected document record is then displayed in PRO.FILE. 

 

 

 

The PRO.FILE Cockpit can be customized. There are several widgets, the contents and 

positions of which can be changed. 

The adjustment is made via the function "Customize Cockpit" from the "Window" tab. 

 

 

  

Customize the 

PRO.FILE Cockpit 
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Function call:  

"Window" => Area "Manage" => "Customize Cockpit" 

 

 

Note: A matter of permissions 

The customization of the PRO.FILE Cockpit requires the corresponding function access 

right. If the function "Customize Cockpit" is not displayed, you do not have this 

permission. 

 

After clicking on this function button, the left-hand side of PRO.FILE displays the area for 

customizing the Cockpit. A detailed description can be found in the following chapter: 

"Tip: Customize the Cockpit". 

 

3.2 Working with forms, lists and browsers 

There are different window types for the display of search results in PRO.FILE: 

 PRO.FILE form displays: Working with forms  

Display of a single data record in form view, with all available data fields displayed 

on the form. 

 PRO.FILE list displays: Working with lists  

Display of several data records, usually listed by a search criterion. 

 PRO.FILE browser displays: Working with Browsers   

The browser displays are usually not used to display single data records but rather 

their structures and links to other objects. 
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The different views contain different elements and features for the display and 

modification of data and information. 

These views are always displayed in the main tab or the dependent tab. Further 

information on tab usage can be found in the chapter: 

 The dependent tabs in PRO.FILE  

 

Only one record is 

shown in a form. 

Using the arrow 

buttons in the 

toolbar of 

PRO.FILE, it is 

possible to thumb 

through the forms.  

 

The display of a preview picture occurs in the forms "Display document" and "Check 

out document". The settings are made for this in the PRO.FILE form designer. 

 

  

Display as a form  
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If a file is attached to 

a document record, 

it would be shown as 

a bracket symbol in 

the first column of 

the list.  
 

If a preview picture, a thumbnail is saved to a document, it will also be displayed in the 

list. See also the chapter: "Displaying thumbnails in lists and forms". 

Permanent columns in a list that are always displayed and cannot be scrolled can be 

made to stand out using a different color. (See also the chapter "Arrange list views and 

save them"). 

The lists in PRO.FILE have full mouse wheel support.  

The highlighting of list entries is carried out by clicking on the required entry with the 

mouse button. If several lines are to be highlighted, the left mouse button should be 

clicked and dragged over the lines to be highlighted.  

Further information on working with lists, can be found in the chapter: "Working with 

lists". 

 

This display shows the links between the parts, documents and projects, plus it shows the 

corresponding structure levels:  

 

 

The browser display shows the structure overview, the usage proof, the part and 

document usage, as well as various bills of materials. 

The administration and the processing of the entries, positions, and links of this browser 

are carried out using functions available in the context menu, which can be activated 

using the right mouse button.  

While the structure overview shows which objects are attached to the active object, the 

usage overviews are listed in reverse order, and show in which of the structures the 

active object is built into. 

Display as a list  

Display in 

browser  
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3.2.1 Sidestep: Input masks and output masks 

There are two types of windows for the communication with the PRO.FILE user interface. 

The first type of window is for you to enter data into PRO.FILE, the other is for PRO.FILE 

to display data and information for you.  

A basic difference is therefore made between "input forms" and "output forms": 

 The entry of data and information for the filing and modification of data records 

and for the running of searches is usually done via input forms. 

 The display of data on the other hand is made in output forms via three different 

window types: 

 In forms 

 In lists 

 In browsers 

 

The difference between these two PRO.FILE basic form types is as follows: 

 Input forms   

enable you to enter information 

into PRO.FILE. This is used, for 

example, to select, create 

and/or edit an object. Please 

refer to chapter: "The PRO.FILE 

fields: How can I enter data?". 

 Output forms   

show you information that is 

saved in PRO.FILE, serves the 

information, and then shows it 

as a form, a list or a browser. 

 

 

 

Note: 

The structure and appearance of the input and output masks as well as the fields and 

data displayed therein are set by the system administrator in the form designer of the 

PRO.FILE Management Console. 

 

3.2.2 Working with forms 

One data record is shown on each page of the form display.  

The system administrator can determine by configuration, the way it looks, its contents, 

and the way in which the form is divided.  

Depending on the configuration, the fixed as well as the variable object master records 

will be shown in the form.  
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If several master records are found in a search, you can scroll from one to the other 

using the buttons  

  Previous data record  

  Next data record.  

You can switch between the form and the list view for the current data record by clicking 

the  icon.  

Forms are used both as input or output screens.  

Also, selection of and search for data records is carried out using forms: "Searches 

using the search form". 

 

3.2.3 Working with lists 

This chapter describes the possibilities that are available when working with lists in 

PRO.FILE. This includes: 

 "List structure" and "Select multiple data records" 

 Additional user information: "Symbols within the list" 

 Sort a list 

 Adjust column order and column width 

 Arrange list views and save them 

 Available list functions 
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The information concerning lists, refers to hit-lists, document lists, and part lists, and are 

described in the following sub-chapters. 

 

The active row is indicated by colored highlighting. 

 

All commands in list operation refer to the active row. You can change the active row by  

 clicking on a different row, or   

 switching the active row using the cursor to move up or down.  

 

How Select multiple data records do I select multiple data records and which will then 

be the current data record? 

If a data record is displayed as a form, it is automatically selected and with that the 

current data record.  

One data record is always active in a list but several can be selected. This current data 

record is encircled with a dotted line. All functions which are applicable to the individual 

data records apply to this line.  

 

 

A selection (clicking on the item) will also mark the current line. You can then move the 

selection using the cursor buttons.  

 

Various functions (so-called group functions such as Delete) can take effect on several 

data records simultaneously. The multiple selection is used for this.  

 If you hold down the SHIFT key while clicking, you can bring about a "from-to" 

selection (cf. operation of MS Windows).  

List structure 

Select multiple 

data records 

Multiple selections 
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 If you hold down CTRL while clicking, the multiple selection of non-contiguous 

individual data records will be achieved. (Cf. operation of MS Windows). A further 

click removes the marking again. The current data record cannot be deselected. 

Please note that the selected data record is not necessarily the active data record.  

 

What do the symbols within the list signify? 

 

 

The following symbols are used in the PRO.FILE list views to display additional 

information: 

 The paper clip symbol in the first line of the list indicates that a file is attached to 

the document description. The documents can be displayed using the structure view 

or the corresponding tab. 

 No file is attached to the document description if the field in the first column is 

empty; there is only the metadata of the document description.  

 This symbol within the document list indicates that older versions of the listed 

document are available.  

 The icons  /  show with their darker color shade for the selected document 

  that one or more older version(s) exist(s) for the selected document. 

  that one or more newer version(s) exist(s) for the selected document. 

 

 

Note: 

This symbol is not displayed for the very first document.  

Whether this symbol is displayed or not is set by the system administrator. 

 

  A symbol can be displayed to indicate a locked object. By default, this is 

indicated by a lock symbol. However, the system administrator can change this 

setting. 

  

Symbols within 

the list 
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  Workflow statuses, as well, can be indicated using symbols. A specific symbol 

can displayed for each specific status. The symbols used for the different statuses 

are decided by the system administrator at your company. The traffic light icons are 

examples for colored symbols indicating different statuses. Red means "In Progress", 

yellow means "Being reviewed" and green means "Being released". 

 

If a list is displayed in a tab within the PRO.FILE user interface, different list functions are 

available to you through the icons in the local toolbar. This is true for the leading tabs 

as well as for the dependent tabs:  

 

The icons available for the list functions are divided into two application areas:  

  

The first four icons offer various possibilities for marking the list entries.  

  

The following icons allow for a targeted search and filtering of data records within 

the list. The following functionalities are available through these icons:  

 

  Select all lines: This icon lets you mark and select all lines within a list. Any 

functions that can be used for multiple data records, e.g. a status change, can now 

be carried out collectively. 

  Toggle selection:   

By pressing and holding the <Shift> key it is possible to mark an area of lines. 

Several different lines are marked by pressing and holding the <Ctrl> key. If you 

wish to invert your selection, that is to mark everything that had been left unmarked 

and to unmark anything that had previously been marked, simply use this icon.  

  Hide selected lines:   

If multiple lines are marked within a list, these can be hidden using this icon. Of 

course, these marked data records will only be removed from the list and not from 

the database.  

 Show hidden lines:  

With this button, rows that have been hidden can be displayed again. 

  

Available list 

functions 

Selecting 
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 Search in all columns / Search in active columns:  

In order to be able to perform a targeted search for terms in the list, the user first 

has to select whether the search is to be carried out across all columns in the list or 

only for a specific column in the list. This is an either/or setting which means that 

one of the icons will always be activated. The activation is indicated by a colored 

framing.  

 : The search is performed across all columns in the list.  

  The search is performed for the active column only. A column is activated 

by clicking the respective column header.  

 Define Filter pattern / Filter: A character string can be entered into 

the entry field located within the icon bar. Here you can use the wildcards/meta 

characters described in the chapter "Note: Optimize your search by using 

wildcards".  

The wildcard "*" is not required all other wildcards can be used.  

 

The search for the entered character string is started using the  icon.  

If the search pattern is found, the respective data record becomes the active line. If 

the search string is not found, a message is displayed and you will remain in the 

active line.  

 Next found pattern: This icon is used to once again compare the entered filter 

pattern with the columns that are to be searched. The first data record found is then 

turned into the active line. 

 

 Hide/show filter :   
Via this button you can display functions for the advanced filtering of the list (see 

chapter "How can I filter results in lists?"). 

 

How do I sort a list, including multi-level sorting?  

Sorting functions enable the user to sort a list, in descending or ascending order, simply 

by clicking on the column header. The sorting order is indicaded by the arrow sign in 

the column header. 

It is also possible just using keyboard and mouse to carry out multistage sorting i.e. an  

arrangement of the data that takes into account several columns at once.  

This multiple selection sorting is carried out using the <Shift>-button.  

This is carried out as follows:  

1. Hold down the <Shift> key.  

2. Click on the first column that you want to sort, until the required sort direction is set.  

3. If you then click on a second column whilst still holding the <Shift>-key, this 

column will also be taken into account when sorting the columns.  

Search 

Sort a list 

Multi-level sorting  
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4. When you have finished selecting the columns for sorting, you can let go of the 

<Shift> key.  

 

The following screen shot shows an example of the multi-stage sort:  

 

 

The functions for sorting and adjusting column widths described above also apply to 

reference lists. Clicking the column header of a reference list sorts the list and displays 

list entries in the desired order.  

For this to function, you need to display reference lists as list view. 

 

The PRO.FILE list view gives you the possibility to group the data records found in a list. 

All columns can be used for grouping. The different levels of the grouping can then be 

expanded or collapsed, depending on your needs. 

 

The following example will explain this: 

1. In order to group a list you have to click on the column you want to start your 

grouping with.  

2. Then use the context menu to select the function "Group this column".  

 

 

 The first level of the grouping will now be displayed. The individual entries within 

this grouping can be shown or hid using the + and – symbols.  

 

Sortable 

Reference Lists  

Group list entries 
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3. You can now include any other column into the grouping. Simply click the desired 

column header and use the mouse to drag it into the upper grouping area.   

 

 

 

 By doing so you can now include all column headers into the grouping. You can 

also use the drag and drop feature to rearrange your grouping. Additionally, the 

sorting functions of the lists will remain available. 

 

 

 

4. In order to reverse the grouping, simply drag the column headers from the 

grouping area back to the list area. 

 

 

Note: 

A grouped list groups data from different data records with the same entries in the 

selected columns. The structure shown relates to the contents of the data records, and 

not to the link between the data records. 

These links between the data records are shown in browsers, and are described in the 

following chapter "Working with Browsers". 

 

Columns in the PRO.FILE lists can be moved to the required position using the drag & 

drop principle.  

 To do this, click on the relevant column and hold down the mouse button whilst 

dragging the mouse pointer to the position in which you want to have the column. 

Once you have the mouse pointer in the required position, you can let go of the 

button.  

Adjust column 

order and column 

width 
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 The width of the columns can also be altered, by moving the column separators 

apart in the column headers of the required columns.  

 Additionally, double clicking a column divider will result in optimizing the column’s 

width. The optimal width equals the maximum text length of data displayed in the 

column.  

 Once the list display has been optimized, the settings can be saved for future list 

views. The function "Save as", should be used from the context menu for list 

creation, as described in the chapter "Arrange list views and save them". 

 

In PRO.FILE, it is possible to only display the data records in a list that match specific 

selection criteria. 

By activating the filter function and clicking on a filter selection in a column of a 

PRO.FILE list, you can select the desired values from the display of possible values. After 

that, the list is automatically reduced to the selected hits. Once you remove the filter, the 

full list is displayed again. Apart from this default filter you can also specify custom text 

filters. 

 

 

Note: 

The filter functions are not available if the list is displayed in a separate window. 

 

To filter a list Proceed as follows 

1. Open a list in PRO.FILE via one oft he search functions. 

2. Select the icon  "Display/hide filter" from the icon bar above the list: 

 

 The list header now displayes the function icons for the list filters. 

3. Click the  icon to select the values from a list column, to which a filter is to be 

applied:  

 

 Via the selection "All" you can activate or deactivate all options. 

 You can now select the values to be used as filter. 

How can I filter 

results in lists? 
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 The list is now displayed with the results according to the filter specified in the 

column header:  

 

 

4. For the filters via the  button, you can also set a text filter:  

 

 

5. Furthermore, you can specify the filter type. To do so, click on the  icon and 

select the desired function:  

 

 

6. Finally, you can click on the  icon to remove the filter settings for a column. 

In order to delete the filter settings for the entire list, deactivate the filter function by 

clicking the  icon in the icon bar of the list. 
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3.2.4 Working with Browsers 

The third window type that is used for displaying data in PRO.FILE is the browser.  

The browsers show graphically, the links and the structure between different data 

records. In this way you can link parts, documents, and projects. The structures that 

result from this, are displayed in the browser.  

 

 

There are browsers for the general structure browser, the part usage browser and for the 

different bills of materials:  

In the structure browser, as well as in the document- and part-structure, all linked 

objects are shown that are attached to this object (referring to the highlighted object).  

 In the part usage browser, as in the document and the part usages, the structure is 

displayed backwards: The browser shows which structure the highlighted object is 

linked to, or built into.  

 The structure is built into the bill of materials according to the position of the 

individual elements.  

 

There are also other functions that can be used from the "Edit" tab or from the context 

menu, using the right mouse button.  

This menu contains the most important commands that enable working with the 

browser. In the browser, the context menu is dependent on the highlighted object, and 

enables quick access to the functions for editing parts, documents, and projects. 

 

 

Note for administrators: 

Icons can be used in the structure browser like in lists. 
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If a structure overview is activated, it is possible to call up the command "Editor" from 

the context menu using the right mouse button, or from the "Edit" tab.  

 

 

Using this function it is possible to edit the structure of documents and parts. Using the 

sub-functions:  

 "Parts": For editing part- part- links  

 "Documents": For editing document- document- links  

The relevant editor will be called up.  

The structures of the selected object types will then always be edited from the 

highlighted level.  

 

 

Note: 

This editor is only available for the structure overview, not for the proof of usage, and 

other browser presentations with backward-directional structures. 

The reason is that the editing of the backward directional structures is an extremely 

complex procedure, and does not always lead to future directional results. 

 

The structure 

overview editor  
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The following example shows the editor for the document- document- link:  

 

 

If the editor is activated, you can edit the structure overview using the "Edit" tab, or by 

accessing the context menu using the right mouse button. 

 

In order to apply functions in the browser view to several objects at the same time, the 

browser view has a multiple-selection mode. 

To use the multiple-selection mode, click on the icon  "Toggle between single and 

multiple selection" in an opened structure browser. The icon can be found in the icon 

bar on the left in the structure tab. 

 

 

  

Multiple selection 

in the browser 

view  
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With the activation of the multiple-selection mode, additional icons become available: 

  Select all (Ctrl-A) 

  Deselect all (Shift-Ctrl-A) 

  Select all visible sub-nodes(Ctrl-Click) 

  Deselect all visible sub-nodes (Shift-Ctrl-Click) 

  Expand all selected nodes (Alt-Click)  

  Expand structure – 2 levels  

  Expand structure – complete 

  Open selected elements in new window 

 

For all selected objects a collective function for the deletion of links can be called from 

the "Edit" tab. 

For multiple selections of objects in a project 

structure, the context menu offers the 

following functions:  

 "Delete": Deletes the link 

 "Type static": Changes the link type to 

static 

 "Type dynamic": Changes the link type to 

dynamic 

 "Type strong": Changes the link type to 

strong 

 "Type weak": Changes the link type to 

weak  

A detailed description of the link types can be found in the manual "Operation 

PROCEED Base". 

 

In structure views, like in lists, the sorting of the PRO.FILE objects can be adjusted, so 

that the results are sorted by several columns. 

 

When a structure browsers is displayed within PRO.FILE, the icons of the local toolbar 

above the browser offer various list functions. 

  

Adjust the sorting 

Search within the 

structure browser 
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The following buttons can be used for the searching within the displayed structure: 

 Define search pattern / search:  

A character string can be entered into the entry field located within the icon bar. Here 

you can use the wildcards/meta characters described in the chapter "Note: Optimize 

your search by using wildcards".  

The wildcard "*" is not required all other wildcards can be used.  

 

The search for the entered character string is started using the  icon.  

If the search pattern is found, the respective data record becomes the active line. If the 

search string is not found, a message is displayed and you will remain in the active line.  

  Next found pattern:  
This icon is used to once again compare the entered filter pattern with the columns 

that are to be searched. The first data record found is then turned into the active 

line. 

 

1. In a structure display or on the dependent tab "Browser" select the function "Adjust 

sorting" via the  button. 

 A separate window for 

adjusting the sorting 

criteria is displayed. 

 

2. Select the object type, for which you want to adjust the sorting order. 

3. Via the button "Add column" you can add new sorting criteria for the structure 

display. 

4. Select the column of the 

structure display to be 

used for sorting. 

 

Proceed as 

follows 
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5. Then select the sorting 

order. 

 

6. Via the arrow buttons, you can move the criteria upwards or downwards within the 

list. 

7. Via the button "Delete column" you can remove a search criterion from the list. 

8. Once all desired settings are made, confirm with <OK>. 

 The PRO.FILE objects are now sorted according to the specified columns. 

 

It is possible to hide specific object types in the structure display. For this purpose you 

can find the following icons in the toolbar above the structure display: 

 

Via these icons documents, parts, projects, tasks, processes or transmittals can be hiden 

in the displayed structure. 

 

The example above shows the filter applied for parts. In the structure, all parts are 

hidden. As a consequence, all objects linked below any part is not visible, either. 

 

 

Note: Are the filters only temporary or permanent? 

Depending on the configuration, the filters can apply onyl for the current structure 

display or permanently. This depends on the configuration settings you administrator 

has made to the parameters in the PRO.FILE Management Console. 

 

  

Filter settings 
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In the browser view you can select two functions, via the menu ribbon or the context 

menu, tot o hide or unhide specific positions from the bill of materials. 

 

"Irrelevant to BOM": 

With this function a part in the structure can be hidden from the bill of materials. 

 

Function call:  

Tab "Edit" => Group "For Bill of materials" => "Irrelevant to BOM" 

 

The selected part is then no longer displayed in the bill of materials. In the browser view, 

the part is displayed with the  icon. 

This function is normally used for auxiliary materials or purchased parts, which are to be 

part of the structure but not to be contained in the bill of materials. 

 

"Relevant to BOM": 

With this function a part that has been hidden via the function "Irrelevant to BOM" can 

be re-activated for the bill of materials. The part is then displayed again in the bill of 

materials. 

 

Function call:  

Tab "Edit" => Group "For Bill of materials" => "Relevant to BOM" 

 

Relevant or 

irrelevant to bill of 

materials  
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The positions in a structure are characterized by different icons. These icons have the 

following meanings: 

 

  Row 1: The project P2 

  Row 2: The task A1 below the project P2 

  Row 3: The project P22 below P2 with a 

weak project link.  

This is important when dealing with parts and 

documents that are linked to P22 and also have to 

be considered in P2 for the evaluation of 

permissions regardubg the visibility due to the 

guest role in P22. 

  Row 4: A strong project-project link between 

P2 and P21.  

This is important when dealing with permissions to 

projects, parts and documents that are strongly 

linked to P2 and the evaluation oft he guest role in 

P21 also requires the evaluation of roles in P2. 

  Row 5: A strong, dynamic project-part link 

between project P2 and part 10487.  

For the evaluation of permissions tot he part 

10487 the roles in P2 are of major significance.  

If the part 10487 is versioned, a new version of 

the part is displayed at this position. 

  Row 6: A bill of materials position. Zeile 6: Eine Stücklistenposition. Part 

10488 is used in part 10487.  

  Row 7: An irrelevant bill of materials position. This is a link between part 10487 

and part 10489 that has been set as irrelevant to the bill of materials. 

  Row 8: The document 10400 is linked to the predecessor version of part 

10487.  

 

This is a hint that the predecessor version of part 10487 has a document version 

but that a new version of the document 10409 is required so that each version of 

the part has a document version of its own. 

  -  Rows 9-11: The document 10401 is linked to part 10487. It contains the 

document 10402. The document 10402 in turn contains the document 10401. 

This is a cycle in the document structure. However, such a cycle may be designed in 

a CAD system under certain conditions. 

  Row 12: A static part-document link between part 10487 and document 

10404.   

  

If the document 10404 is versioned in the future, the link to the old version will 

remain, provided that there is no newer version of part 10487. 

 

Icons in the 

structure views 
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  Row 13: A strong, static project-part link 

between project P2 and part 10485. If part 

10485 is versioned in the future, the newer 

version of the part will be linked to project P2, 

but the structure of P2 will still display 10485. 

With regard to permissions to part 10485, the 

roles in project P2 have to be evaluated. 

  Row 14: A strong, dynamic project-part link 

between project P2 and part 10483.   

This is important with regard to the visibility of 

part 10483. In this case, the roles in project P2 

have to be evaluated. If part 10483 is versioned 

in the future, the new version of the part will be 

displayed at this place. 

  Row 15: A weak, static project-part link 

between project P2 and part 10486. This is 

important with regard to the visibility of part 

10486. In this case, the roles in project P2 have 

to be evaluated.  

If part 10486 is versioned in the future, the 

same version of part 10486 will still be 

displayed at this place. The new version of the 

part will then also have a link to project P2. 

  Row 16: A strong, dynamic project-document link. The same rules as for a 

strong, dynamic project-part link apply. 

  Row 17: A dynamic document-document link between documents 10394 and 

10399. In case that 10399 is not a CAD document: If document 10399 is 

versioned in the future, this link will be updated. 

 Row 18: A static document-document link between documents 10394 and 

10400. This link to this version of the document 10400 will remain, even if 

document 10400 is versioned in the future. This link to this version of the document 

10400 will remain, even if document 10400 is versioned in the future. 

  Row 19: A static, strong project-document link between project P2 and 

document 10397. The same rules as for a strong, static project-part link apply. 

  Row 20: A strong, dynamic project-document link. The same rules as for a 

weak, dynamic project-part link apply. 

  Row 21: A weak, static project-document link. The same rules as for a weak, 

static project-part link apply. 
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3.2.5 Displaying thumbnails in lists and forms 

 In PRO.FILE, each document can have a preview picture, a so-called "thumbnail" saved 

to it. When documents are dsplayed, either in the document list, the "Display document" 

form or the "Check out document" form, this thumbnail will be shown. 

 

 

The thumbnails should ideally be in the Windows BMP format. JPG formats are also 

supported, but only in the case of no BMP being available. As a rule, all thumbnails 

have the same size, which is set in the PRO.FILE-configuration.  

During the normal application of PRO.FILE, the thumbnail is filed by the integration 

when the geometry is saved. Also included in the standard package of PRO.FILE is an 

import program, which is able to create thumbnails for files that are already saved in 

PRO.FILE.  

It is also possible, using menu functions to add or remove documents thumbnails. 

 

 

Function call:  

"Edit file" => "Add Thumbnail" 

"Edit file" => "Remove Thumbnail" 

 

You can save a file with an existing thumbnail format *.bmp or *.jpg from the file 

system. This file is then laid down in the appropriate place for thumbnails in the 

PRO.FILE system. 

 

 

Note: 

In order to add a thumbnail for a document, a document file has to be attached to the 

document description. 
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3.2.6 Printing forms, lists and structure displays 

In the different displays (forms, lists, structure) of the PRO.FILE surface the displayed 

information can be automatically transferred to a printer. 

For this purpose the icon  is available in the main tab and in the dependent tabs: 

 

 

 

1. Activate the form, list or browser display you wish to print 

2. Click on the button  in the icon bar belonging to the display 

3. The data is now displayed in 

a print preview. 

4. To print click on the button 

 or select the printing 

option from the "File" menu 

of this print preview. 

 

 

 

 

3.3 The file preview 

Documents shown in list or form displays can be displayed in a preview window, so that 

the file does not have to be extracted from PRO.FILE for viewing. 

To print form, list 

or browser 

contents Proceed 

as follows 
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The file preview displays the currently selected document, regardless of whether the 

document is selected in a main tab or a dependent tab. 

 

 

If the selected document cannot be displayed (e.g. because the corresponding viewer is 

not installed), the file preview shows a corresponding message. 

 

The bar oft he file preview in PRO.FILE is, by default, displayed with autohide function. 

The preview window always automatically hides at the side of 

the window when it is not required to leave more room for 

other information. 

1. To show the preview window click on the tab "Previewer" 

at the right-hand side of the window. 

 The file preview is now displayed. It remains open until 

the mouse pointer leaves the area of the display window. 

Once the mouse pointer leaves this area, the window 

collapses again. 

 

The display of the 

file preview: Fixed 

or autohide? 
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2. The preview window can also be fixiated via the icon 

at the top right corner of the preview window.  

 The preview will then permanently stay open and can 

be used at any time. 

3. When the preview window is fixiated, the autohide 

function can be reenabled by clicking the  icon. 

 

 

3.4 The dependent tabs in PRO.FILE  

In PRO.FILE the user has the possibility to use the tab concept in forms and lists. With 

this Tap-concept the organization of the individual windows is more comfortable.  

Each activated window is divided in two views. The selected data is shown in the upper 

view. All relating information can be displayed by using the tabs. 

 

The tab concept is shown and described by the screenshot above:  

A selection of documents was made and is represented in a document list.  

For each document selected in the list the existing relating documents and information 

are shown in the relevant tabs. The above example shows the document usage of the 

document with the ID 15366.  
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These tabs can be used to display many additional views and information for a 

document or a part. It is also possible to display multiple tabs at a time: 

 

 

 

Note: 

For larger structures or lists or large preview files, it may be advisable to deactivate the 

automatic update of the dependent tabs to reduce loading times. This can be done via 

the corresponding parameter in the PRO.FILE Management Console under 

"Configuration" => "Parameter" => "PRO.FILE" => "Form design". You should also 

make sure that these dependent tabs are not configured as first tabs to be displayed 

when a data record is selected. 

 

 "Modification Log":   

The modification log displays the list of changes for the data record that is currently 

active in the list or the form view. This list of changes contains information such as, 

the user who applied the changes, the date of the changes as well as comments on 

the changes. The specific list functions are available for further modification of the 

list of changes. Please also refer to chapter "Available list functions".   

 "Status log":   

Displays a list of the completed status changes stating the change date, the user in 

charge, and the status change comments. This allows you to retrace the sequence 

of the status changes of a selected document or part through the specified workflow 

within the company (e.g. from construction to manufacturing).  

 

 

It is also recorded if a user has used the functions "Notify", "Seen and approved" or 

"Seen and rejected". Entries in the list of status changes are recorded by the system 

once an event is triggered. Here, information on the date, the individual who 

applied the changes and the status changes are included. Subsequent changes are 

not possible.   

Dependent tabs 

that are available 

for documents 

and parts: 
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 Please refer to chapter "PRO.FILE status management: Support and Control your 

Workflow" for more information on the status system. 

 "Status":   

The dependent tab "Status" provides users with further information on the current 

data record. This includes workflow status, project designation, information on who 

locked the data record, plus information on who opened an attached document 

and when. 

 "BizTalk Log":   

If the BizTalk adapter is used, this is where the BizTalk log can be viewed. This log 

is used to record communication information between PRO.FILE and the BizTalk 

server. 

 Browser":   
The structure overview (also called browser) gives users a graphical overview of the 

links of documents and parts. Starting from the currently active part, the 

subordinate structure is displayed here. Please refer to chapter "Working with 

Browsers"   

for more information on the functionalities of the structure overview. A context 

menu is always available within the structure overview that can be accessed 

through a right mouse click. It contains the most important commands to ensure 

ease of-use for this structure overview. The context menus within the browser are 

dependent on the selected object and allow users to gain fast access to the 

functions required for editing parts and documents.  

 "Where used":  

The usage browser is available in PRO.FILE as a counterpart to the structure 

browser. It is intended to inform users on the usage of a part or document making 

it an aid to illustrating the backward structures. As opposed to the structure view, 

the PRO.FILE usage browser is used to show which objects a specific document or 

part is built or attached to, thereby giving a complete usage list for the selected 

object. Additionally, a context-sensitive editing menu gives users the possibility to 

manage and adjust the usage records. Please refer to chapter "Working with 

Browsers for more information on the functionalities of the usage record. 

 

 "Preview ":  

This view will display a document in a preview window. The PRO.FILE preview 

window allows for the display and viewing of raster drawings in a PRO.FILE window 

without having to open the corresponding editor program. It is, however, required 

that the corresponding viewers and drivers are installed. Within this preview 

window, users can access the functions "Adjust", "Next page" "Previous page", 

"Zoom selection" and "Zoom out selection" by clicking the corresponding icon 

allowing them to zoom within the PRO.FILE preview tab. It is also possible to show 

the preview in a form and to then show it using a tab. It can also be included in a 

list as a thumbnail. Especially for larger files, these thumbnails offer distinct 

advantages: their transfer to the client is much faster and their format and small 

size enable a preview that is integrated into the list of documents. Please also refer 

to chapter "Displaying thumbnails in lists and forms".   

 "Versions / Revisions":  

If a document is versioned, the database will contain older versions or revisions of 

the currently displayed document master data. This view will now list all of the 

available versions and revisions. 

Dependent tabs 

that are available 

for documents in 

particular: 
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 "Document structure ":  

Uses a browser to show which documents are attached to the selected document 

and in which structure. This corresponds to the structure view but is limited to 

documents. 

 "Document usage":  

This shows a browser view of which documents the selected document is attached 

to thereby showing the backward structure. This view corresponds to the usage 

record, but is limited to documents. 

 "Part form ":  

Displays all parts for the selected document that are attached to this document 

within a new form view. Please refer to chapter "Working with forms" for more 

information on the form view. 

 "List of parts ":  

Displays all parts for the selected document that are attached to this document 

within a new list. Please refer to chapter "Working with lists" for more information on 

the list view. 

 

 "Browser":   

Uses a browser to show which parts are attached to the selected part and in which 

structure. This view corresponds to the structure overview but is limited to parts.  

 "Parts usage":   

This shows a browser view of which parts the selected part is attached to thereby 

showing the backward structure. This view corresponds to the usage record, but is 

limited to parts.  

 "Document description":   

Displays all documents for the selected part that are attached to this part within a 

new form view. Please refer to chapter: "Working with forms" for more information 

on the form view.  

 "List of documents":   

Displays all documents, which are attached to the selected part, within a new list. 

Please refer to chapter: "Working with lists" for more information on the list view.  

 "Bill of materials":   

Displays the bill of material that belongs to the selected part. Use the context menu 

of the right mouse button to access the bill of material editor from this view. 

 

A configuration menu "Arrange tabs" is available to set up the tabs. It can be accessed 

through the context menu of the right mouse button. This context menu is available once 

the mouse pointer is placed over a tab that contains the names of the tabs. See also the 

chapter: "Setting up the dependent tabs ". 

 

3.5 The PRO.FILE fields: How can I enter data? 

The following image shows an input form. In the following input form, which in some 

programs is called an input window, you can enter data into specific data fields.  

Dependent tabs 

that are available 

for parts in 

particular: 
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The input forms are 

mainly used for 

selecting data records, 

creating data records, 

and when editing data 

records. 

 

 

There are several types of fields 

The simplest element for the entry of data is the form field: 

 

 In these fields, a previously defined number of characters can be entered and 

displayed. 

 To activate an input field, click on it with the mouse and then type in the desired 

information:  

 For selection use TAB or select the field by clicking on it with the mouse.  

Multi-line fields provide unlimited space for unformatted text input. 

 

  

Form fields 

Multi-line fields 
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Some fields are marked with a  button; these fields offer a selection function via a 

reference list.  

 If you click on the 

button, a drop-down 

list.  

 You can select only one 

option from this list. 
 

 Depending on the configuration of the field, you can also enter text that is not part 

of the reference list. 

 As soon as text is 

entered into the field, 

the list of matching 

values is reduced 

automatically to make 

the input easier. The 

placeholder "*" can also 

be used in this context. 

 

 

 By clicking the drop-

down button, a list of 

categories is displayed. 

 You can select several 

categories. 

 The input of text that is 

not part of the list is not 

possible. 

 

 

 You can also access a special date selection 

function by using the  button. With this, the 

values "yesterday", "today" and "tomorrow" can be 

chosen when creating or editing a PRO.FILE 

object.  

 

Fields with 

selection option 

(reference list) 

Fields with 

selection option 

(category list) 

Field for the 

selection of dates 
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 Date fields may also 

have a date picker . 

This is to make the 

selection of a date even 

more comfortable via a 

calendar. The 

specification of a date 

range is only possible 

for search forms. The 

date picker has to be 

configured for the field 

(see manual 

"Configuration 

PRO.FILE GUI"). 

 

 

 Reference fields display values of 

superior objects. The icon next to 

the field value indicates the object 

type. The fields cannot be changed. 

 Via the icon, the referenced object 

can be displayed in a separate form. 

 Reference fields can be used for the 

search- 

 

 

How to fill the fields  

 Fields filled automatically by PRO.FILE:  
Some fields automatically receive a value from PRO.FILE, such as the DB 

Identification Number or the User (designer).  

 Required fields:  
Some fields require an entry, you cannot quit without making an entry.  

 

 

 

These fields are indicated by a red triangle in the upper left corner. If you try to 

confirm the input mask without making an entry in this field you won’t be able to 

proceed and the required field is also marked with a red exclamation mark. 

Reference fields 
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3.5.1 Use multiline-fields to present multiline texts  

PRO.FILE multiline fields allow for data entry and storage of an unlimited amount of text 

data.  

The configuration of multiline fields allows users upon creation or editing of data 

records to enter text data consisting of several lines and then display this data in output 

forms. The number of characters that can be entered in multiline fields is unlimited. A 

scroll bar is displayed that allows for navigation to text data that resides outside of the 

viewable area of the multiline field.  

Text data entered into a multiline field is stored separately in the database and can be 

displayed in output forms. Multiline fields are available in conjunction with documents 

and projects. 

 

Multiline fields are configured using designated database fields provided in PRO.FILE 

Management Console. Up to 5 multiline fields for each form can be configured. 

Multiline fields can be inserted in forms using the form designer. 

 

Displaying multiline entries in lists: 

If a multiline field contains a long entry or an enty with several lines, the corresponding 

field in the list is displayed with a height of 3 lines.  

When a row is selected in a list and copied to the clipboard, only the first line of the 

multi-line field entry is copied. 

 

PRO.FILE offers a multiline editor for working with text data in multiline fields. The 

multiline editor simplifies data entry and also features a function for importing data into 

a multiline field.  

In the data entry form, click the button  for entering or editing text data in a multiline 

field. 

The PRO.FILE 

Multiline Editor 
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The multiline editor will then be displayed, and the changes can be made to the text. 

You now can modify or enter data in the window. The length of text data entered is not 

limited.  

The editor window allows for modification and update of existing text. An import 

function allows for import of entire text files. The editor window is fully sizable (click & 

drag) following common Microsoft Windows standards.  

Right-clicking the mouse inside the editor window will display a menu featuring "Undo", 

"Cut", "Copy", "Paste", "Delete", and "Select All" text editing commands.  

When finished with updating text data, click the <OK> button to assign the text data to 

the multiline field. Then, contents of the editor window will be displayed as data in the 

multiline field. 

 

3.5.2 Category fields 

Selection fields may contain a list of categories. The configuration for the categories is 

made by the PRO.FILE administrator in the PRO.FILE Management Console. In contrast 

to reference lists, category lists allow the selection of mutliple values, i.e. an object can 

be assigned to several categories. 

Category fields facilitate the fast and simple assignment of objects to categories with 

customizable color flags. 

 

You can select multiple 

categories by activating the 

corresponding checkboxes. 

The field then displays the 

color codes of the selcted 

categories. 

 

Assign categories 



Operation PRO.FILE advanced The PRO.FILE fields: How can I enter data? 

PRO.FILE Release 8.7 
June 2017 Page 51 of 241 

 

Note: 

When a category is disabled by the administrator, it is still displayed in the list (grey) 

but cannot be selected. If a data record, that contains a category that has been 

disabled in the meantime is modified, you can uncheck the category for this record. 

The category is then also disabled for this record 

 

For the search, the context menu of a category field offers specific options. 

1. Righ-click on a category field to open the context menu. 

2. Select from the following options: 

 Has categories: Searches all objects that have been assigned categories. 

 Does not have categories: Searches all object that have not been assigned 

categrories. 

 Purge field: Removes the current setting from the field. 

 The selected option is displayed in the field. 

 

In lists and browser displays, you can set a filter for categories. 

1. Click on the  icon. 

 In the column header filter field, the available values are displayed 

 The list displays only values that are actually used within the list of results. 

2. Select the category you want to include in the filter. The cateogory names are 

displayed as tooltips. If several categories are selected, an "OR" connection is 

established. 

 The results list is reduced to all records the filter applies to. 

 

If the results list is grouped by the column of a category field, a new group is createf for 

each combination of categories. 

  

Search for 

categories 

Category filter 

Category groups 
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3.5.3 Enhance reference lists directly in PRO.FILE 

A reference list can be enhanced directly in PRO.FILE but only if you have the 

corresponding function access right. 

As described in the previous chapter, a reference list may either be used as a pure 

selection function – or may be connected with a check function, allowing only entries 

from the reference list. 

If reference lists are used in such way to ensure the correct filling of fields, only entries 

from the reference list are allowed. 

 

 

Example: 

You are using this check function to fill the field with a selection of part materials, in 

order to avoid data inconsistencies caused by wrong entries of material names or 

numbers. 

 

If such a reference list with check function is to be used, there are two options: 

 The PRO.FILE administrator enhances the reference list via the reference list 

administration in the PRO.FILE Management Console. 

 You have the function access right "Enhance reference list. Then you can enter a 

new value into the field, which will enhance the existing reference list by the new 

value. 

 

 

Note: 

In order to enhance a reference list with a check function directly in PRO.FILE, the user 

needs the corresponding function access right "Enhance reference lists". This function is 

only available for the Windows Client. 

 

How to enhance a reference list? 

In order to enhance a reference list with a check function directly in PRO.FILE, Proceed 

as follows 

 

 

Note: 

In order to enhance a reference list with a check function directly in PRO.FILE, the user 

needs the corresponding function access right "Enhance reference lists". 
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1. Requirement:  

The reference list "Screw" shown here is to be 

enhanced by the entry "Wood screw". 

 

 

2. Enter new reference list entry into the field  

Enter the value "Wood screw" into the entry field. 

3. Call up reference list enhancement  

Click the drop-down button of the reference list with the mouse button.   

 

 

4. Confirm enhancement:  

The query "Would you like to enhance the 

reference list?" is displayed.  

Since this is what you want, confirm with 

<Yes>.  

5.  Check the necessity of this entry 

In the wizard that appears now, check 

whether you really need the new entry or 

whether an according entry already exists. 

If you want to create the new entry, select 

"Wood screw" and click <Forward>. 

 

6.  Select superior level  

You now have to decide, on which level 

the new entry is to be inserted. For this 

purpose, select the superior structure 

point in the reference list.  

The new reference list entry will be 

inserted one level below the selected 

entry. 
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7.  Select subordinate levels  

If the new reference list entry is to form a 

new structure within the reference list 

(thus to be inserted between two existing 

structure levels), you must now select the 

reference list entries that are to be 

attached below the new entry.  

 

If all entries are to be on the same level, 

do not select anything here.  

 

In this example, the "wood screw" is to be 

on the same level as the other screws, so 

nothing is selected here. 

 

8.  Determine display of entry in reference 

list  
Finally, you can determine how the new 

entry is to be displayed in the reference 

list. This option is used to keep reference 

lists easy to handle by displaying only 

short forms of the entry in the list, but 

which will enter a longer value into the 

field.  

 

Examples:  

Entry in reference list: O  

Entry in field: Oxygen  

 

Entry in reference list: GTC  

Entry in field: General terms and 

conditions  

 

9.  Completion:  

To complete the enhancement of the reference list, click on <Finish>. The new 

entry can now be selected from the reference list and is available to all other users. 
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3.6 The PRO.FILE data fields: Working with SmartLinks 

Hyperlinks are an established tool in many areas of IT. Via a single mouse click, a user 

can jump from one object to another. PRO.FILE picks up this comfortable method with 

the new PRO.FILE SmartLinks.  

 Links can be configured for PRO.FILE fields in forms and lists. These links establish 

a connection to documents and assemblies, between documents and projects, 

between processes and parts, etc.  

 Another usage scenario is the access to internet sites directly in a PRO.FILE window.  

 The SmartLinks can also be placed on the desktop of a PRO.FILE user or within a 

company portal. This way, it is possible to jump directly to a PRO.FILE object from 

the outside and vice versa. 

 

SmartLinks in PRO.FILE allow to jump: 

 From…  

a field entry 

 in a form display 

 in a list 

 in a browser display 

 …to 

 a different PRO.FILE object (form or list 

display) 

 a web site  

(Web tab directly in PRO.FILE or external 

browser) 

 a user-defined function (user exit 

 

Examples: 

In the document list you 

can directly access the 

corresponding project by 

clicking on the project 

number. 

 SmartLink "Object 

link" 
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Via the entering of the 

URL into a field with 

configured SmartLink 

you can access the web 

site of the supplier on a 

new PRO.FILE tab. 

 SmartLink "Web 
link"  

 

    

 

 

Furthermore, the SmartLinks offer the following options: 

 The context menu for opening, linking and copying a SmartLink 

 Creating links from SmartLinks via drag & drop 

 

3.6.1 The context menu for opening, linking and copying a SmartLink 

If you move the mouse over 

a SmartLink in a list or form 

view, you can access a 

context menu via the right 

mouse button. 

 

 

This menu offers the following functions: 

 Open  

This function corresponds to the left mouse click on the SmartLink. The PRO.FILE 

object linked via the ID number (document description, part, project, …) is 

opened and displayed in a new tab in PRO.FILE.  
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 Copy shortcut  

This function copies the link contained in 

the SmartLink to the Windows 

Clipboard. 

You can copy this link into other 

documents or applications. A mouse 

click on the link opens PRO.FILE and 

displays the linked object. 

 

 Create shortcut on desktop  

This function creates a link instance of the SmartLink on your 

Windows desktop. With a mouse click on this shortcut 

PRO.FILE is started and the PRO.FILE object linked via the ID 

number is opened and displayed in a new tab in PRO.FILE.   

 Copy content  

This function copies only the content of the displayed SmartLink, i.e. the character 

string which is displayed as link signifying the SmartLink. 

 

3.6.2 Creating links from SmartLinks via drag & drop 

A SmartLink be used for the creation of shortcuts and hyperlinks via drag&drop. 

Drag the SmartLink with the left mouse button from the form or list view to the desired 

target location. 

 Drag&drop of a SmartLink from PRO.FILE 

 to the Windows desktop creates a shortcut 

 to an Explorer folder creates a shortcut 

 into an MS Word or Outlook document creates a hyperlink. 

 

By clicking on the thus created hyperlink or shortcut, PRO.FILE is opened and displays 

the PRO.FILE object linked via the ID number of the SmartLink. 

 

3.7 Tip: Customize the GUI to your needs 

You can customize the PRO.FILE GUI according to your daily requirements: 

 Setting up the dependent tabs  

 Arrange list views and save them 
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3.7.1 Setting up the dependent tabs  

The "dependent tabs" can be displayed in forms and lists. These dependent tabs allow 

you to directly view additional information for an object that is active in the form or list 

view.  

Within the PRO.FILE user interface, this 

information is displayed in the lower 

corner of the tab windows in the 

dependent tabs  

A configuration menu is available to set 

up the tabs. It can be accessed through 

the context menu of the right mouse 

button.  

This context menu is available once the 

mouse pointer is placed over a tab that 

contains the names of the tabs. 

 

 

 

Function call:  

"Place mouse pointer over tab" => "Right mouse button" 

 

The functionalities that are described in the following chapters will then be available for 

configuration:  

 Hide a dependent tab 

 Display all dependent tabs 

 Arrange dependent tabs 

 Split the tab window in order to see multiple tabs at a time 

 Reset the settings for the dependent tabs 

 Save settings for the dependent tabs 

 

 

Note: 

The available tabs are dependent on the object type that is currently active. The tabs 

can therefore be configured separately for documents and parts. 

The settings for the dependent tabs are stored locally on the current user computer and 

are only available there. 

 

1. If you want to hide a dependent tab, simply place you mouse pointer over the 

desired tab.  

2. Then select the function "Hide tab" from the context menu that is activated using the 

right mouse button.  

Hide a dependent 

tab 
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 The currently active tab will then be hidden. In order to redisplay a tab that is 

hidden, please also refer to chapter "Arrange dependent tabs". 

 

Individual dependent tabs can be hidden from the document or part view.  

If these tabs have to be accessed again at a later time, you can use the function "Show 
all tabs".  

1. Place you mouse pointer over the header of any dependent tab in order to call this 

function. Then select "Show all tabs" from the context menu.  

 All dependent tabs that are available for the current PRO.FILE object type will then 

be displayed. 

 

1. Place the mouse pointer over a dependent tab. Then press the right mouse button 

and select the function "Arrange tabs…" from the context menu.  

 A new window will appear: 

 

2. Using drag and drop you can now move every entry to the desired position. 

3. It is also possible to activate or deactivate individual dependent tabs using the 

checkboxes in front of the tab designation. This is how you can redisplay any 

hidden tabs as well.  

4. When you have arranged the tabs confirm your selection by pressing the <OK> 

button.  

In order to discard possible changes and to return to the existing arrangement of 

tabs simply press the <Cancel> button. 

In order to return to the default settings simply press the <Reset> button. 

 

You can set up groups within the tabs in order to display multiple tabs at a time. The 

following illustration, for example, shows how the preview tab is arranged on the left 

hand side while all other tabs are placed on the right hand side: 

Display all 

dependent tabs 

Arrange 

dependent tabs 

Split the tab 

window in order 

to see multiple 

tabs at a time 
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In order to subdivide the tab window into several tab groups, please follow these steps:  

1. Place the mouse pointer over the header of a dependent tab. Press the right 

mouse button and select "Arrange tabs…" from the context menu. 

2. A new window will appear. 

Press the <New group> 

button.  

 A new Group 1 will be 

created within the list: 

 

3. Using drag and drop, now 

move the tabs that you want 

displayed in a second window 

from the upper list ("Main") to 

"Group 1".  
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4. Confirm your settings by pressing the <OK> button. 

 The tabs will now be displayed within multiple groups in the PRO.FILE user 

interface. 

 

1. Place the mouse pointer over the header of a dependent tab. Press the right mouse 

button and select "Arrange tabs…" from the context menu.  

2. Now move all entries within the additional groups back to the "Main" list. If a group 

doesn’t contain any more tabs, it will be automatically deleted upon confirmation 

of your selection with <OK>. 

 

1. Place the mouse pointer over the header of a dependent tab. Press the right mouse 

button and select "Reset" from the context menu.  

 Availability and arrangement of the dependent tabs will be set back to the default 

settings.  

 

If you choose to hide individual dependent tabs and to arrange the remaining tabs 

according to your wishes, you should save your settings so that they will be available to 

you for the next session! 

Follow these steps to save you settings for the dependent tabs:  

1. Place your mouse pointer over the header of any dependent tab. Then press the 

right mouse button and select the function "Save" from the context menu.  

 The current settings will be saved and will be available the next time you use the 

respective tab view. 

 

 

Note: 

Which tabs are available depends on which object type is currently active. The tabs are 

configured separately for documents and parts and therefore have to be saved 

separately as well. 

 

3.7.2 Arrange list views and save them 

There is always a context menu available to the user in the hit lists, document lists and 

the part lists. Using this context menu, you can create the lists, edit them, and also save 

their displays.  

To call up this context menu, position the mouse pointer in the list header with the 

column headers, and click the right hand mouse button:  

Undo the 

subdivision of the 

tab window 

Reset the settings 

for the dependent 

tabs 

Save settings for 

the dependent 

tabs 
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The following functions are available:  

 The information on the currently selected list view:   

You can save lists that you have previously configured yourself, and reselect them 

at a later date. The first line of the context menu shows you which list view are 

presently selected.  

 Select list view:   

This menu point can be used to select and call up all available list views.  

 Save:   

This function is used to save changed displays of a list view. This function relies on 

the specific user authority.  

 Save as:   

This function saves changes to a display of a list view under a new name. During 

the save as process, a new name must be given to the newly created list view.  

 Make this list view as the default:   
This command enables the presently activated list view to be set as the standard 

view in its’ present saved state. If a new list is called up, it will always appear in this 

standard view format.  

 Arrange columns:  
This command opens a dialog in which you can quickly and easily specify the 

columns to be displayed and in which order.  

For this purpose, columns are shown or hidden via the arrow buttons. The order of 

the columns is then determined with the buttons <Move up> and <Move down>. 

 Hide column:   

This command hides the presently active column from the list view. Each active 

column is marked with a small arrow in the column header.  

 Show column:   

This function is used to blend in previously blended out columns, to make them 

visible again. In the sub-menu of this function, is a list of all of the blended out 

columns.  

 Scrollable from here:   

This function determines which columns are to be seen in the view. If a column is 

activated and this function is called up, all columns to the left of the activated 

column can no longer be scrolled away, and are remain visible in the view. (The 

column that is active at the time is shown with a small arrow in the column header).  
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The view manager is used for the administration of the self-created lists. The various 

functions of which, can be found in the following chapter "Manage stored list views". 

Manage stored list views 

You can create and customize lists in PRO.FILE so that they fulfill your individual 

requirements: You make all the settings that determine blend out, or blend in, sort, the 

changing of the column order and the column width.  

These customized views can then be saved. (See also the chapter "Arrange list views and 

save them"). 

The views manager is used to carry out the administration of all of the saved list views. 

 

 

Function call:  

"View" => "Views Manager" 

 

Using the view 

manager it is possible 

to delete, rename, or 

publish saved list views. 

 

For this, on the right hand side of the window, you have the three corresponding 

buttons:  

 <Delete>:  

Irrevocably deletes the highlighted view. Recovery of this view is then not possible! 

After this function has been called up, a request screen appears in which you must 

either confirm or cancel the delete process. Only the customized view will be 

deleted – none of the list entries or data records.  

 <Rename>:  
This function can be used when saving a customized list, that has a name that does 

not describe the view too well, or when all saved lists should be renamed according 

to a specific scheme. To do this, the list view that is to be renamed must be 

highlighted, and the <Rename> button selected. A window will appear in which 

the new name can be entered. The renaming should then be confirmed with 

<OK>.  

 <Public>:   
Using this function you have the possibility to make your created, customized and 

saved lists available to other PRO.FILE users. This requires you to have the relevant 

user authority, and only applies to PRO.FILE users that have access to the same 

database. To publish your lists, highlight the list views required and click on the 

<Public> button.  

Published views will then be marked with the symbol:  
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3.8 Export the contents of lists and browser displays to Excel 

With the button  you can export the information displayed in different lists and 

browser displays in PRO.FILE into an Excel file. 

The export of such displayed data can be made from the main tab as well as from the 

dependent tabs. 

 

 

1. Activate the list or browser display that you wish to export. 

2. Click on the button  in the icon bar belonging to the display. 

3. You are then prompted to specify a file name for the Excel table to be saved. 

 The data is now 

displayed in Excel. For 

better display, the 

column headings are 

displayed for each level 

of the exported structure 

in Excel separately. 

 

 

  

To export list or 

browser contents 

to Excel Proceed 

as follows 
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The export of browser contents is only possible for homogenous browser displays 

containing either only documents, only parts, or only projects. 

 

 

Note: 

The display of a non-homogenous structure from PRO.FILE in Excel is confusing, since 

you cannot see which entry is a part and which entry is a document. For this reason, 

the ExportToExcel button is not available in non-homogenous structures. 

 

The icon "Excel export" is available in the following displays: 

 Transmittals in list display 

 Projects in list display 

 Role assignments 

 Quantity bill of materials 

 Bill of materials editor 

 Bill of materials as list 

 

And in the dependent tabs 

 Status log 

 Modification list 

 Mail log 

 Versions 

 Document usage 

 Document structure 

 Document list 

 Parts list 

 Role assignment 

 Parts usage 

 Bill of materials  

  

Availability: 
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3.9 Tip: Customize the Cockpit 

The PRO.FILE Cockpit can be customized. There are several widgets, the contents and 

positions of which can be changed. 

The adjustment is made via the function "Customize Cockpit" from the "Window" tab. 

 

 

 

Function call:  

"Window" => Area "Manage" => "Customize Cockpit" 

 

 

Note: A matter of permissions 

The customization of the PRO.FILE Cockpit requires the corresponding function access 

right. If the function "Customize Cockpit" is not displayed, you do not have this 

permission 

 

After clicking on this function button, the left-hand side of PRO.FILE displays the area for 

customizing the Cockpit. A detailed description can be found in the following chapters. 
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3.9.1 Adjust Cockpit "Layout" 

To adjust the layout of the PRO.FILE Cockpit, select the register tab "Windows" and then 

the function "Customize Cockpit". 

For the layout you can now make the 

following settings: 

1. Enter the number of lines the structure 

of the Cockpit is to consist of. 

 The lines are then listed with types and 

values. 

2. If a line is selected in this list, the width 

can be adjusted. The options 

"absolute", "percent" and "Autosize" are 

available. "Absolute" is the width in 

pixels, "percent" is the width in relation 

to the total width of the Cockpit. 

 

The following widgets can be added for the 

lines listed above: 

  Via a selection window, 

elements (widgets) can be added to 

the Cockpit. 

  Via this button, the layout can 

be reset to the last saved status. 

 

 

Once all settings are made, you can save the layout via the <Save> button. 
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3.9.2 Adjust Cockpit "Logo" 

To adjust the logo in the PRO.FILE Cockpit, select the function "Customize Cockpit" => 

"Logo". 

For the layout you can now make the 

following settings: 

1. Specify the positions of the cells, in 

which the logo is to be displayed. 

Cells occupied by other widgets 

cannot be selected. 

2. To use your own logo in the PRO.FILE 

Cockpit, this logo must be stored in 

the folder images\cockpit of the 

PRO.FILE configuration point. You can 

then enter the name of the image file 

in the input field. 

3. Once all settings are made, you can 

save the layout via the <Save> 

button. 
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3.9.3 Adjust Cockpit "Full-text search", "Search", "Create" and "Recently used" 

In the PRO.FILE Cockpit, various widgets are available in the standard: 

 Full-text search 

 Search 

 Create 

 Recently used 

If these widgets are to be used in the PRO.FILE Cockpit, select the function "Customize 

Cockpit". 

1. Select the widget to be adjusted from the 

bottom area of the configuration window.  

 The corresponding information is then 

displayed in the upper area. The example 

here shows the configuration of the widget 

"Full-text search". 

2. You can now make the following settings: 

 Specify the positions of the cells, in 

which the widget is to be displayed. 

Cells occupied by other widgets 

cannot be selected. 

 You can also specify for which 

PRO.FILE objects the widget is to be 

available. 

 

3. Once all settings are made, you can save 

the layout via the <Save> button. 
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3.10 The buttons – an overview 

A variety of functions in PRO.FILE can be accessed via buttons. These can be found in 

the toolbars of the tabs as well as in the ribbons or context menus. 

The following is a list of the various buttons and their meaning: 

 Description   Description 

 

Switch between single and 

multiple-selection mode 

 

 

MarkAll (for multi-selection 

mode) 

 
Insert link  

 

Expand structure – 2 levels (for 

multi-selection mode) 

 
Delete link  

 

Expand structure – complete 

(for multi-selection mode) 

 
Modify link  

 

Show selected elements in new 

windows (for multi-selection 

mode) 

 

Show/hide documents  

 

Show bill of materials editor 

 
Show/hide parts  

 

Preview thumbnail  

 
Show/hide projects  

 
Preview file 

 

Show/hide tasks  
 

Adjust height 

 
Show/hide processes  

 
Adjust width 

 

Show/hide transmittals  
 

Fit 

 

Create NDF job  
 

Rotate 90° left 

 
Print file  

 
Rotate 90° right 

 

Copy  
 

Go to page … 

 

Adjust width  
 

Next page 

 

Adjust sorting order  
 

Previous page 

 

Export list to Excel  
 

Enlarge selection 

 
Switch between form and list view  

 
Enlarge 

 
Select all rows  

 
Make smaller 

 
Hide selected rows  

 
Start task 

 
Invert selection  

 
Finish task 
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Show hidden lines  

 
Sub-processes 

 

Search by active column  
 

Create new task 

 
Search by all columns  

 
Create new project manager 

 
Filter  

 
Remove selected project 

manager 

 

Next found pattern  

 

Manage role assignments 

 
Display/hide filter  

 

Delete selected role 

assignment 

 
New modification list entry  

 
Previous element 

 
Delete modification list entry  

 
Next element 

 Edit modification list entry  
 

Display as leading window 

 
Display structure bill of materials  

 

Display in external browser 

 
Show part usage   Display previous page in 

browser 

 
Mark all visibile nodes(for multi-

selection mode) 

  Display next page in browser 

 
Unmark all visibile nodes(for 

multi-selection mode) 

 
 

Stop loading process 

 

Mark all visibile subnodes(for 

multi-selection mode) 

 
 

Reload page 

 

Unmark all visibile subnodes(for 

multi-selection mode) 

   

 

  



Operation PRO.FILE advanced The PRO.FILE register tabs 

PRO.FILE Release 8.7 
June 2017 Page 72 of 241 

4 The PRO.FILE register tabs 

 The context-sensitive menu bar makes the necessary menus available to you. 

 

 

The contents of these individual menus and their appropriate commands and functions 

are context-sensitive, i.e. dynamically adjusted to the active window:  

For example, when a part is selected, the tab "Edit" only shows functions that are 

relevant for the handling of parts. When a document is selected, the tab "Edit" only 

shows functions for the handling of documents.  

In the following sub chapters, the functions contained in the various tabs are explained. 

 The menu "File" 

 The tab "Start" 

 The tab "Edit" 

 The tab "Search" 

 The tab "View" 

 The tab "Window" 

 

An additional description is provided in the next chapter as a cross reference, for the 

description of the commands that are to be seen in a total relationship. 

 

 

Note: Context menu via the right mouse button 

A context menu is always available within the PRO.FILE interface that can be accessed 

through a right mouse click. This context menu largely is the same as the "Edit" menu. 
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4.1 The menu "File" 

In the "File" menu of PRO.FILE, you can access fundamental 

functions and settings of PRO.FILE. 

  

This menu contains the following functions: 

 Information: 
Displays information on the installed PRO.FILE system. 

See chapter "Viewing PRO.FILE system information". 

 Deactivate project: 
This function is also permanently available in the file 

menu, so that activated projects and their related data 

assignment for these projects can be deactivated. 

 Import document: 
If a file has been exported from PRO.FILE for external 

editing, this file can be re-imported via this function. See 

chapter "Export / Import of documents with PRO.FILE 

(Option)". 

 Export Pocket:  

This menu entry is used to export documents and parts 

to PRO.FILE Pocket to make their structure available 

offline. This optional PRO.FILE module is used e.g. for 

displaying objects on construction sites, where no 

PRO.FILE connection is available. Detailed information 

can be found in the manual for PRO.FILE Pocket, which 

you can download from the PROCAD Support portal. 

 

 General Reports:   

This menu entry is used for the creation of reports (option) and is described 

separately in the manual "PRO.FILE Report Generator Link". This manual can be 

downloaded from the PROCAD Support portal. 

 Web Reports:   

This menu entry is used for the access to Web reports. These reports are then 

displayed in PRO.FILE and can be used for the further evaluation of a variety of 

relevant data. 

 Job Monitor: 
The Job Monitor displays the activities of the PRO.FILE Generic Job Server. Further 

information can be found in the manual on the Generic Job Server. 

 Default actions…: 
This function specifies the actions to be performed when a PRO.FILE object is 

double-clicked. These specifications can be made individually by each user and are 

described in the chapter "Defining the PRO.FILE default actions". 

 Reset messages:  

At various places in PRO.FILE, it is possible to hide frequently displayed messages. 

With the function "Reset messages" you can re-enable the display of all messages. 

All messages that have been hidden before are then displayed again. 



Operation PRO.FILE advanced The menu "File" 

PRO.FILE Release 8.7 
June 2017 Page 74 of 241 

 Settings: 
Each user can make settings relating to the start and closing of PRO.FILE (see 

chapter "Settings for the start and shutdown of PRO.FILE").  

 Logging: 
This function starts the trace configuration, via which log files of PRO.FILE system 

activities can be activated. This can be required, e.g. in support cases. 

 Switch user:   

Each PRO.FILE user has specific function authority rights, e.g. to view certain 

statuses. These rights are activated when the user logs on. Various actions e.g. 

editing, and status changes are protocolled along with the user's name. It is 

therefore strongly recommended that when a user changes places to a different 

workstation, the in PRO.FILE registered user is changed. See also the chapter: 

"Change the currently logged on PRO.FILE user". 

 Change Password:   

Users always have to log on to PRO.FILE with their user name and password. This is 

where users can change their PRO.FILE password. Please also refer to chapter 

"Change the PRO.FILE password". 

 Finish:   

This function is used to end a PRO.FILE session, and log off.  
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4.1.1 Viewing PRO.FILE system information 

The menu point "Information" allows you to call up the basic information from the 

PRO.FILE-System.  

This system information is especially important for the configuration of the PRO.FILE-

System. Use the entries also when you make support- enquiries, and have contact to the 

PROCAD hotline.  

 

 

Function call: 

"File" => "Information" 

 

The following entries are then shown in the info window:  

 

 The operating system used.  

 The database management system used.  

 The software status: "Alpha", "Beta" or "Release" 

 The version number of the PRO.FILE database used.  

 The actual used database when working with PRO.FILE.  

 The version number of the installed PRO.FILE-Version.  

 The actual registered user.  

 The current storage utilization of the PRO.FILE client in KB.  

 The installed CAD-Integrations, that is defined in the PRO.FILE-Management 

Console bills of materials mode.  
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Note: 

This window can also be accessed via the tray icon in the Windows system tray and via 

the context menu of the right mouse button. 

 

4.1.2 Defining the PRO.FILE default actions 

Via the function "Default actions" the user can specify the actions to be performed when 

a PRO.FILE object is double-clicked.  

 

Function call:: 

"File" => "Default actions…" 

 

If this function is selected, the following configuration window is displayed: 

 

 Object type: 
Specifies the object type, for which the selected action is to apply. 

 My settings: 
Here you can specify the action to be performed when the object is double-clicked. 

You can choose from a variety of actions as shown in the screenshot above. 

 Default settings: 
This column shows the default settings as per installation. If the user does not 

specify specific actions, the action from this column is used. 

Once you have made your changes, confirm with <OK> to close the window. 
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4.1.3 Settings for the start and shutdown of PRO.FILE 

The options in the window "Settings" determine the behavior of PRO.FILE upon Windows 

start and closing of the PRO.FILE window.   

 

 

Function call:: 

"File" => "Settings" 

 

The four options 

control the following: 

 

 "Start PRO.FILE automatically after Windows logon": When the user logs in to his 

Windows account, PRO.FILE is started automatically. 

 "When closed, PRO.FILE stays active in the system tray": When PRO.FILE is closed 

via the  icon, PRO.FILE stays active in the system tray and allows a quick access 

to the program again. 

 

 

Note: 

PRO.FILE only remains active when the  icon is used. If the function "Exit" from the 

menu "File" is used, the program is shut down completely. 

 

 "Allow PRO.FILE and other applications to come active to the foreground". This 

can be helpful, when an integration is used and an integration function requires 

action in PRO.FILE. 

 "Show tooltips in list and browser": Tooltips in list and browser displays can be 

deactivated via this setting. 

When tooltips are deactivated, you can press <CTRL> + <T> to reactivate the 

display of tooltips for the currently active list or browser display temporarily. This 

activation of tooltips via keaboard only applies for the current display and is not 

saved. 
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4.1.4 Change the currently logged on PRO.FILE user 

 The user authorities in PRO.FILE can be set independently for each individual user. In 

this way, the corresponding access authorities are activated for each individual user as 

he/she logs on.  

PRO.FILE traces all actions of the currently logged-in user, e.g. creating a document or 

changing a part. Part of this logged information is reflected in fields on the forms (e.g. 

"document created by") or the modification log.  

Therefore, it is recommended when changing the user on a workstation, to also carry 

out a change of the registered PRO.FILE user.  

You do not have restart PRO.FILE to change the user. The function "Switch user" can be 

used. 

 

 

Function call: 

"File" => "Switch user" 

 

After calling up this function, the log in screen of PRO.FILE will appear.  

The new user can now log in and start working with PRO.FILE.  

 

 

 

Note: 

Please note that when carrying out the user change, all screens and windows that are 

opened, will all be closed. 
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4.1.5 Change the PRO.FILE password 

Users have to log on to PRO.FILE with their user name and password.  

Users have the possibility to change their passwords. For security reasons, it is 

recommended to change the password on a regular basis.  

In order to change your PRO.FILE password access the function "Change password" in 

the PRO.FILE file menu.  

 

 

Function call: 

"File" => "Change password" 

 

You will now have to 

enter your current 

password, the new 

password and a 

confirmation of the 

new password in the 

mask that will appear. 

 

 

 You have to give your current password in order to verify yourself as the user who is 

authorized to change the password.  

 You have to confirm your new password. This is necessary because the password 

characters are hidden; the entries in the "Change Password" mask are indicated 

with "*" only. You have to repeat your entry in order to avoid possible typing errors.  

 Confirm your new password by clicking the <Modify> button.  

From this moment on, you will have to use the new password to log on to PRO.FILE.  

 

 

Note: 

Ask your system administrator for guidelines regarding the mandatory length and 

makeup of the password. 
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4.2 The tab "Start" 

The register tab "Start" contains the most frequently used PRO.FILE functions for quick 

access. 

The following list is to give you an overview of these functions. Detailed information can 

be found in the following chapters. 

 

 Group "Create": 
Functions for the creation of PRO.FILE 

objects. 

 

 Group "Edit": 
Functions for editing, locking or 

unlocking data records. 

 

 Group "Edit file": 

Functions for viewing, editing or 

opening a copy of files attached to a 

document description. 

 

 Group "Create link": 

The functions "Copy" and "Create link" 

can be used to create structures of 

PRO.FILE objects. The function "Copy 

search criterion" is used for the 

creation of dynamic saved searches. 

 

 Group "Manage": 

Functions for the changing of the 

PRO.FILE status and the sending of 

messages to other PRO.FILE users via 

the PRO.FILE Mail Connector. 

 

 Group "Current display": 

The function "Refresh" refreshes the 

currently displayed form, list or 

structure display (e.g. if data has 

changed in the background). 
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 Group "Open in new display": 

This function opens selected data 

records in a new tab as list, form or 

structure display. 

 

4.3 The tab "Edit" 

The tab "Edit" contains all of the commands that are required in the administration, and 

editing of data records. Whether a document, part, project, transmittal is active, whether 

a role is called up or also a structure overview, diverse commands can be found in this 

menu.  

From "New", "Modify" and "Duplicate" to "File processing", "Lock/Unlock" and "Redlining" 

through to status change commands, import/export functions, and for archiving and 

versioning.  

In this handbook, the working with PRO.FILE-objects is described in the chapters: 

 Working with documents in PRO.FILE  

 Working with parts in PRO.FILE 

 Transmittal: digital dispatch list with PRO.FILE 

 

For the PRO.FILE objects project, task and process, information can be found in the 

manual "Operation PRO.CEED Base". 

 

4.4 The tab "Search" 

It is a great advantage of PRO.FILE that the user can utilize detailed search and 

selection functions, so that precise information can be found and extracted from the 

database. To help with this you can use the PRO.FILE- "Search" tab.  

 

 

 

Note: 

The selection possibilities for documents are controlled and protected by the user 

access authorities. 

When a document, part or project is in a condition in which it may not be shown due 

to the users function access authority, it would also not be visible in the selection 

function. 
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A detailed description of the search functions can be found in the chapter "Searching 

and finding: selecting data records". 

 

4.5 The tab "View" 

After the selection of the data records in PRO.FILE, the information is presented in a list, 

or a form view.  

Using the tab "View", you have the additional possibility to call up further graphic 

descriptions of the data.  

There are special view types for all of the PRO.FILE objects. Therefore the functions that 

are available in the "View" tab, are always dependent on the actual called up object 

type, and also dependent on the present display (form or list). 

The following illustrations show the "View" tab the way it appears for:  

Documents in form display: 

 

Parts in form display: 

 

Documents in list view: 

 

Parts in list view: 
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The following list gives a brief overview of the available view types and the various 

functions. Further information can be taken from the following sub-chapters: 

 

  "Switch Form/List view":  

This icon allows you to switch between the form views and the list views of the 

currently  

accessed data records. 

  "List":  

Presents either an object that is active in the form display as a list, or one or more 

highlighted objects in a new list. See also the chapter "Working with lists". 

  "Form":  

Presents one or more highlighted objects in a form. See also the chapter "Working 

with forms".  

  "Structure":  

The active document or part will be displayed in the browser view. The browser 

view only covers one document or part at a time. Please also refer to chapter 

"Working with Browsers". 

 

 "Bill of materials":   
Enables you to call up different bill of materials view for the highlighted part. This 

includes the structure bill of materials, the single level bill of materials, the part 

usage, the structure list, with the depth and the quantity bill of materials.  

 "List of documents":   
Shows all documents that are attached to the highlighted part, in a new list view. 

Further information can be found in the chapter "Working with lists". 

 

 "Fwd":  
Proceeds to the next data record. 

 "Bwd":  
Returns to the previous data record.  

 "First object":   

Returns to the data record that was called up first.  

 "Last object":   

Returns to the last data record that was called up.  

These views are described in the following chapters.  

 

  "Views Manager" In PRO.FILE it is possible to create customized list views, and 

to save the lists produced. The administration of these list views is carried out using 

the view manager. The view manager is also used to publish these views for the use 

Views available 

for all objects:  

Views specifically 

for parts:  

Functions for 

scrolling/browsin

g in forms  

Additional 

functions:  
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of other users. Further information can be found in the chapter "Manage stored list 

views". 

 "Refresh": This menu point, or the hotkey F5 can be used to update the contents of 

a list or a form.   

 

4.5.1 Display a bill of materials for a selected part 

The function "Bill of materials" in the "View" menu gives you an additional submenu for 

the display of different characteristics or representations of bills of materials.  

 

The following different Bill of materials are generally available: 

 

If more parts or sub-assemblies have been built into an assembly, this command will 

show the attached parts in a Bill of material.  

The view as standard in the browser.  

  

Structure bill of 

materials 
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 Only the first level of the structure bill of material is shown.  

 The special list functions are available here as well so that the single-level BOM 

can be edited.  

 

 Via this command you can obtain a list which shows which parts in what quantities are 

built into a specific assembly.  

 

The special list functions are also available here for the further editing of the quantity 

BOM.  

 

 

This command creates a browser that shows in which assemblies the selected part was 

used.  If the selected part is an assembly of the highest level the browser will remain 

empty.  

The specific list functions are also available here for further processing of the part usage 

list. 

  

Single-level Bill of 

materials  

Quantity Bill of 

Materials 

Parts usage 
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4.5.2 Updating lists and forms  

By the Hotkey F5 or menu option "View" => "Refresh" contents in lists, forms or 

browsers can be updated. Data which are modified or expanded in the meantime will 

be updated and shown in the latest state in forms or lists.  

 

 

Note: 

Updating of lists, forms and browsers is not available for all windows. If a window does 

not react to the command, a corresponding message is displayed. 

 

4.6 The tab "Window" 

The PRO.FILE "Window" tab contains 

commands that are used to close 

individual or inactive or all tabs in the 

PRO.FILE user interface.  

If the mouse pointer is placed on the 

header of a list or form tab, these functions 

are also accessible from the context menu 

of the right mouse button.  

The following functions are available in the 

"Window" tab: 

 

 

 "Show in separate window":   

If this function is called, the currently active tab will be displayed in a new, separate 

window. This allows you to open multiple PRO.FILE windows next to one another. 

Please also refer to chapter: "Display tabs in a separate window". 

 "Close":   

Windows standard: closes the last active tab within the PRO.FILE user interface. 

(And not the last tab that was last open.)  

 "Close inactive": Closes all tabs of the PRO.FILE user interface except for the 

currently active one.  

 "Close all":   

Closes all tabs that were opened by the users so that only the PRO.FILE initial 

screen will be shown.  

 "Customize cockpit": 
As user can customized the information and widgets in the PRO.FILE Cockpit. See 

chapter "Tip: Customize the Cockpit". 
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Note: 

The currently active 

tab is always 

highlighted: 

 

 

4.6.1 Display tabs in a separate window 

Tab windows that are displayed within the PRO.FILE user interface can be opened as a 

separate independent window.  

A new window will be opened in addition to the PRO.FILE interface in which the selected 

tab will be displayed.  

By doing so you can also display multiple PRO.FILE list or form views in separate 

windows next to one another. This is beneficial for a repeated selection of "Copy" and 

"Link" for different data records.  

You can "pin" such a window in order to permanently place it in the foreground. Please 

refer to chapter "Pin separate windows of tab views to the foreground?" for more 

information. 
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Function call: 

"Window" => "Show in own window" 

 

1. Activate the tab that you want to display in a separate window. The currently active 

tab is always highlighted. 

2. Access the PRO.FILE "Window" menu and select the command "Show in own 

window".  

3. The activated tab will be opened in a separate window, as illustrated above. Now, 

it is no longer available within the tabs of the PRO.FILE user interface but only in 

this separate window.  

 

 

Note: 

Of course, the list function as described in chapter "Working with lists" is also available 

to you in these "separate windows".  

In these separate windows, the edit menu can be accessed from the context menu of 

the  right button! 

 

In order to bring a tab that is opened in a separate window back to the PRO.FILE user 

interface please click the  icon in the header of the separate window.  

 

If PRO.FILE tabs are opened in separate windows then these will act according to the 

Windows standard: if you click on the general PRO.FILE user interface again the 

separate windows will disappear to the background.  

However, the user can choose to permanently keep separate windows in the foreground 

of the general PRO.FILE window.  

In order to do this, use the  icon on the right hand side of the window header.  

Proceed as 

follows 

Bringing the 

separate window 

back to the 

PRO.FILE user 

interface 

Pin separate 

windows of tab 

views to the 

foreground? 
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The pin icons have the following meaning:  

  : The separate window is not permanently pinned to the foreground. This can 

be changed by clicking this symbol.  

  : The separate window is permanently pinned to the foreground. This can be 

changed by clicking this symbol. 

 

4.7 The PROOM tab 

PROOM is a solution for the document exchange in technical companies. For PROOM 

users, PRO.FILE offers a specific menu for the data exchange between PRO.FILE and 

PROOM. 

Detailed information can be found in the chapter "Optional: The PROOM Integration in 

PRO.FILE". 

 

Licenses required for PROOM 

In order to use the PROOM integration in PRO.FILE you need a PROOM Enterprise 

license. 
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4.8 How do I access the PRO.FILE online help? 

To support you in your work with PRO.FILE, you can access a help in NetHelp format. 

 

Function call: 

The help can can be accessed via the corresponding icon in the top right 

corner of PRO.FILE or via the "F1" key. 

 

 

When the function 

"PRO.FILE help" is selected, 

the PRO.FILE help is 

displayed in your web 

browser. 

 The left-hand structure 

contains the overview 

of all chapters, which 

you can select. 

 

 The information for the selected chapter is displayed in the right-hand window. 

 

Within the help window you can use the following functions: 

 

: 

Switching back and forth between help chapters  

Contents: Display of the chapter structure 

Full-text search Enter a search string. The entire help is searched for this string. Resulst are 

displayed in the left-hand bar. 

: 
Print the currently displayed help chapter 
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Note: Help access "locally" or via the internet 

The PRO.FILE help is either locally installed on your computer or company network – 

or is accessed via internet connection from the server of the company PROCAD. The 

second option has the advantage that the help is always up to date. 

You can see in the address bar of your web browser whether the help is accessed 

locally or via internet. Additional information for administrators can be found in the 

manual "Installation and administration PRO.FILE Online Help". 

 

 

4.9 Tip: Quick access to functions via the Quick Access Toolbar 

PRO.FILE has a quick access toolbar at the top 

left corner of the window. 

This toolbar allows for customized quick access 

to PRO.FILE functions. 

In accordance with Windows standard, you can 

deposit the functions most relevant to you in this 

toolbar. 

The contents of this quick access toolbar are 

displayed in dependence of the selected 

PRO.FILE objects: Depending on whether a 

document, part or project, etc. is selected, the 

available icon buttons are displayed or hidden. 
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5 Searching and finding: selecting data records  

 One basic activity when working with PRO.FILE is the search for existing data records. 

The search can be performed using four basic search types: 

 Possibility 1: search with the 

search form  

When searching using the search 

form, users can individually 

configure every single search.  

Please also refer to chapter 

"Searches using the search form" 

 

 Possibility 2: full-text search:   

Full-text search allows users to search for keywords or strings that can be found 

either in the object description or even in the attached files (of document 

descriptions) on the file server. 

See chapter "For data and files: the "Full-text 

search"". 

 

 Possibility 3: the Favorites and subscriptions:  
Favorites deliver a list of results with one click of the 

mouse and are therefore a fast search option. The 

favorites are defined by the user according to the user's 

specific requirements. Subscriptions are used to indicate 

changes to the objects that are found by the favorites.  

See chapter "Saved searches and subscriptions".  

 

 Possibility 4: the SmartSearch:   

A SmartSearch is a search form that 

only features the desired number of 

fields which drastically reduces 

complexity. A SmartSearch will only 

contain those fields that the user 

needs for a specific search. 

Please refer to chapter 

"SmartSearch". 
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For detailed information on the utilization as well as on the possibilities of search form, 

full-text search, Favorites and SmartSearch please refer to the following chapters. 

 

5.1 Searches using the search form 

If you want to search PRO.FILE for specific data you can choose between different 

possibilities that can be accessed through the "Search" menu. 

 

This menu offers various options for a detailed search and access to PRO.FILE objects to 

be displayed. 

During the search you can specify whether the search results are to be displayed in form 

or list display. 

 

Note: 

The selection possibilities for documents are controlled and protected by the user 

access authorities. 

When a document, part, project or transmittal finds itself in a condition in which it may 

not be shown due to the users function access authority, it would also not be visible in 

the selection function 

 

 

Function call: 

"Search" => Group "Search Objects" => "…" 
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This input form and the resulting procedures are different for the search for parts and 

documents. Detailed information can be found in the sub-chapters "Search for specific 

types of documents" and "Search for specific part characteristics" 

 

1. An input form is 

displayed (search 

form), in which you 

can entert he 

search criteria. 

Depending on the 

configuration, you 

can also use 

selection functions 

and reference lists. 

 

2. Search results in list or form display: 

 In the search form you can use the options at the bottom of the window to decide 

whether you want to display the search results in list or form view: 

 

 There is also the option Documents-parts list: 
This search function enables the selection of documents that are used with part 

characteristics in the selection screen of documents and CAD data.  

Using this function allows you to use information from the part master records for 

the selection of data as well as those of the document master record.   

This simplifies relocating documents and CAD drawings that you know belong to 

specific parts. If, for example, in the selection screen for documents the 

characteristic "Part number" is used, the results list will contain a list of the search 

criteria that refer to a specific part that is in the document. More information is 

available to you in chapter  

"Usage of part characteristics in the selection mask of documents and CAD-data". 

3. Search in versions? 

 Via the option "Also search in versions at the bottom of the search form you can 

enhance the search to also include versions of the document (or part – provided 

that part versions are activated in PRO.FILE). 

4. Specific search options for categories 

 You can also include categories in the search by activating the corresponding fields 

within the specified category field. The search will then include the selected 

categories as AND criteria, i.e. the search will find records that are assigned to at 

least one of the selected categories. 
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Right click on the field and select from the following options in the context menu: 

 Has categories: Searches all objects that have been assigned categories. 

 Does not have categories: Searches all object that have not been assigned 

categrories. 

 Purge field: Removes the current setting from the field. 

5. Do you want to combine the search fields with a full-text search? 

  Via the button <Next> you can combine your search form with a full-text 

search. The input for the full-text search is connected tot he input for the search 

form by an "AND"-connection. For more information see "For data and files: the 

"Full-text search"". 

 

 

 

6. After the input of your search strings, the search is started by clicking on the button 

<Search>. 

 The result of the search is displayed. 

 

 

Note: 

You can use the search form or the full-text search or both. Both options can be used 

separately. 

 

 

Note: 

The search step for the full-text search is only displayed the full-text search is 

configured for the database. 

 

 

Note: 

You can also use wildcards such as "*" as described in chapter "Note: Optimize your 

search by using wildcards". 

 

This search form and the resulting procedure differs for the search for documents and 

for the search for parts.  
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Please refer to the following subchapters:  

 Search for specific types of documents 

 Search for specific part characteristics 

 

If no data record matches the search, the following information dialog box will be 

displayed:  

 

 

Then a new selection form is displayed and new search criteria can be typed in. 

 

If a data record matches the search pattern,  

 the search resalts are displayed in list form or 

 the first of the found data records found is displayed in an output form. 

 

The icon  causes PRO.FLE to switch between form display and list display. 

Very general search criteria lead to the output of data records. The list commands make 

it quick and easy to reduce this output.  

Here the work can be done in various stages i.e. a list can be shortened, narrowing 

down the listed data records through more specific search criteria.  

By clicking on the icon , the selection form is displayed showing the previously 

entered search criteria. Additional criteria can be specified. (= Search repeat with 

search pattern retained / expanded.)  

When calling up this function, the previous search values are taken on in the new search 

field, they can then be either accepted as they are, or edited, shortened or lengthened.  

 

5.1.1 Search for specific types of documents 

If the search for documents is opened using the function "Search" => "Documents" the 

search form for documents will be displayed.  

This facilitates the selection of the document types.  

 

Unsuccessful 

search  

Successful search  
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Note: 

A document description in PRO.FILE always consists of two parts: the fixed document 

description and the variable document description. The fixed document description is 

identical for all documents in the database. The variable document description varies 

depending on the type of document that is selected. 

This allows users to capture different types of information for the document type "CAD" 

document and for the document type "Template", for example. 

 

You can find a list of the document types that are configured within your database in the 

left column of the search form. Simply click one of these list entries to select the desired 

document type. This can also be done using the drop down menu of the search form 

field "Type of document".  

Depending on your selection the search form will now show the corresponding variable 

document characteristics. These can now be used for the search as well:  
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5.1.2 Search for specific part characteristics 

If the search for parts is opened using the function "Selection" => "Parts" the search 

form for parts will be displayed.  

The list on the left hand side of the search form allows you to select specific 

characteristic for the search.  

 

 

Note: 

Different types of part information can be included in PRO.FILE depending on the level 

and depth of the key characteristics list. 

 

If a characteristic is selected the search form will automatically feature the 

corresponding search fields:  
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5.1.3 Narrow down a search result 

When the search via the search form is completed you will receive the data records that 

correspond to the search criteria, either in a list view or in a form view.  

In order to further narrow down these results and to fine-tune the 

search with additional criteria you can now use the "Change search" 

function: 

  

 

 

Function call:: 

Tab "Search" => "Change search" 

 

 Clicking this  icon will reopen the selection made for the active window. This 

search mask will then already include the previous search criteria. These values do 

not have to be entered again but can be fine-tuned and narrowed down.  

 Once the search is started these new search criteria will now be used for the data 

records that are already displayed in the active window.  

The selection in the active tab thus does not refer to the entire contents of the database 

but only to the contents of the active tab. You can find no new data records by 

expanding the criteria. It is only possible to further narrow down those you have already 

found. 

 

5.1.4 Narrow down the search for parts using the selection filter 

The function  that is located in the "Options" in the "Search" menu 

enables the pre-settings that are to be permanently used for a search, with additional 

search criteria, to be set. This can be of great advantage when searching for parts with 

specific CAD documents.  

 

 

Function call: 

"Search" => "Options" => "Filter parts search" 

 

After the function has been called up, a selection screen appears, in which you can set 

all of the required selection filters.  
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To do this you will find a list of different search criteria that can be activated by checking 

the respective checkbox. The checkboxes are activated with the mouse pointer.  

The following criteria are available through the selection filter:  

 Only parts without documents:   

This search will only find those parts that have no links to any documents.  

 Only parts with documents:   

This search will only find those parts that have at least one link to a document.  

 Only Assemblies:   
This search will only find those parts that are part of an assembly and therefore 

have links to other parts.  

 Only parts with documents of the integration types:   

If the filter setting "Only parts with documents" is activated then you can use this 

area to additionally select which documents of which integration should be taken 

into account. The desired integration types are activated by checking the respective 

checkbox.  

If multiple integration types were selected then the parts will have to be connected to all 

of the selected document types in order to be found by the search. Example: If the 

integration types "AutoCAD" and "MS Word" were selected the search will only find parts 

that are linked to the document master data of an AutoCAD document as well as to the 

document master data of a Word file.  

 

 

Note: 

(This option can only be selected if the selection "Only parts with documents" was 

activated beforehand). 
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Using this screen, it is possible through the application of "Use selection filter", to 

determine whether the set search filter is to be used during the next selection of 

PRO.FILE objects or not.  

 If the selection field is set to "Yes", the selection filter will be considered by every 

new search that is carried out. Therefore, only data records that fulfil the selection 

filter criteria will be found.  

 If the selection field is set to "No", the selection filter criteria will not be considered 

during a search.  

 

5.1.5 Usage of part characteristics in the selection mask of documents and CAD-data 

 With "Search" -> "Documents-parts list" you can use the characteristics of the part data 

in addition to the document data characteristics.  

The finding of documents an CAD-documents relating to relevant parts is easier. For 

example, if you use the characteristic "Part number" in the selection mask, the results list 

of the search will only contain documents relating to the relevant part. 

 

5.2 For data and files: the "Full-text search" 

Via the function "Full-text search in …", it is possible to search the part and document 

descriptions  

The full-text search allows users to search for keywords or strings that can be found 

either in the document or part description or even in the attached files on the file server.  

 

 

Note:  

The full-text search must be configured in the PRO.FILE Management Console, 

otherwise, an error message is displayed. 

 

The full-text search can always be accessed from two points within PRO.FILE: 

 from the PRO.FILE Cockpit:  
Please refer to chapter "Start the full-text 

search from the PRO.FILE Cockpit". 
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 and from the "Search" tab in the 

PRO.FILE ribbon bar:   

Here the user is given separate access 

to the full-text search for parts and for 

documents; the search for documents 

comprises further settings in order to 

include the attached file. For a detailed 

description please refer to chapter "Start 

the full-text search from the "Search" 

tab". 

 

 

5.2.1 Start the full-text search from the "Search" tab 

The full-text search in the PRO.FILE "Selection" menu gives users an additional search 

mask in which the conditions for the text search can be determined. The search mask for 

the search for documents differs from that for the search for parts.  

 

 

Function call: 

"Selection" => "Full-text search in documents"  
"Selection" => "Full-text search in …" 

 

After calling this function the following entry window will appear: 

Enter the desired search text. You 

can use letters, numbers, characters 

and links. 

 

Please also refer to chapter "Tips on using the search function "full-text search"". 

Confirm your entry by pressing the <OK> button. 

 PRO.FILE will now search the parts descriptions of the parts that are accessible to 

you in the database for the search text and provide a list of all search hits. 

  

Full-text search in 

parts, projects, 

processes, tasks 

and transmittals: 
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After calling this function, an entry window will appear that leaves room for 

differentiated specifications regarding the full-text search:  

 

 The search text can contain letters, numbers, characters and links (also explained in 

chapter: "Tips on using the search function "full-text search""). This search window offers 

different fields, one for the search in the document description and one for the search in 

the file that is attached to the document description:  

 Search in the meta data: The search term that is entered here refers to the 

document description, the meta data of the data record. The document 

descriptions of the document data records that are accessible to you will be 

searched for this search term.  

 Search in all files on: This is where the search term for the search within the 

physical files (e.g. a Word document or an AutoCAD document) is entered. All files 

accessible to you in the database that are attached to the document descriptions in 

PRO.FILE and that are saved via these document descriptions in PRO.FILE will be 

searched for the entered search term.  

The third setting lets you determine how the two search terms are to be used:  

 Result set:  

 Show only documents that match all search criteria: In order for a document to 

be included in the list of results, the search term for the document description 

has to be found as well as the search term for the attached file. Both search 

terms have to be found in order for the data record to be included in the 

results.  

 Show documents that match at least one search criterion: In order for a 

document to be included in the list of results either the search term for the 

document description or the search term for the attached file has to be found. 

The list of results will include all documents for which the meta data search 

term was found in the document description and, additionally, all documents 

for which the file search term was found in the attached file.  

Confirm your selection by pressing <OK>.  

The documents found for your search criteria will be displayed in a list. 

 

Via the function "Full-text search in Document list", a search via all files of documents in 

the current document list is started. 

  

Full-text search in 

documents 

Full-text search in 

document lists 
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After calling this function the input mask for your search term is displayed: 

 

This is to make a pre-selection of files to be searched. 

 

After calling this function the input mask for your search term is displayed: 

 

Via the function "Full-text search in files", a search via all files of documents accessible 

by the user is started. 

The search does not distinguish uppercase and lowercase spelling. 

The results of a search are displayed in a separate tab in list form. 

 

 

Settings:  

For the full-text search in metadata, the tables DOKSTAMM, DOKVAR, DOKVAR1, 

DOKVAR2, MLFIELD and DOKTYP are scanned. The full-text catalogue must be filled 

with these tables. 

 

Full-text search in 

files 
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5.2.2 Start the full-text search from the PRO.FILE Cockpit 

You can perform a full-text search from the PRO.FILE Cockpit directly after starting 

PRO.FILE. The Cockpit will always remain accessible to you via the tab in the PRO.FILE 

user interface.  

The full-text search from the Cockpit is realized using a single entry field:  

 Enter the term you are searching for into the "full-text search" field. You can use 

letters, numbers, characters and links. Please also refer to chapter: "Tips on using 

the search function "full-text search"".  

Use the icon on the right hand side of the entry field to determine whether you are 

searching for documents or parts:  

 

The corresponding icon will then either start the search for documents or for parts:  

 Parts:  
The parts descriptions available to you in the database will be searched for the 

search term. If the search term corresponds to information that is stored within a 

parts description then these parts descriptions will be included in the list of results.  

 Documents:  
The document description (meta data) as well as the contents of an attached file 

will be searched for the search term. All documents that are available to you in the 

database will be included in the search. The list of results will display all documents 

that either contains the search term in the document description or in the attached 

file.  

  Projects,  processes,  tasks,  transmittals: 
Here, too, the entered search string is looked up in the database. If the search 

string is found in one of the records for the selected object type, the results are 

displayed in a list. 

 

 

Attention: 

Please make sure that you perform the right type of search 

(documents/parts/projects/processes/tasks/transmittals) or you will not be able to 

obtain the desired results. 
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5.2.3 Tips on using the search function "full-text search" 

In the selection function "Full-text search in documents/parts ", it is possible to "play" 

different Wildcards and operators, to search for data as precisely as possible  

These possibilities are listed below and relate to the entry field ‚Search in Metadata for’ 

as well as the entry field ‚Search in files for’, unless an alternative is specifically 

mentioned.  

 

If you are searching for a particular word, this word should be entered into the entry 

field. The word can also be entered inquotation marks. If you are searching for a 

specific word order, it is important to note that the exact word order to be found, must 

be entered into the entry field in quotation marks.  

 

Different search criteria can be linked together. The following operations are available 

for this:  

OR  

AND  

NOT 

 

Example 1: Mountain OR Hill  

Either mountain or hill must be present in the searched data.  

 

Example 2: Mountain AND Hill  

In this search, both mountain and hill must be present. When searching metadata, 

mountain and hill must be present in a field.  

 

Example 3: Mountain AND NOT Hill  

When searching files, mountain must be present in the files, whereas hill must not be 

present. When searching in metadata, mountain must appear a field, but hill must not 

be present. 

 

Example 4: "John Smith" OR Hill  

In this search, the word order "John Smith" or hill must be present.  

  

Simple search for 

a word or word 

order:  

Working with 

logical operators:  

Examples:  
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If several words are entered, and there is no logical operator in the entry field, and the 

words have not been entered in quotation marks, the word AND will be placed 

automatically between the words. This means that if you run a search to find documents 

containing the word mountain as well as the word hill, you could use example 2, and it 

too could have AND left out. 

 

 

Attention: 

In a full text search in the metadata, the command AND means that both terms must 

be present in a field. It is not possible to carry out a search in which the "AND" relates 

to several fields. 

 

In contrast to the other PRO.FILE selection functions, when applying the selection 

function "Full text search in." as a Wildcard/Variable character, only the character "*" is 

allowed.  

"*" Stands for "random". 

 

  

Working with 

Wildcards/variab

le characters:  
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5.3 Note: Optimize your search by using wildcards 

For entering criteria the following wildcards are possible: 

 

replaces several symbols  

 

replaces one symbol  

 

smaller than 

 

greater than  

 

smaller or equal (only for float fields) 

 

greater or equal (only for float fields) 

 

from - to (Range Selection) 

 

Exclusion of the follow-up text 

 

"Or"- connection of two expressions 

 

Search for empty fields 

 

Search for not-empty fields 

[*] 

 

To search for percentages, the %-

character has to be replaced by this 

wildcard. 

Example: A search for "50% discount" 

should look like this: *50*[*]* 

 

Additional information on wildcards: 

 By entering "!" at the start of a search text, makes the search carry out a search, and 

show all results except those containing the text that follows the exclamation mark. 

(E.g. by entering "!Text1" all descriptions will be shown except those containing 

"Text1").  

 The entering of "||" into the search text, separates two phrases, and presents them 

as an OR-link, (e.g. the entry "Text1||Text2", shows all entries containing "Text1" or 

"Text2").  

 It is also possible to search using the date function. See also the chapter "Search 

using relative dates". 
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5.4 Search using relative dates 

When searching for PRO.FILE-objects, different date functions can also be set. In this 

way, it is possible to enter a sure date, a relative date, or a date range.  

In the date fields, using the button  , it is possible to call up the date selection 

function, the following entries are included:  

Yesterday (#-1)  

Today #  

Tomorrow (#+1)  

This week (#w)  

This month (#m)  

This year (#y)  

Last week (#w-1)  

Last month (#m-1)  

Last year (#y-1)  

Next week (#w+1)  

Next month (#m+1)  

Next year (#y+1)  

Until yesterday <=(#-1)  

Until today <=#  

Until tomorrow <=(#+1)  

Since yesterday >=(#-1)  

Since today >=#  

Since tomorrow <=(#+1)  

 

The user can also set the possible date entries. The following possibilities are available 

for this:  

 Search for a point in time with a simple date expression 

 Search for a point in time using relative date expressions 

 Search for a period in time by entering a relative date range 

 Search using a period of time by linking fixed and relative date expressions 

 Search using date comparison expressions 

 

 

Warning: 

When applying the date functions, no difference is made between work days and 

public holidays. 
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Note: 

It is also assumed that the operating system showed no problems with the year 2000. 

The projects parts and documents that have been searched for must have values that 

are after 31.12.1899 in the date fields. 

 

A simple date expression can be entered in the following way:  

#  Today 

#d  Today 

"Date"  Exact date, e.g. 29.05.2003 

 

 

Example: 

If the date criteria #d, is entered in the field "Reminder" of the favorite, the object with 

the date that matches exactly that of the date entry in the field "Reminder" of the 

favorite will be shown. 

In brief: If I call up the favorite on 12.4.2003, all objects with the reminder date 

12.4.2003 will be displayed. If I call up the favorite two days later, we would write 

14.4.2003 and the favorite would display all the objects with the reminder date 

14.4.2003. 

The same applies of course for e.g. Changes- and new created dates. 

 

When searching with relative date expression, you can enter a point in time that is 

related to a certain period of time from today’s date.  

The search with relative date expressions, are based therefore on relative time entries 

"Today".  

"Today" is entered as "#", "#d".  

In addition to this relative date, the period of time is then added, or taken away.  

The terms "d" for day, "w" for week, "m" for month, and "y" for year are used for this.  

The way to write it is as follows ("|" is to be read as "or"):  

(# +|-number d|w|m|y) or  

(#d +|-number d|w|m|y)  

 

Search for a point 

in time with a 

simple date 

expression  

Search for a point 

in time using 

relative date 

expressions 
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Example: 

#, #d  Today 

(#+5d)  Five days from today 

(#+1m)  A month from today 

(#-1y)  A year ago today 

 

When searching for a PRO.FILE-object, a relative date range can also be entered, which 

can provide information for a period of time in relation to today. The following terms 

are available for the entry of a relative date range:  

 #d Today  

 #w This week  

 #m This month  

 #y This year  

 

 

Note: 

The date range is always calculated in the given period of time from 0:00 to 23:59. 

 

These expressions can also be adapted. This can be done by using ("|" is to be read as 

"or"):  

 (#d +|-number)  

 (#w +|-number)  

 (#d +|-number)  

 (#d +|-number)  

"+|" Number always represents the amount of time in the future or past in which the 

search should be carried out.  

 

 

#y-5)  In the year 5 years ago 

(#m-1)  Last month 

(#d+1)  During tomorrow 

 

When searching for PRO.FILE-objects, many possibilities are available to link sure date 

entries and relative date entries, to carry out a search in a specific period of time.  

  

Search for a 

period in time by 

entering a relative 

date range 

Search using a 

period of time by 

linking fixed and 

relative date 

expressions 
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The following links are possible ("|" is to be read as "or"):  

 Entering the period of time using a sure date entry:  

 "Date" – "Date", e.g. 21.6.2002–5.4.2004  

 

 Entering the period of time using a sure- and a relative date entry:  

 "Date" – (# +|-Number d|w|m|y)   

e.g. 01.01.2003–(#-1d): From 1.1.2003 to yesterday.  

 (# +|-Number d|w|m|y) – "Date"   

e.g. (#-1m)-31.12.2003: From a month ago today to 31.12.2003  

 

 Entering the period of time using two relative time ranges:  

 (# +|-Number d|w|m|y)- (# +|-Number d|w|m|y)   

e.g. (#-1y)-(#-1d): A year ago today to yesterday.  

 

 

Note: 

The search over a period of time is only possible using the link of relative entries, not 

using the relative entries of a time range. 

 

When searching for objects, it is also possible to apply a simple comparison operation. 

The following possibilities can be used for this:  

>  After  

< Before  

>=  Then or after  

< =  Then or before  

 

 

Example: 

< 1.11.2003   search all objects that were created before 1.11.2003. 

< #d    All objects that were created before today. 

>=#w   All objects that were created after this week. 

 

The following examples help to explain the concept of the date search in PRO.FILE:  

#  Search all objects that were created today.  

<(#-1)  Search all objects that were created up until the day before 

yesterday.  

Search using date 

comparison 

expressions 

Examples for 

searches with 

date entries  
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#w  Search all objects that were created this week.  

(#m-1)  Search all objects that were created last month.  

1.1.03-(#-1)  Search all objects that were created between the 1.1.2003 and 

yesterday.  

<1.11.02  Search all objects that were created before the start of the 

1.11.2002.  

(#+1d)-

(#+1m)  

Search from tomorrow to a month from today.  

Example only for the new creation, or the editing of master records:  

(#+2)  Carry as reminder for the day after tomorrow.  
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6 Functions of the favorites bar 

Via the favorites bar at the left-hand side of the PRO.FILE 

Windows Client GUI, you get access to various advanced 

search and quick access functions. 

These are described in the following sub-chapters: 

 SmartSearch: Create your own form 

 Saved searches and subscriptions 

 Working with folders 

 

 

The favorites bar in the PRO.FILE user interface is by default displayed using the "Auto 

Hide" feature. This means that the favorites bar will always hide automatically when it is 

not needed in order to leave more room for the PRO.FILE user interface. 

1. In order to 

display the 

favorites bar 

simply click the 

"Favorites" tab on 

the left hand side 

of the PRO.FILE 

user interface: 

 

 The list of 

favorites will now 

be shown. It will 

remain open until 

the mouse pointer 

leaves the 

favorites bar. It 

will then 

disappear again. 

 

The display of the 

favorites bar. 
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2. You can also choose to lock the favorites bar for continuous viewing by clicking 

the  icon in the right upper corner of the favorites bar:  

 The favorites bar will now remain visible for your convenience.  

3. If you have locked the favorites bar, the auto hide feature can be reactivated by 

clicking the  icon. 

 

6.1 SmartSearch: Create your own form 

The search for data records using a 

SmartSearch offers users a saved 

search query in interactive form thus 

making the SmartSearch the perfect 

combination of the possibilities 

delivered by the search using saved 

searches and of those delivered by the 

search form.  

 

 

Using SmartSearch you can define your own search form: 

 A SmartSearch is a search form that can be set up to contain only the desired 

number of fields. Now, less fields have to be filled in which drastically reduces 

complexity. 

 A SmartSearch can include predefined search fields with preset search parameters 

(like the favorites) as well as search fields without search parameters (like the 

conventional search). The search mask thus remains interactive without having to 

manually complete every field. 

 Users are also given the possibility to make a fast and easy addition to the 

SmartSearch at any time in order to include a field that is required for the search at 

hand. 

 Each user can define any number of SmartSearches.  

 The SmartSearch can be used for parts, documents, projects, processes and tasks. 

 

For details see the following sub-chapters: 

 Access an existing SmartSearch 

 Create a new SmartSearch 

 Transform a completed standard search into a SmartSearch 
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 Permanently change an existing SmartSearch 

 Delete a SmartSearch? 

 Rename a SmartSearch 

 

6.1.1 Access an existing SmartSearch 

Because the SmartSearches are somewhat related to 

the saved searches, they were positioned in the same 

area on the left hand side of the PRO.FILE interface. 

They are displayed as an independent branch above 

the favorites: 

In order to access a SmartSearch simply place the 

mouse pointer on the desired SmartSearch entry and 

double click it with the left mouse button. (You can 

also use the right mouse button => "Show"). 

 

The stored SmartSearch will now be displayed as shown in the example below:  

 

Because a SmartSearch is usually comprised of only a few fields, these are simply 

arranged one below the other. The fields for a key characteristics list for parts or for 

variable document characteristics for documents are indented according to their 

structural depth.  

The field name for each field can be found on the left hand side. The same names are 

used as in the standard search form. The entry field for the entry or selection of your 

search criteria is on the right hand side.  

Users can now fill in the fields, change preset values in the entry fields, or even add new 

fields. (This is explained in the following chapter "Add more fields after accessing a 

SmartSearch". 

So if you want to narrow down your search, simply use the field on the right to specify 

your search criteria according to the field name on the left. If available, you can also 

select values from the drop down menu .  
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Note: 

If required fields are defined within the standard search form then these will also be 

displayed as required fields in the SmartSearch. They are marked in red and have to 

be filled in. The same is true for the selection functions and the expanding field entries. 

 

The actual search is then run by pressing the <OK> button.  

The results of the SmartSearch are displayed in a new window. They include all data 

records that match the criteria of the SmartSearch.  

If the search is repeated by clicking the "Change search" icon, the previous SmartSearch 

will reappear:  

 

 

If required, you can always easily add new fields, preset fields, or delete fields after 

accessing a SmartSearch in order to include additional criteria in the search.  

 

 

Attention: 

However, there are two ways to use these added fields in the SmartSearch: 

Permanently 

In order to permanently add fields to a SmartSearch so that they will be available for 

all future searches using this SmartSearch, the SmartSearch has to be saved in the 

editing mode. Please refer to chapter: "Permanently change an existing SmartSearch". 

Temporarily 

The fields are added for a single current search only. The next time you access the 

SmartSearch, the fields will not be available anymore. The SmartSearch will have gone 

back to its stored status. The added fields are only used once to temporarily include 

additional search criteria. The corresponding procedures are described in this chapter. 

 

These added fields are used only temporarily for the current search. Once the 

SmartSearch is accessed again it will be displayed as stored – without the added fields.  

1. Access the desired 

SmartSearch from the list by 

double-clicking it.  

2. In order to add another field, 

simply click the  icon of the 

preceding field on the desired 

level. 

 

Add more fields 

after accessing a 

SmartSearch 

Proceed as 

follows  
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Note: 

Fields that are related to the document type or to the key characteristics list are always 

indented to show their dependencies. A new field will always be displayed on the level 

on which the  icon was selected. 

 If the  icon of an indented field is selected, an additional indented field will 

appear, if available. 

 In order to obtain an additional, non-indented field, simply click the  icon of a 

preceding field on the first level. 

 

 An empty field will appear. You can now use the drop down menu  to select an 

appropriate field from the list and name the new field. All fields that are available in 

the standard PRO.FILE search mask are also available for selection.  

 

 

 

 Once you have selected a search field, the new entry field will appear. You can 

now enter the corresponding search criteria:   

 

  

 

 You can now add further fields by following this procedure. Start your search by 

pressing <OK> once you have included all of the desired search criteria.  

 The documents or parts found with these criteria will be displayed in a list view in 

the PRO.FILE user interface.  
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Note: 

Fields that are not configured within the standard search form cannot be included in a 

SmartSearch. 

 

In order to remove fields that are no longer required, simply click the  icon of the 

field you want to delete.  

If there are any structure-relevant subentries to this field these will have to be deleted 

first. 

 

6.1.2 Create a new SmartSearch 

 

1. Creating a new SmartSearch is very easy. Simply follow these instructions:  

 

 

 

If you want to define a new SmartSearch that will remain available to you, please 

mark the list item SmartSearch that can be found above the list of favorites. Then 

use the context menu of the right mouse button to access the functions "New" => 

"Part", "Document", "Project", "Process" or "Task". 

 

You have to decide whether you want to create a SmartSearch for documents, 

parts, projects, processes or tasks. Naturally, there are different selection fields for 

the different object types. 

 

 A window will appear in which you can define the fields and field values that are to 

be used.  
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Use the drop down menu  to select the first field you want to include in the 

SmartSearch. 

 

2. After you have selected an entry from the list, the field name will be displayed and 

another field will appear next to it into which you can enter the field values.   

 

 

 

If any selections are defined for this field these are available through the  icon for 

the entry of the field value. (Please also refer to the following subchapter "Field 

types available for the creation of a SmartSearch").  

 

3. Additional fields on the same level: By clicking the  icon you can add additional 

fields on the same level. They are then determined the same way with field name 

and entry field for the field value.   
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4. Additional fields on structured levels: If a field value is entered within a structure-

relevant field (item class or document type), another structure level is automatically 

created in which the fields of the related structure level are displayed. In order for 

you to be able to select fields on every structure level, at least one field (even an 

empty field) has to be displayed:   

 

 

 

If all fields of a structure level are already configured in the SmartSearch, no new 

fields can be added through the  icon.  
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Note: 

Fields that are related to the document type or to the key characteristics list are always 

indented to show their dependencies. A new field will always be displayed on the level 

on which the  icon was selected. 

If the  icon of an indented field is selected, an additional indented field will appear, 

if available. 

In order to obtain an additional, non-indented field, simply click the  icon of a 

preceding field on the first level. 

 

5. In order to further facilitate the execution of a SmartSearch, the defined entry fields 

can be preset with field values or left empty.  

 

 

 

Preset fields can be overwritten at any time when later executing a SmartSearch.  

6. Once a SmartSearch is completely set up with the desired field names, entry fields 

and preset fields it can be stored by pressing the <OK> button.  

7. Another entry mask will appear in which you have to specify a name for this 

SmartSearch. You can also add a description of the SmartSearch:   

 

 

 

Name and description are also stored after pressing the <OK> button.  
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 The respective SmartSearch will then be available to you in the upper corner of the 

PRO.FILE info bar:  

 

A SmartSearch can now be accessed by double-clicking the desired SmartSearch entry 

in the list. 

 

 

Note: 

Please keep in mind that a SmartSearch can be freely adjusted or modified upon 

accessing it. These changes, however, will only be temporary as described in chapter 

"Add more fields after accessing a SmartSearch" and will not be available to you when 

the SmartSearch is used again. To permanently change a SmartSearch please follow 

the instructions in chapter: "Permanently change an existing SmartSearch". 

 

Field types available for the creation of a SmartSearch 

The SmartSearch lets you use the fundamental fields that are also available for the 

PRO.FILE standard search.  

 

 Fields with entries of item classes / document characteristics:  
Fields for an item class or for variable document characteristics are indented due to 

their structural depth.  

 Required fields:   

If any required fields are defined in the search, they will automatically be included 

when defining a SmartSearch. However, it will be rather unusual to define required 

fields for search form.  

 Fields with expanding entries:   

If a field is used when defining a SmartSearch that fills in additional fields through a 

reference list, then these fields will be automatically added to the SmartSearch.  

 Fields with selection functions:   

The same selection functions as in the search form are available in the 

SmartSearch. 
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Note: 

Fields that are not configured in the standard search form cannot be used for a 

SmartSearch. Only those fields are available that were set up for the standard search 

form by the administrator. 

 

6.1.3 Transform a completed standard search into a SmartSearch 

In addition to a manual definition of a SmartSearch, you can also choose to use a 

completed standard search as the basis for the definition of a SmartSearch.  

The applied search criteria are stored when the search is completed and then used for a 

new SmartSearch. Please follow the instructions below:  

1. Access a search 

using the 

PRO.FILE 

"Selection" menu 

and enter the 

desired search 

criteria. (Please 

refer to chapter 

"Searches using 

the search form" 

for more 

information). 

 

2. The results 

will be 

displayed in a 

tab within the 

PRO.FILE user 

interface. 

Within this list 

of results, 

now select the 

function 

"Copy search 

criterion" from 

the "Modify" 

menu or from 

the context 

menu of the 

right mouse 

button: 

 

Proceed as 

follows 
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3. The third step is the creation of a 

new SmartSearch: mark the list entry 

"SmartSearch" in the PRO.FILE info 

bar and use the context menu of the 

right mouse button to select the 

command "New" => "Part", 

"Document", "Project", "Process" or 

"Task". The stored search fields will 

now be automatically displayed in 

the SmartSearch: 

 

 

 

Note: 

The object type of the SmartSearch that is to be created has to correspond to the 

object type of the stored search: if criteria for the search for documents were stored a 

SmartSearch for documents will be automatically created. A SmartSearch for parts can 

only be automatically created if the stored criteria were for parts as well. 

 

4. This predefined SmartSearch can now, if required, be adjusted, abridged, or 

extended. It is also possible to include preset values.  

5. The creation is then confirmed and stored by pressing the <OK> button.  

 Now all you have to do is add a name and a description (see chapter "Create a 

new SmartSearch") and the SmartSearch will be available to you in the upper 

corner of the PRO.FILE info bar. 
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6.1.4 Permanently change an existing SmartSearch 

As already mentioned, there are two possibilities to change a SmartSearch.  

 You can always apply temporary changes to a SmartSearch after accessing it by 

adjusting fields and preset values or by adding new fields. These changes will, 

however, only apply to the search at hand. They will not be stored in the 

SmartSearch and will not be available to you the next time you access this 

SmartSearch.  

 Permanent changes to fields, preset values, and additional options within the 

SmartSearch will be stored within the SmartSearch and will be available to you 

every time you access this SmartSearch again.  

 

In order to permanently change a SmartSearch, simply follow the instructions below: 

1. Mark the SmartSearch whose search criteria 

you wish to change in the list of 

SmartSearches.  

2. Use the context menu of the right mouse 

button to select the command "Modify" => 

"Modify": 

 

 The current definition of the 

SmartSearch will be displayed:  

3. You can now apply the desired 

changes to the SmartSearch. Please 

also refer to chapter "Create a new 

SmartSearch". 

 

4. Once you have completed all changes store the SmartSearch using the <OK> 

button.  

 The changes will be stored and will be available to you every time you access this 

SmartSearch.  

6.1.5 Delete a SmartSearch? 

SmartSearches that are no longer required can be deleted from the list.  

 

 

Attention: 

The deletion of a SmartSearch is irreversible. Recovery is not possible! 
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1. Mark the SmartSearch that you want to delete in the list within the info bar.  

2. Select the command "Modify" => "Delete" from the context menu of the right 

mouse button:  

 

 

 

3. IF you really want to irretrievably delete the selected SmartSearch confirm the 

selection with "Yes":   

 

 

 

 The selected SmartSearch will be irreversibly deleted from the PRO.FILE database.  

Please refer to chapter: "Create a new SmartSearch" for more information on the 

creation of SmartSearches. 

 

Proceed as 

follows  
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6.1.6 Rename a SmartSearch 

Users can choose to adjust their SmartSearches and to apply permanent changes to 

them whenever they please. And so the original name that was given upon creation of 

the SmartSearch may sometimes become unsuitable.  

If you want to change the name of a SmartSearch please follow these instructions:  

1. Mark the SmartSearch that you want to rename in the list within the info bar.  

2. use the context menu of the right mouse button to select the function "Modify" => 

"Rename":  
 

  

 

 A window will appear where you can enter the name and the description:  

 

  

 

Now change the name of the SmartSearch and, if required, its description.  

3. Close the window and save your changes by clicking <OK>.  

 The change of the name of the SmartSearch will now be displayed in the PRO.FILE 

info bar.  
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6.2 Saved searches and subscriptions 

Saved searches offer additional possibilities, including the automated performance of 

such searches upon PRO.FILE start 

All information on favorites: 

 What are saved searches and subscriptions? 

 Working with saved searches and subscriptions 

 

6.2.1 What are saved searches and subscriptions? 

Another useful tool for quick and structured calling up of the regularly used documents, 

parts, projects, and transmittals saved searches in PRO.FILE  

This allows for favorite documents being quickly accessed without going through data 

selection forms. Then, results are displayed in a document list.  

A simple mouse click on one of the 

saved searches in the favorites list will 

display the list of documents, parts or 

projects that is specified for this saved 

search. 

Here you can choose  

 whether you want to use a saved 

search to define bookmarks for 

specific documents/parts/projects  

 or if you want to include search 

criteria for such objects as a 

bookmark. Accordingly, all 

documents, parts or projects will be 

accessed that either correspond to 

the ID numbers or to the search 

criteria specified within the favorite. 

In order to ensure that you are always 

automatically up to date, you can utilize 

subscriptions: A subscription can be 

created for any saved search. This 

subscription monitors a saved search. If 

changes are made to the subscribed 

documents, parts or projects, this is 

indicated in the information bar behind 

the respective subscription in brackets. 
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Each user has the possibility to create a multitude of different saved searhces for specific 

documents, parts or projects and for frequently used selection criteria for the 

corresponding data records.  

Using the favorite management, you have quicker access to:  

 Any Documents, Parts and Projects  

 Any Document lists, Part lists and Project lists  

 Any selection criteria without having to enter data. 

 

 Once defined, PRO.FILE allows you to make your favorites available to other users. 

You can display and use favorites of other users.  

 In the "Public folders" you can deposit favorites for every other user to access. 

 It is also possible to define a favorite as an Autostart-Favorite. When starting 

PRO.FILE, the documents and the parts of this favorite will automatically be loaded 

into the list presentation. 

Saved searches can be presented, created, listed, administered, and activated in the 

favorites bar. 

The favorites bar is accessed through the "Favorites" tab on the left 

hand side of the PRO.FILE user interface.  

You can then lock the favorites bar for continuous viewing by 

clicking the  icon. The auto hide function of the favorites bar can 

be reactivated by clicking the  icon.  

The favorite overview presents the created favorites as an info-tree. 

The individual branches of this info-tree can be blended in or out 

with the use of a double mouse click.  

Accessing 

documents, parts 

or projects 

Saved searches 

offer the following 

possibilities 
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In this favorite overview, the saved searches of the actual user are shown under the user 

name. Also saved searches of other users can be called up via the corresponding user 

names.  

A particularly helpful feature within PRO.FILE includes a function for modifying existing 

saved searches, by including or excluding documents or search criteria:  

 For example, using a saved search you can organize documents, parts or projects 

along with common selection criteria, such as documents with IDs 17080 and 

25098 along with the "e-mail" document type.  

 Once defined, criteria for a saved search can be modified. You can include or 

exclude criteria as well as include those of other document types (e.g. the selection 

of all documents that have been released except "CAD" documents and documents 

that are older than ten days).  

 Additionally, you can exclude objects from a saved search by explicitly excluding its 

ID.  

 Relative time entries remain saved, and are re-evaluated at every new start.  

The following chapters describe functions and handling of saved searches. 

 

For each saved search that you create, it is possible via mouse click to simultaneously 

create a subscription.   

When PRO.FILE is started, a comparison is carried out in the subscription, to see if 

anything has been changed in the object of the saved search. A check will be run to see 

if new or changed objects exist.  

If this is the case, the number of changes and reforms will be shown after the name of 

the subscription in brackets, in the PRO.FILE info bar.  

 

These displayed changes can then, with the click of the mouse, be called up in the form 

of a list on the subscription in PRO.FILE.  

Combine saved 

searches 

To keep you up to 

date: The 

subscriptions  
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6.2.2 Working with saved searches and subscriptions 

PRO.FILE introduces the ability to use saved 

searches for quick access to frequently used 

data objects and documents. For access to the 

commands and functions, the favorites 

administration offers a context menu.  

Right-clicking the mouse in the list of saved 

searches will display this menu.  

With this editing menu all actions connecting 

the favorites administration can be executed. 

This menu contains the following functions: 

 Display: displays the contents of a saved 

search or a subscription in the form of a 

list. This function can also be applied by a 

double click on the desired saved search 

or subscription in the favorites bar.  

 

 New: The menu allows users to create saved searches and subscriptions. A 

structure can be built by creating sub-folders, which allows for the organization of 

saved searches. To find out more about the creation of saved searches and 

subscriptions please refer to the chapters: 

 Create a new saved search 

 Create a new subscription 

 Create folders to structure the favorites 

 Rename: Renames an existing saved search or structure folder. It is also used to 

modify the description of the saved search. The contents of the saved search will 

remain unchanged.  

 Modify: This function allows the editing of the saved search with respect to the 

memorized objects and search criteria. See also the chapter "Change the contents 

of saved searches". 

 Delete: Removes a saved search or subscription from the favorites list. See also the 

chapter "Delete saved searches and users from the list". 

 

 

Caution – undo is not possible: 

This command will irretrievably delete saved searches and subscriptions. 

 

 Copy, Insert:  

Function to copy a saved search – even a saved search of another user. See 

chapter: "Copy " for further information. 
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 Move: Using the functions "Cut" and "Insert", you can move saved searches and 

subscriptions and their superior folders via the PRO.FILE clipboard to another 

folder. Structure folders, saved searches and subscriptions can also be moved to 

other positions of structure, using drag & drop. See chapter "Moving saved 

searches, subscriptions and their folders using drag & drop" for further information. 

 Extend / Extend (visible versions): Using the respective function, the selected saved 

search (i.e. the search criteria it contains) is enhanced by the contents of the 

PRO.FILE clipboard. This is applies for documents in the clipboard as well as for 

search criteria. See also "The functions "Extend" and "Reduce"".  

 Reduce / Reduce (visible versions): Using this command, the existing saved 

searches are reduced by the contents of the PRO.FILE clipboard. This applies for 

documents in the clipboard as well as search criteria. See also the chapter "The 

functions "Extend" and "Reduce"". 

 Check subscriptions: Subscriptions inform the user of the changes to the elements 

in the respective saved search. The subscriptions are automatically updated when 

PRO.FILE is started. This function is available to give an updated version of the 

subscription whilst working in PRO.FILE.  

 Saved search as autostart: Using this function, a saved search can be set up, so 

that when PRO.FILE is started it is opened immediately. The contents of the saved 

searches are then immediately displayed in the form of a list. If a saved search is 

set as autostart, "(Auto start)" will be noted in parentheses after the name of the 

saved search.  

 Saved searches of other user: Enables a user, with the help of the sub functions 

"Display" and "Hide", to access the saved searches of another user and also to hide 

them, without having to create them personally. "Show" and "Hide" always relate to 

all saved searches and subscriptions of a user.  

 Properties: Shows the properties windows of the saved search. This window 

contains the name of the saved search and a field with detail information on the 

saved search. 

 

Saved searches, subscriptions and the folders of their relating structures, can be moved 

and sorted by simple use of the drag & drop method.  

To do this, click on the required folder, saved search, or subscription, and drag the 

mouse pointer to the new position, keeping the mouse button held down until you are in 

the new position.  

Note that folders, Saved searches, and subscriptions can only be attached to other 

folders in the structure, not to other Saved searches or subscriptions. 

  

Moving saved 

searches, 

subscriptions and 

their folders using 

drag & drop 
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6.2.3 Create a new saved search 

With the favorite administration of PRO.FILE document lists can be created and can be 

stored by a favorite name for a recall.  

Using PRO.FILE favorites management, you can define two different kinds of favorites: 

 Static: You can define a list of objects to be found by the saved search. You may 

include or exclude further objects of the same type at a later time for this saved 

search.  

 Dynamic: You can define search criteria for objects via a saved search. When 

using search criteria with a saved search, PRO.FILE first initiates a selection on all 

affected objects in the database and then displays the results in a list.  

Creation of saved searches is always based on data stored in the PRO.FILE Clipboard 

and therefore requires that you use the "Memorize" function to assign objects with a 

saved search.  

A saved search can be made up from individual documents ("Copy") or from criterion 

("Copy search criterion "). The criteria for this search represent the foundation for the 

saved search. After the search results have been displayed in the list or form within 

PRO.FILE, the search will be saved in the interim save in PRO.FILE, with:  

 "Copy": When the saved search should contain the exact contents of the search.  

 "Copy search criterion": When the saved searchis to be made up of the criterion 

that makes up the search result.  

 

 

Note: 

A saved search can only display one type of object within a list. It is not possible, e.g. 

to display documents and projects in the same list. 

 

Create a static saved search   Create a dynamic saved search 

1. Select the desired data records in 

a list. 

 1. Start a search with a search form. 

Use the search criteria to be 

stored in the saved search.  

2. Choose one of the following functions from the context menu using the right 

mouse: 

3. "Copy"  3. "Copy search criterion" 

 

  

Proceed as 

follows 
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4. In the node named with your user-name on the left side of the favorites bar select 

the node named "Saved Seaches" (or one of its sub-folders). 

 

5. Select the function "New" => "Save new search" from the context menu (right 

mouse button). 

6. Enter a name and description for your saved search. 

7. Confirm with <OK>. 

 The saved search is thus created and available in the list of saved searches. 

 Double-clicking the saved search will result in PRO.FILE displaying the memorized 

data records or the results of the search criteria memorized.  

 

The Extend and Reduce commands are very helpful in managing saved searches. 

 They are used to modify the contents (documents and selection criteria) of a saved 

search.  

 When these commands are used, the PRO.FILE Clipboard is checked for objects 

and attributes to be included or excluded to/from a saved search. This works for 

objects as well as for selection criteria. 

 Particular objects can be excluded from a favorite with the command "Reduce". The 

"Reduce" command is also used to define exception rules when a set of search 

criteria is to be saved. 

On the following pages we illustrate working with favorites using an example:  

 

 

Note: 

A saved search can only display one type of object within a list. It is not possible, e.g. 

to display documents and projects in the same list. 

 

  

The functions 

"Extend" and 

"Reduce" 
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6.2.4 Example: creation, enhancement and reduction of saved searches 

Let's assume that a user often access three particular product specification documents. 

The user can create a saved searcg for convenient and quick access. The documents 

are already shown in a document list. 

1. To collect the documents with a saved search, the user selects the three documents 

in a document list window.Next, the "Copy" command is called (using the right 

mouse button or from the "Edit" menu).  

 

 This results in PRO.FILE adding these three documents to the PRO.FILE Clipboard. 

The next step is to activate the list of saved searches in the favorites bar. Now we can 

create a new saved search: 

2. Right-click the mouse, then select 

the "Save new search" command. 

PRO.FILE creates a saved search 

and includes the documents stored 

in the PRO.FILE clipboard with it. 
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3. Upon creation, PRO.FILE 

displays a form prompting for 

a name to be given to the 

saved searcg. In this example, 

we have entered "My 

documents". A description of 

the saved search can be 

added as well.  

4. Confirm your input with <OK>. 

 PRO.FILE updates the list of saved searches to include the new one. 

Double-clicking the saved search will result in PRO.FILE displaying a window containing 

a list with objects that have been defined for the favorite. 

Now we want to enhance the definition of the saved search by all order documents that 

the user is allowed to see. To accomplish this, we would like to add a document 

selection using only one criterion (document type equals "Order").  

5. To add the search criterion to the saved search, we initiate a select command for 

documents. When the selection form is displayed, we enter "Order" in the document 

type field.  

 PRO.FILE displays all existing and for this user accessible orders in a document list 

window.  

6. We can now initiate the process for adding the search criterion to the saved search 

by selecting the "Copy search criteria" command from the "Edit" menu. You can 

access the "Edit" menu by right-clicking the mouse or by selecting it from the 

PRO.FILE menu bar.  

 PRO.FILE memorizes the criteria used for the search, the results of which are 

displayed in the current list.  

7. We have to switch to the favorites window for adding the criterion to the saved 

search. Select the saved search you would like to add the criterion to; in our 

example this is the saved search "My documents". Then, select the "Extend" 

command from the context menu.  

 With the command "Extend" the search criterion is now included in the favorites 

definition.  

8. Now, what happens if you double click the saved search "My documents"? The 3 

specification documents are displayed and a document selection with the document 

type equals "Order" criterion is executed.  

 Then, PRO.FILE displays all found documents in a document list window.  

  

Enhance the 

search 
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Saved searches may also be extended by actual documents. To do this, you highlight 

the desired in a document list, copy them to the PRO.FILE Clipboard and add them to 

the saved search using the "Extend" command after selecting the saved search "My 

documents" inside the favorites window.  

After investigating the document list we notice that it also includes documents that are in 

the "Approval" workflow state. We would like to exclude these documents.  

 We can accomplish this by excluding these documents from the saved search.  

9. Just like with including documents, we initiate a document selection. When the form 

for entering search criteria is displayed, we enter "Approval" in the workflow state 

field. PRO.FILE now displays a window with a list of all documents that are 

accessible for this user and that are in the "Approval" workflow state.  

10. As with including search criteria, we right-click the mouse or activate the "Edit" 

menu form the PRO.FILE menu bar and select the "Copy search criterion" 

command.  

 PRO.FILE then copies these criteria to the PRO.FILE clipboard.  

11. We have to switch to the favorites window to add 

this criterion to the saved search.  

 The "Reduce" command results in excluding the 

documents for which the above search criterion 

(workflow status equals "Approval") applies. 

Activation of the "My documents" favorite will 

result in an object selection based on these 

criteria: All documents for which the document 

type equals "Orders" except documents that have 

the "Approval" workflow status assigned.  

 

 

Now, what happens if you double click the "My documents" favorite? The 3 quote 

documents are displayed and a document selection with the document type equals 

"Order" criterion is executed. Then, PRO.FILE excludes all documents that have the 

"Approval" workflow state assigned from this list. Results are displayed in a document list 

window  

Saved searcges may also be defined to exclude actual documents. To do this, you 

highlight the desired documents (document no. 14360, i.e.) in a document list, copy 

them to the PRO.FILE Clipboard and add them to the definition of the saved search 

using the "Reduce" command after selecting the saved search "My documents" inside the 

favorites window. 

 

Comments:  

Reduce the search  

The result 

Comment:  
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6.2.5 Copy saved searches 

Each save search that can be accessed can also be copied. 

The context menu of a saved search contains the 

functions "Copy", "Cut" and "Insert" 

 Copy: copies the selected saved search to the 

internal clipboard. 

 Cut: copies the selected saved search to the 

internal clipboard and removes it from its current 

position. 

 Insert: inserts the copied saved search at the 

target location from the internal clipboard. 

 

 When the function "Copy" is used, a dialog for naming the resulting copy is 

displayed. 

 If the source is a folder, the folder with all sub-folders and saved searches in it is 

copied. 
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6.2.6 Create a new subscription 

Subscriptions are always created in relation to a specific saved search. They monitor 

saved searches and inform the user of changes to the results of the saved search. The 

update of the saved search is made upon the start of PRO.FILE, or when the function 

"Check subscriptions" is selected from the context menu of the favorites bar.  

If you want to create a subscription, a saved search has to be selected so that it can be 

monitored by the subscription. Then the command "New" => "Subscription" has to be 

called up from the context menu. 

A subscription always has the same name as the saved search. It now appears in the 

subscriptions folder. 

When changes occur in the results of the saved 

search, the amount is shown in parentheses after the 

corresponding subscription. 

  

 

 

Attention: 

Relative time entries in saved searches can sometimes lead to undesired effects in 

connection with subscriptions. This is especially the case if date ranges are set very 

tight, and the subscription is not updated regularly. 

 

6.2.7 Saved searches with relative time entries 

Relative time entries in saved searches can sometimes lead to undesired effects in 

connection with subscriptions. This is especially the case when date ranges are set very 

closely, and the subscription is not called up regularly.  

Information on updates and changes are only shown for the set date range when the 

subscription is called up. If the time period of time that the subscription is not called up 

is longer than the time range of the saved search, the information about the updates 

and changes is incomplete.  

You should be aware of this problem when setting up subscriptions!!  
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Example: 

Let us assume the following: There is a saved searchefor a certain status that goes on 

the basis of the noted criterion. In the related subscription, the user is informed about 

newly created parts.  

The saved searches is then activated, so that only new creation from this week (#w) will 

be considered. These criteria will of course then be taken on by the subscription. The 

information for the user will then always be correct, as long as the subscription is called 

up every week (Diagram 1).  

In the diagram, in calendar week (W) 1, everything is ok.  

 

Then the user goes on holiday for two weeks, he comes back in calendar week 4.  

When he now opens the subscription, he will be informed of the new creations in 

calendar week 4.  

Due to the time setting in the subscription, he will also be informed of newly created 

parts in calendar weeks 2 and 3. As the saved searches then is set only to provide 

information on the actual week, the information from weeks 2 and 3 is filtered out.  

The user will expect to be given results from weeks 2 and 3 as well as week 4. But he 

will not be informed of the changes in weeks 2 and 3, because of the limitations of the 

date range.  

 

This example is designed to make the user aware of possible problems that can occur 

when using relative time entries.  

  



Operation PRO.FILE advanced Saved searches and subscriptions 

PRO.FILE Release 8.7 
June 2017 Page 142 of 241 

This problem can be remedied by:  

 Using a saved search with autostart instead of a subscription  

 Using a saved search without relative time entries  

 Using a saved search with a longer time range, so that each holiday is covered, 

(e.g.: (#30)-(#+30): the 60 days around today). 

 

6.2.8 Create folders to structure the favorites 

Users can create their own folders within the PRO.FILE favorites bar in order to structure 

their saved searches and subscriptions.  

 

 

Note: 

The creation of a folder structure in the "Public folder" area is only possible for users 

who have the access right "Writing access to public folders". 

 

The folders are created within the structure of saved searches. Simply follow the 

instructions below:  

 Mark the folder within the structure to which you want to attach an additional 

subfolder.  

 Select the function "New" => "New folder" from the context menu of the right 

mouse button.  

 Enter the name for the subfolder that is to be created. Try to select a self-

explanatory name in order to facilitate your future work with this folder.  

 You can enter a description in addition to the folder name. This description will 

facilitate the flow of information on the purpose of the created folder.  

 Please confirm the creation of the folder with <OK>.  

The created folder will now be displayed in the structure. You can now move this folder 

within this structure or place existing saved searches in this folder using drag and drop. 

Please refer to chapter "Moving saved searches, subscriptions and their folders using 

drag & drop" for more information. 

 

 

Note: 

Folders can only be created underneath an existing folder. 
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6.2.9 Change the contents of saved searches 

This function allows you to:  

 display and delete the ID numbers of a saved search.  

 display, modify and delete the criteria of a saved search.  

 delete or modify individual criteria for extended or abridged saved searches.  

In order to edit a saved searchsimply follow these instructions:  

1. Mark the saved searchyou want to modify in the list of saved searches.  

2. Select the function "Modify" from the context menu of the right mouse button.  

The criteria and ID numbers that are stored for the saved search will now be listed in a 

new window:  

 

The left column of the mask displays the applied criteria or the stored ID numbers of the 

saved search.  

Criteria and ID numbers are indicated as follows:  

 With for factored criteria and ID numbers.  

 With  for excluded (abridged) criteria and ID numbers.  

If the entry "Criteria" or "Ident numbers" is marked in the left column the corresponding 

values will be displayed in the right column.  

Individual contents of the applied search criteria or individual ID numbers can be 

deleted from the saved searches using the context menu of the right mouse button, as 

shown in the above illustration.  

The stored criteria and ID numbers as well can be edited in the left column of the mask.  
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Mark the respective entry and use the following functions from the context menu of the 

right mouse button in order to do so:  

 Display:  
Shows all objects found using the ID number or stored criteria.  

 Modify:  
Allows you to modify or supplement stored criteria.  

 Delete:  
Irretrievably deletes stored criteria or ID numbers from the saved searches. It is not 

possible to undo this deletion! 

 Change examination: 
This function specifies for memorized objects (memorized via ID number), whether 

the newest visible version is to be found or the exact memorized version. 

 

6.2.10 Delete saved searches and users from the list 

The function "Delete" lets you delete a marked saved search, subscription or folder 

including the corresponding bookmarks from the list of saved searches. This will only 

delete "bookmarks" but no documents.  

 

 

Caution – undo is not possible 

This command will irretrievably delete saved searches and subscriptions. 

 

In order to delete a subscription, saved search or folder simply follows these instructions:  

1. Mark the subscription, saved search or folder that you want to delete in the list.  

2. Select the command "Delete" from the context menu of the right mouse button.  

3. Confirm the deletion   

 

 

 

 The selected subscription, saved search or folder will now be irretrievably deleted!  

 

 

Attention:  

You should make sure that you no longer need the saved searches contained in a 

folder, since these will be deleted along with the folder. 
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6.2.11 Access other users’ saved searches 

The PRO.FILE favorites management allows for adding and maintaining saved searches 

defined by other users to the list of your own searches.  

To do this, the user is added to the favorite overview using the functions "Saved 

searches of other users" => "Show", and by doing this, all of the existing favorites of 

the actual user are made visible (this depends on the user authority level).  

 

 

Note: 

For the display of saved searches of other users, you need the corresponding function 

access right. 

 

1. Open the list of saved searches and select the function "Saved searches of other 
users" => "Display" from the context menu.  

2. A selection screen will now appear, from which you can choose the user whose 

saved searches should be displayed. In this mask the name can be selected from a 

list via the selection button . 

 The saved searches of the selected user are displayed in the list of saved searches.  

In order to hide a user from this list, simply select the respective user in the list of saved 

searches and select the command "Saved searches of other users" => "Hide" from the 

context menu. 

6.2.12 Public saved searches 

PRO.FILE gives you the possibility to save searches to a public folder as well.  

Saved searches in the folder "Public saved 

searches" are available to all users within the 

same PRO.FILE database. 

Saved searches in the public folder have to 

always be created in this folder because a 

separate authorization is required for the 

creation. 

The procedures for creating, deleting, editing 

and further managing saved searches in the 

public folder are the same as the general 

procedures for saved searches that are 

described in the previous chapters. 

  

 

Proceed as 

follows 

Hiding other users 

from the list 
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Note: 

Users need the corresponding function access rights in order to make saved searches 

available and to manage them in the public folder. These are administrated via the 

PRO.FILE Management Console. 

 

6.3 Working with folders 

Folders are PRO.FILE Objects used for the structuring of data and for the quick saving 

of files in PRO.FILE. 

As a simple structure object, folders are neither subject to the status network nor to the 

version chain. 

Detailed information on working with folders can be found in the following sub-

chapters: 

 Folder types 

 Create, edit and delete folders 

 Data structure with folders 

 Duplicate folder 

 Display and manage folders in the favorites bar 

 Quick saving of files via drag & drop 

 Configure folders for quick save 

 Delete fast-check-in configuration of a folder 

 

6.3.1 Folder types 

There are different types of folders available: 

 Default folder: A PRO.FILE object for structuring your data and for the quick saving 

of files, as described in the following chapters. 

 Valid/invalid template: Templates for folder structures including linked documents, 

parts and tasks that can be used for the work without projects. These templates can 

be duplicated, as long as the type of the folder is set to "valid template". 

If the type is set to "invalid template", the folder cannot be duplciated. 

See also the chapter "Duplicate folder". 

 Valid project template / invalid project template: Folders can be used to define 

structure templates that can be applied for the creation of projects. 

For details, see the manual "Operation PRO.CEED Base"  

 

Folder:Definition 



Operation PRO.FILE advanced Working with folders 

PRO.FILE Release 8.7 
June 2017 Page 147 of 241 

 

Note: function access rights 

Please note that the usage of the functions described in the following sub-chapters 

requires the corresponding function access rights. If required, please contact your 

PRO.FILE administrator.  

 

6.3.2 Create, edit and delete folders 

This chapter details the functions for creating, editing and deleting folders in PRO.FILE. 

 

Proceed as follows 

1. Select the function "New folder" either from the menu "Start" or in the PRO.FILE 

Cockpit. 

 The form for the creation of a new folder is displayed. 

2. Enter the information for the description and classification of the folder into the 

corresponding fields. 

3. For the field "Type" see the chapter "Folder types". 

4. Confirm your entries with <Finish>. 

 The new folder is now displayed in the tab "New folders" and can be used as 

structure object for documents, parts and tasks. 

 

To change the description of a folder or to rename it, Proceed as follows 

1. Use the PRO.FILE search functions (see chapter "Searching and finding: selecting 

data records") to display the folder to be changed in a list or form. 

2. If displayed in a list, select the desired folder. 

3. Select the function "Modify" either from the "Edit" menu ribbon or from the context 

menu. 

 The form for editing the folder description is displayed. 

4. Make the desired changes. 

5. Confirm your changes with <Modify>. 

 The folder description is changed and the updated folder description is displayed. 

 

To delete a folder Proceed as follows 

1. Use the PRO.FILE search functions (see chapter "Searching and finding: selecting 

data records") to display the folder to be deleted in a list or form. 

2. If displayed in a list, select the desired folder. 

3. Select the function "Delete" either from the "Edit" menu ribbon or from the context 

menu. 

Create a new 

folder 

Edit an existing 

folder 

Delete a folder 
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 You are now prompted to confirm the deletion of the folder. 

 

 

Attention – Undo not possible: 

The deletion of a folder cannot cannot be undone. 

 

4. If you really want to delete the folder, confirm the dialog with <Yes>. 

 The folder is deleted from PRO.FILE. 

 If the folder was linked in the favorites bar, it is also removed there. 

 Links of the deleted folder to documents, parts, projects or tasks are also deleted. 

 

6.3.3 Data structure with folders 

Folders can be used to enhance the structure of other folders or of projects. 

You can link parts, 

documents, projects 

transmittals, processes 

or tasks to your 

folders. 

The link type between 

folders and documents 

can be set to either 

static or dynamic. 

 

Further inofmration on the structuring of PRO.FILE objects can be found in the chapter 

"Copy and link PRO.FILE Objects". 

 

6.3.4 Duplicate folder 

Folders can be duplicated, including the objects in their structure. With this method, in 

particular folders of the type "Valid template" can be used for the pre-definition of entire 

structures to be duplicated on demand. 

When a folder is duplicated, the following aspects are to be noted: 

 Only folders of the type "Standard" or "Valid template" can be duplicated. 

 Only the objects directly linked to the duplicated folder are duplicated, too. 

Exception: If a task is linked to a folder and documents are linked to the task, these 

documents are duplicated as well. 
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 If a folder is linked to the duplicated folder, it is also duplicated including its sub-

structure of directly linked objects. 

 If the duplicated folder is configured for quick save, the configuration is duplicated 

as well. 

 Transmittals and processes are ignored when a folder is duplicated. 

 

1. Use the PRO.FILE search functions (see chapter "Searching and finding: selecting 

data records") to display the folder to be duplicated in a list or form. 

2. If displayed in a list, select the desired folder. 

3. Select the function "Duplicate" either from the "Edit" menu ribbon or from the 

context menu. 

 The form for the creation of a new folder is displayed. 

4. Enter the information for the description and classification of the folder into the 

corresponding fields. 

5. For the field "Type" see the chapter "Folder types". 

6. Confirm your entries with <Finish>. 

7. All other PRO.FILE objects that are directly linked to the original folder can now be 

duplicated as well. 

For each of these objects, the corresponding check-in wizard is now displayed. For 

each object you actually want to duplicate, click <Finish> in the corresponding 

checl-in wizard. For each object, you do not want to duplicate, click <Cancel> in 

the corresponding check-in wizard. 

 The new folder with the duplicated structure is now displayed in the tab "New 

folders" and can be used as structure object for further documents, parts and tasks. 

  

Proceed as 

follows 
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6.3.5 Display and manage folders in the favorites bar 

Folders can be included in the PRO.FILE favorites bar for quick access. 

By double-clicking on the desired folder in the favorites bar, the corresponding folder 

description is opened in a PRO.FILE tab. 

 

1. Use the PRO.FILE search functions (see chapter "Searching and finding: selecting 

data records") to display the desired folder in a list or form. 

2. If displayed in a list, select the desired folder(s). 

3. Select the function "Copy" either from the "Edit" menu ribbon or from the context 

menu. 

 The selected folder(s) is/are copied to the PRO.FILE clipboard. 

4. Select the node "Folders" in the favorites 

bar. 

5. Select the function "Insert folder" from the 

context menu. 

 

 The folder is now displayed in 
the favaorites bar. 

 

 

Proceed as 

follows 
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Note: 

If a folder that is linked to the 

favorites bar contains sub-folders, 

the sub-structure is now also 

displayed in the favorites bar. 

 

 

To remove a folder from the favorites bar Proceed as follows 

1. Select the folder to be removed in the favorites bar. 

 

 

Attention: 

When the following function is used, the folder is removed immediately from the 

favorites bar without further inquiry. 

 

2. Select the function "Remove folder" from the 

context mneu. 

 The selected folder is no longer displayed in 

the favorites bar. 

 The folder is not deleted and can still be found 

via the PRO.FILE search functions. 

 

 

6.3.6 Quick saving of files via drag & drop 

Folders can be used for the quick saving of files via drag & drop in PRO.FILE. A new 

document description is created based on a pre-configured classification that can be 

configured for each folder individually. 

See the following chapter "Configure folders for quick save". 

 

 

Note:  

Folder configured for the quick saving of files in 

PRO.FILE are displayed in the favorites bar with an 

upward arrow. 
 

The quick saving via drag & drop is only possible for folders showing this arrow icon. 

 

1. Select the file to be saved in Windows Explorer.  

Remove a folder 

from the favorites 

bar. 

Proceed as 

follows 
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2. Drag the file 

 to the desired folder in the PRO.FILE favorites 

bar 

 to a folder displayed in a PRO.FILE form or list 

tab. 

 

The further steps depend on whether the folder has been configured for quick save with 

or without check-in wizard (see chapter "Configure folders for quick save"). 

3A "Without check-in wizard" the document description is created immediately 

according to the pre-configured classification and the file is saved. 

3B If the quick saving is not configured without check-in wizard, the check-in wizard is 

displayed and you can adjust the pre-filled document description. 

4. The file to be saved is attached to the new document description and displayed in a 

PRO.FILE tab labeled "new documents". 

 

6.3.7 Configure folders for quick save 

Folders can be used for the quick saving of files via drag & drop in PRO.FILE as 

described in the previous chapter. 

To be able to use this function, the folder has to be configured with information to be 

entered into the new document descriptions. 

1. Select the folder to be configured either in a list or form display or in the favorites 

bar. 

2. Select the function "Quick save" => "Configure" 

from the context menu. 

 

 The window for the quick save 

configuration is displayed. 

 The functionality of this window 

corresponds to the functionality of a 

window for the configuration of a 

SmartSearch. 

 

3.  Select the fields of the document description that are to be filled automatically 

during the quick save action. 

Proceed as 

follows 
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4. Enter the values for the selected fields. 

5. Via the checkbox at the bottom, specify whether the check-in wizard is to be 

displayed for the quick save action. 

 If the checkbox is activated, the check-in wizard is displayed during the quick 

save action and the preconfigured values can be adjusted. 

 If the the checkbox is not activatedm the document description is created 

without further interaction based on the preconfigured information. 

6. Confirm your settings with <Save>. 

 The preconfigured values are now used for the quick saving of files via drag & drop 

in this folder. 

 Folder configured for the quick saving of files in 

PRO.FILE are displayed in the favorites bar with an 

upward arrow. 
 

 

 

Attention: 

In order to use the option "Check-in without check-in wizard", you have to make sure 

that all required fields (red corner triangle) of the document description are filed with 

valid values. 

If this is not the case, the check-in wizard will be displayed in order for the required 

fields to be filled manually. 
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6.3.8 Delete fast-check-in configuration of a folder 

Folders can be used for the quick saving of files via drag & drop in PRO.FILE as 

described in the previous chapter. This configuration can be removed so that the folder 

is no longer used for quick saving. 

 

 

Attention: 

The deletion of a quick save configuration is made without a confirmation dialog 

immediately after the function call. 

 

1. Select the folder, the quick save configuration of which you want to delete, either in 

a list or form display or in the favorites bar. 

2. Select the function "Quick save" => "Delete 
configuration" from the context menu. 

 The configuration is deleted without further 

inquiry. 

 The icon of the folder is now displayed without 

upward arrow. 
 

 

Proceed as 

follows 
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7 Working with documents in PRO.FILE  

PRO.FILE unifies the handling of documents, CAD data, Office files, etc. and allows a 

direct and joint access to these different objects and their listing in a document list. 

 

Function call:  

"Edit" => … 

 

The functions in the edit menu of PRO.FILE can either be applied to the document 

description or to the file attached to this document description. 

The functions for editing the document description can be found in the tab "Edit": 

 

The functions for editing the file attached to a document description can be found in the 

tab "Edit file": 

 

 

All of these functions can also be accessed via the context menu (right mouse button). 

 

7.1 Create new document description 

There are two basic possible preconditions:  

Neither parts nor documents have been selected, nor has a document been created:  

 

Function call: 

"Start" => "New document " 

 

Documents have already been selected. The system "knows" therefore that the 

subsequent Edit functions will refer to documents.  

 

Function call: 

"Edit" => "New document" 
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An input form will be displayed that has the same basic setup as the form for the 

creation of a new part. The setup and layout of a data entry are in the PRO.FILE 

Management Console. After all required data is entered and the description is 

confirmed through clicking on ‘OK’, PRO.FILE will display the stored document 

description in a new form.  

 

Note: 

The start status of a document is dependent on the system configuration of the user, 

and on the document type. 

 

7.1.1 Save files in PRO.FILE using drag & drop 

Drag & drop with the file manager allows to you to save and link files with a simple drag 

using the mouse. By dragging a selected file from the file manager (Explorer) to the 

menu bar in the PRO.FILE user interface, you can create a new document description 

and a link to the object.  

 

 

 

Attention: 

The check-in of files using drag & drop will only work if the icon is dragged to the 

PRO.FILE menu bar. Dragging it to another location within the PRO.FILE interface will 

be of no result! 

 

In order to save files in PRO.FILE, drag the file that is to be saved to the PRO.FILE menu 

bar. Once the file is placed there, the PRO.FILE Checkin wizard will appear.  

You can now use the Checkin wizard to either create a new document description, 

adopt the data of an existing document description, or directly attach the file to an 

existing document description.  

The file about to be saved can be seen in the header of the CheckIn Wizard. 
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7.1.2 Check in files and directly link them 

In addition to the check-in of files to PRO.FILE (see chapter "Save files in PRO.FILE using 

drag & drop") you can directly link the data record that is to be created with an existing 

data record when saving it.  

In order to do so, the document or part with which you want to link the new data record 

with has to be displayed in the browser view and selected.  

Then, using drag & drop, the file that is to be saved is dragged from the Explorer 

directly to the object selected in the browser view with which you want to link it with.  

The new document can then be created as usual. Following the storage assistant, a 

window will appear in which you are asked to confirm the immediate creation of the 

link.  

  

If you confirm this with "Yes", the link to the object that was previously selected in the 

browser view will be created directly upon creation of the document data record. 

7.1.3 Create document description "New with data" 

In Menu "Edit" you will find an additional command for creating new document 

descriptions "New with data".  

The selected data records can be copied with this command.  

A document description is supposed to be activated in the PRO.FILE window. The 

master records of this document description are already inserted in the new document 

for creating and can be modified in this mask.  

The files relating to the data records will not be copied.  

 

Function call: 

"Edit" => "New with data" 

 

An insert mask with the already inserted fields corresponding to the previous active 

document appears. After insertion the document description will be displayed in a form.  

 

Note: 

The start status of a document is dependent on the system configuration of the user, 

and on the document type. 
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7.2 The PRO.FILE Checkin wizard 

In order to save files in PRO.FILE, drag the file that is to be saved to the PRO.FILE menu 

bar. Once the file is placed there, the PRO.FILE storage assistant will appear.  

You can now use the storage assistant to either create a new document description, 

adopt the data of an existing document description, or directly attach the file to an 

existing document description. 

By dragging a selected file from the file manager (Explorer) to the menu bar in the 

PRO.FILE user interface, you can create a new document description and a link to the 

object. 

The process of saving is carried out in a number of stages. The outcome of each 

individual stage determines the dialog that will appear for the next stage. 

 

 

Note: 

The description of the processes in connection with PRO.FILE may vary from your 

actual business situation. This is due to the fact that actions, which are executed after 

the execution of a command, can be configured differently in PRO.FILE. This 

particularly applies to the PRO.FILE areas of status administration, part and project 

assignment, change management and change history. 

 

1. Drag the file from the windows explorer or from the Windows desktop to the menu 

or icon bar of PRO.FILE  

2. Drop the file.  

3. The Checkin wizard is displayed supporting you in the saving process. 

 

Saving of new objects in PRO.FILE takes place in two steps: 

 Checkin wizard Step 1: Creation of the document description in PRO.FILE 

 Checkin wizard Step 2: Assignment of the created document to a PRO.FILE project 

 

These steps are described in the following sub-chapters. 

7.2.1 Checkin wizard Step 1: Creation of the document description in PRO.FILE 

All files saved in PRO.FILE are generally stored under the object type "Document".  

In order to save the file now to PRO.FILE, the corresponding document description must 

be entered to describe and classify the CAD document and to make it available for 

further usage.  
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For this, the Checkin wizard for the document description is available: 

 

Note: Which file is 

about to be saved can 

be seen in the header 

of the CheckIn Wizard 

 

You can access four options through the buttons in the upper half of the CheckIn 

Wizard: 

 

Create new:  

Usage:  

 A new document description is to be created.  

1. Fill in the information for the description of the document.  

 2. After entering all required document data, confirm the creation of the document 

description in PRO.FILE with <Next>. The new document description is saved. 

 

 Select in list:  

Usage:   

 The document to be saved is not to be linked to a new document description but to 

an existing one.   

1. Click the option <Select in list> to select the desired document description.  

 The wizard displays the PRO.FILE surface, as it was opened the last time. 

2. If the document description desired for assignment is not yet displayed in a list or 

form view, you can use the search functions of the Cockpit, the "Search" menu or 

favorites and SmartSearch to start a search.  

3. If the document description desired for assignment is displayed in a list view, you 

can now select it. (If the desired document is displayed in form view, it is already 

selected automatically).  

Proceeding:  

Proceeding:  
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4. Confirm your selection with <Next>. 

 

 Search:  

Usage:  

 The document to be saved is not to be linked to a new document description but to 

an existing one.   

 The desired document is not yet displayed in PRO.FILE and has to be searched for 

before assignment of the document description.  

 

1. Click the option <Search> to select the desired document description.  

2. Enter the search criteria into the displayed search form and click <Search>.  

3. Select the desired document record from the list of results.  

4. Confirm your selection with <OK>. 

 

 New using template:  

Usage:  

 A new document description is to be created for the new document.  

 To make the creation of a new document record easier, an existing document 

record can be used as template with pre-filled fields, which only need to be 

adjusted.  

 

1. Click the option <New using template> to select the desired document 

description.  

 The wizard displays the PRO.FILE surface, as it was opened the last time.  

2. If the document record that is to be used as template is not yet displayed in a list or 

form view, you can use the search functions of the Cockpit, the "Search" menu or 

favorites and SmartSearch to start a search. 

3. If the document record that is to be used as template is displayed in a list view, you 

can now select it. (If the desired document record is displayed in form view, it is 

already selected automatically).  

4. Confirm the selection of the document description with <Next>.  

 The input form for the creation of the document record is pre-filled with the data 

from the selected part document record.  

5. Make the necessary adjustments to the pre-filled data.  

6. Once all required document data is entered, confirm the creation of the new 

document record in PRO.FILE with <Next>.  

 The new document description is saved. 

Proceeding:  

Proceeding:  
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The Checkin wizard now continues with the options of assigning the newly created 

objects to a PRO.FILE project. 

 

7.2.2 Checkin wizard Step 2: Assignment of the created document to a PRO.FILE 

project 

In this step the document just saved can be assigned to a specific PRO.FILE project. 

 

 

Note: Usage of PRO.FILE projects 

The third step in the Checkin wizard is intended for the use of PRO.FILE projects. If you 

are not using PRO.FILE projects, you can skip this step with the option <Skip>. 

 

For this project assignment of the newly created document description an existing 

project must be selected, or a new project must be created. 

 

 

Note: The title bar of 

the Checkin wizard 

displays the 

documents that are 

currently being 

handled. 

 

Here, too, the Checkin wizard offers different options that can be accessed via the 

operations bar: 

 

 

 

Attention: Project must be activated 

In order for a document to be linked to a project, this project must be ACTIVATED. 

This means that for all of the following options, you have to select the option "Activate" 

afterwards. 
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The proceeding for these options is the same as for the first two steps of the Checkin 

wizard: 

  Create new:  

A new project is created in PRO.FILE. The document description created in step 1 is 

assigned to this new project. 

  Search:  

The document description created in step 1 is to be assigned to an existing project. 

This project is now searched via the search form and selected.  

  Select in list:  

The document description created in step 1 is to be assigned to an existing project. 

This project is already displayed in a PRO.FILE list and only has to be selected and 

confirmed. 

  Activate:  

If a project is activated, all new parts and documents in PRO.FILE are automatically 

assigned to this project. If no project is currently activated, and you want to do so, 

you can use this function to activate a project. 

  Deactivate  

Again: If a project is activated, all new parts and documents in PRO.FILE are 

automatically assigned to this project. If this assignment is not to be made for the 

current document, you can deactivate the project before finalizing the saving 

process.  

Note: If a project is activated, this is displayed in the title bar of the active PRO.FILE 

window. 

 

Proceeding: 

For the assignment of new documents to a project via the Checkin wizard Proceed as 

follows 

1. Select an existing project or create a new one. 

2. Select this project in the list view (project in form view are automatically selected). 

3. You now must select "Activate". Only if the selected project has been activated, the 

assignment to the project is made after confirmation. 

4. Confirm your proceeding with <Finish>. 

 

The saving of the document in PRO.FILE is now finished. 

7.3 Opening a document file 

The documents saved under PRO.FILE can be created within various applications such 

as documents from Microsoft Word, or spreadsheets in Microsoft Excel etc.  
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The menu command "File edit" from the PRO.FILE "Edit"-Menu allows the user to edit a 

document in its original application. 

 

 

Function call:  

"File edit" => "Document" => … 

 

These commands are available:  

 "Display":   

Displays the document in one of the viewer-programs that have been set up for 

viewing.  

 "Edit document":   
Extracts a document from the database for modification.  

 "Redline":   

Extracts a document from the database for redlining.  

 "Open copy":   

Extracts a copy of the document from the database.  
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7.3.1 Change documents 

When changing documents in PRO.FILE you need to decide: 

 Do you want to change the 

document description? (See 

chapter "Modify document 

description"). 

 

 Or do you want to edit the 

attached document? (See 

chapter "Check out document 

file for editing "). 

 

 

7.3.2 Modify document description  

To modify and delete a document, follow the same procedures as for a part.  

 

 

Function call: 

"Edit" => "Edit" and "Edit" => "Delete" 
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7.3.3 Check out document file for editing  

To open a document file for editing, select the function "Edit" from the menu "Edit file" or 

the button "Edit". 

 

Function call:  

"Edit file" => "Edit"  

 

 "Edit":   

Extracts a document from the database for modification. 

 

7.3.4 Note: Change document type 

With PRO.FILE a document type can be modified subsequently. The modifying can be 

made in the modification mask – the field document type is, by default, not locked in 

this case.  

This function can be executed only in the modifying mask for one document, not for 

several chosen documents.  

Modification of a document type initiates the following:  

 The variable characteristics related to the old document type will be deleted.  

 If a document is saved to a modified document description, it will be copied to the 

new document description.  

 An empty input mask occurs and the new attributes can be inserted in the variable 

document description.  

 

Note: 

Renaming of the document type is not allowed with archived documents. 
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7.4 Opening and editing a document file  

The documents saved under PRO.FILE can be created within various applications such 

as documents from Microsoft Word, or spreadsheets in Microsoft Excel etc.  

The menu "File edit" allows the user to edit a document in its original application.  

These commands are available:  

 "Display":   

Displays the document in one of the viewer-programs that have been set up for 

viewing.  

 "Print":   

Prints the document using the printer that is set up as the standard for the operating 

system.  

 "Edit":   

Extracts a document from the database for modification.  

 "Redline":   

Extracts a document from the database for redlining.  

 "Open copy ":   

Extracts a copy of the document from the database.  

 "Delete":   

Deletes the document permanently (!) from the database.  

 "Export for editing" 

 "Export local copy" 

 "Copy link to Clipboard":   

This function enables you to create an http-link to the file attached to the document 

master record and copy this link to the Clipboard. In this way the link to the 

corresponding document e.g. in all office programs, can be taken on. 

 "Add Thumbnail":   

A preview picture (a so-called thumbnail) of the document master can be saved to 

the document, which gives an insight as to what is contained in the document 

before it is opened. Once this function has been called up, you must select 

between a "*.jpg" or "*.bmp"-file that will then be used in the list and form views. 

Additional information can be found in the chapter "Displaying thumbnails in lists 

and forms". 

 "Remove Thumbnail":   

This function deletes the thumbnail saved to the document master.  

Depending on the system configuration, these functions can be launched within 

respective applications by the operating system or through additional programs.  

PRO.FILE will launch the document related application if necessary.  

Also, PRO.FILE checks for any possible lock statuses or other limitations in the user 

rights and statuses.  

 



Operation PRO.FILE advanced Further functions for document management 

PRO.FILE Release 8.7 
June 2017 Page 167 of 241 

7.5 Further functions for document management 

The PRO.FILE "Edit" menu offers the following further functions for the management of 

documents: 

 Delete documents 

 New version of documents  

 Status change of documents 

 Export / Import of documents with PRO.FILE (Option) 

 Note: Document management using drag & drop 

 What happens if I exit PRO.FILE while documents are still checked out? 

 

7.5.1 Delete documents 

If the document description is deleted, the attached document will be deleted as well.  

The Menu function Edit => File Edit => Remove document deletes a document but not 

its description. 

7.5.2 New version of documents  

 A document can be "frozen" in its current revision. This is done by creating a new 

revision without having the previous revision updated. 

 

Function call:  

"Edit" => "New version/revision" 

 

PRO.FILE creates a new document description and copies the attached files. A reference 

of this new document description is established to the prior versions/revisions.  

 Only the latest revision will be displayed.  

 To find out whether there are any old revisions of a document, got to the 

dependent tab "Versions" 

All previous revisions are listed here. 

 

7.5.3 Status change of documents 

 Statuses, following the workflow plan, can be assigned to documents; these can then 

be transferred according to the current document.  

Also, a linked part can be in a different status than the related document.   

The procedures are for all objects the same, please refer to the chapter: "Transfer of a 

document, part or project into another status". 
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7.5.4 Export / Import of documents with PRO.FILE (Option) 

The PRO.FILE-commands "Export document" and "Import document" support companies 

in forwarding technical documents to the "extended workbench" and guarantees the 

proper recycling of the documents  

When exporting documents from PRO.FILE, the primary data is added to a local export 

directory where they can be passed on according to the requirements at hand. Due to 

this functionality, the corresponding data record will remain locked in PRO.FILE until 

reimport. This avoids the occurrence of competing changes.  

All that PRO.FILE requires for the import is the name of the directory in which the 

exported folder can be found. The data is brought back from there and stored or 

versioned according to user specifications. Versioning can also be automated for 

specific statuses. Following the import, the corresponding data records will be unlocked 

again in PRO.FILE. 

 

Simply follow these instructions in order to export documents:  

1. In PRO.FILE, open the documents that are to be exported in the list or form view 

and mark them.  

2. Now select the command "Export document" from the PRO.FILE "Edit" menu or from 

the context menu of the right mouse button. 

 

 

Function call:  

"File Edit" => "Export for editing" 

 

 A directory browser will appear in which you can select the folder to which you want 

to export the document:  

 

 

3. A new folder can be created through the <Make New Folder> button. In order to 

do so you have to first select the structure level on which you want to create the 

new folder. 

Proceed as 

follows 
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4. The selected documents will be added to new subdirectories within the selected 

directory by pressing the <OK> button. A modification note will be automatically 

generated in PRO.FILE and the exported data records will be locked.  

 

A reliable lock and information mechanism will avoid conflicting changes and parallel 

processing for the duration of the external processing. Corresponding messages will 

indicate the status of the document if someone tries to retrieve it.  

A subdirectory will be created in the selected export directory for each document 

selected in PRO.FILE. The names that are used for the subdirectories correspond to the 

PRO.FILE ID numbers of the selected documents. 

 

The exported data can now be retrieved from these directories e.g. by using the 

Windows explorer and then passed on according to the requirements at hand. 

 

 

Attention: 

The subdirectory that is created according to the PRO.FILE ID upon export (e.g. 

10465) must not be renamed! If the directory name is changed PRO.FILE will not be 

able to find the corresponding data record when importing the data. 
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Exported documents from PRO.FILE are saved to a specific directory in which 

subdirectories are created according to the respective PRO.FILE ID numbers.  

If you want to reimport this data, you have to specify a higher-level directory in which 

the subdirectories can be found according to the PRO.FILE ID number that is to be 

imported.  

The directory selected for the "Import" can be different from the "Export" directory. The 

subdirectories contained in this "Import" directory, however, have to correspond to the 

exported directory names.  

PRO.FILE imports all data in the subdirectories within the selected import directory and 

allocates them according to their subdirectory number to the data record with the 

corresponding PRO.FILE ID number. 

 

 

Note: 

The import feature can only be used for documents that were previously exported from 

PRO.FILE. A corresponding data record has to already exist in PRO.FILE. Furthermore, 

this data record has to be locked since the export in order to exclude the possibility of 

conflicting changes. 

If the document that is to be imported is not in already in the database and therefore 

unknown to PRO.FILE, the import will not be possible. A new document description has 

to be created and the file has to be checked in to PRO.FILE. 

 

Please follow these instructions in order to import documents that were previously 

exported from PRO.FILE:  

1. Select the command "Import document" from the PRO.FILE "Edit" menu or from the 

context menu of the right mouse button. 

 

 

Function call:  

"File" => "Import document" 

 

2. A menu will appear in which you have to select the higher-level directory that 

contains the subdirectories with the files that are to be imported.  

Import exported 

documents back 

to PRO.FILE 
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Note: 

Please make sure to always select the higher-level directory in the structure when 

importing! This has to be the higher-level directory (e.g. "Export") that contains the 

subdirectories whose names were generated from the PRO.FILE ID numbers upon 

export and which, in turn, contain the files that are to be imported. 

An import can only be done by stating the higher-level directory in which PRO.FILE will 

then find the exported subdirectories. If you directly select a document directory (e.g. 

10465), an error message will be returned. 

 

Once the respective directory was selected, it will be executed by clicking <OK>.  

 If the subdirectories contained in the selected directory were previously exported 

from PRO.FILE, the contained documents will be imported back to the database. 

You can select the type of import from the window that appears:  

 

 If you select <Overwrite>, the imported data will be saved under the existing 

document description from which the data were exported. Existing documents 

will always be overwritten.  

 If you select <Versioning>, a version of the imported data will be stored for 

the existing document description from which the data were exported.  

 If you select <Automatically>, the status will determine whether the imported 

document will overwrite or version the existing document. If the option 

"Automatic versioning" is set for the workflow status in which the document 

master data are currently in, these document master record will be versioned 

upon this selection. If this status is not set for the current workflow status of the 

document master data, they will be overwritten.  

 The documents in these subdirectories will be allocated to the data records in 

PRO.FILE according to the number given in the name of the subdirectories and 

then imported.  

 The data records of the reimported documents in PRO.FILE will be unlocked. You 

can now work on them again and apply changes. This completes the import. 
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Attention: 

All subdirectories with a PRO.FILE ID name and their related documents that are 

contained in the selected directory will be imported back to PRO.FILE and then 

unlocked upon import! 

 

When importing data that were previously exported from PRO.FILE, all subdirectories 

with ID names in the selected directory will be taken into account and the contained 

documents will be imported.  

However, you can freely select the directory from which you want to realize the import.  

 

In addition to the export directory, you can create an 

import directory from which you can realize the 

import of data into PRO.FILE.  

This is illustrated by the following example: In this 

example, the data from PRO.FILE is exported to the 

"Export" directory. The reimport back to PRO.FILE, 

however, is realized from the "Import" directory.  

This allows you to move data and the related folder 

(in this example "406454") into the "Import" directory 

once you have completed your work on them. This 

ensures that only modified documents are reimported 

back to PRO.FILE when you select this "Import" folder. 

 

 

 

 

Attention: 

Please note that you can move the directories that were created in the export directory 

upon export but that you must not rename them. You also have to make sure that the 

right data is placed in the right directory: 

PRO.FILE will allocate the files in the subdirectory to the corresponding document 

master records, based on the document IDs that are used as folder names. 

 

Tip: re-import of 

modified 

documents only 
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7.6 Note: Document management using drag & drop 

Drag & drop in PRO.FILE allows you to create, retrieve, or link documents and parts by 

dragging an object with the mouse.  

 

 

Note: 

Drag & drop describes the Windows functionality that allows you to move files within 

the Windows user interface using the mouse and graphical visualization. In order to do 

this, the object that is to be moved is selected with the mouse pointer. By pressing and 

holding the left mouse button, the selected object can now be "dragged" to the desired 

location (e.g. the PRO.FILE menu bar). Once the mouse button is released, the object 

will be pasted to the new location in the active program. 

 

The following subchapters will give you an overview of the different drag & drop 

possibilities: 

 Save files in PRO.FILE using drag & drop 

 Check in files and directly link them 

 Retrieve files as a copy using drag & drop 

 Display documents in MS Excel or MS Word using drag & drop 

 Save entire folders 

 Drag & Drop from the documents list  

 Drag & Drop from the Parts List 

 Drag & Drop with the Bill of Material Editor  

 

7.6.1 Retrieve files as a copy using drag & drop 

PRO.FILE gives you the possibility to directly retrieve files as a copy using drag & drop. 

Simply follow these steps:  

1. Select the document that you want to retrieve as a copy in PRO.FILE and display it 

in the list view.  

2. Start the Windows Explorer and select the directory where you want to place the 

copy.  

3. Go back to the PRO.FILE user interface.  

4. Press and hold the <Ctrl> key to start the drag & drop function. At the same time, 

click the first column with the  icon in the PRO.FILE list. Now drag the selected 

lines to the desired directory without releasing the mouse button.  

5. Do not release the mouse button and the <Ctrl> key before the Windows paste 

icon appears here. The data is then pasted to the desired location. 
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Note: 

In order for this drag & drop functionality not to be executed accidentally when 

marking data records and to avoid unwanted data movement, it can only be executed 

via the first column of the PRO.FILE document list. 

The drag & drop to the Windows Explorer can only be initiated when the mouse 

pointer is placed in this first column with the  icon and the <Ctrl> button is held 

down. 

 

7.6.2 Display documents in MS Excel or MS Word using drag & drop 

Documents can be directly transferred to Microsoft Excel or Microsoft Word using drag 

& drop. This is done using a copy; the data record will not be locked in PRO.FILE!  

Simply follow these steps:  

1. Select the document that you want to retrieve in PRO.FILE and display it in the list 
view.  

2. Press and hold the <Ctrl> key to start the drag & drop function. At the same time, 

click the first column with the  icon in the PRO.FILE list. Then drag the marked 

lines to the header of the MS Excel or MS Word interface.  

3. Do not release the mouse button and the <Ctrl> key before the Windows paste 

icon appears here. The file that belongs to the documents data record will now be 

opened here.  

 

 

Note: 

In order for this drag & drop functionality not to be executed accidentally when 

marking data records and to avoid unwanted data movement, it can only be executed 

via the first column of the PRO.FILE document list. 

The drag & drop to the Windows Explorer can only be initiated when the mouse 

pointer is placed in this first column with the  icon and the <Ctrl> button is held 

down. 

 

7.6.3 Save entire folders 

PRO.FILE allows users to save entire folders in the database.  

In order to do so, move the directory from the Windows Explorer or any other file 

manager to the menu bar of the PRO.FILE user interface using drag & drop.  
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Attention: 

Directories can only be checked using drag & drop if the icon is dragged to the 

PRO.FILE menu bar. Dragging it to any other area of the PRO.FILE interface will not 

yield any results! 

 

PRO.FILE is activated and creates a data record for this directory via the CheckIn 

Wizard. Saving can be made as usual by selecting the document type and inserting the 

PRO.FILE document description.  

By checking out the directory from the database the complete directory will be created 

locally. The user has the possibility to select a file in the browser. The relevant 

application is then started.  

With termination of the application the complete directory will be saved. 

 

7.6.4 Drag & Drop from the documents list  

Using Drag & Drop from Documents List enables the documents to be linked with 

objects in the browser. Once the active document description is dragged into the 

browser, a link is established with the objects shown by the browser. 

7.6.5 Drag & Drop from the Parts List 

Using Drag & Drop from the Parts List is identical to using Drag & Drop from the 

documents list. 

7.6.6 Drag & Drop with the Bill of Material Editor  

Via Drag & Drop you can copy or move positions in the bill of materials editor: 

 Move single BOM position: 

 

 Copy single BOM position (hold CTRL key): 

 

 Move several BOM positions: 

 

 Copy several BOM positions (hold CTRL key): 
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7.6.7 Drag & Drop for the transfer of PRO.FILE data to MS Excel 

You can export selected lines of a PRO.FILE list to MS Excel via drag&drop. The selected 

data is then also displayed in a table there. 

To use this function, select the desired lines within a list in PRO.FILE. 

You can then click on the first column (which displays the  icon or is empty) of your 

selection and then drag the selection to the MS Excel GUI. As soon as your mouse 

pointer shows the Windows insertion symbol, you can drop the selection. The data is 

now inserted into Excel. 

 

7.6.8 Combined documents 

 In most companies there are firm relations between document types, which should be 

displayed in PRO.FILE. That means that documents cannot only be selected by their own 

document type, they can be selected by the characteristics of the relating document 

type, too.  

Example: A customer placed an order, and to this order exists an invoice (this invoice is 

also related to the customer). A document type "customer" is defined, and to this a 

subordinated document type "invoice". The document type "invoice" is a related 

document type of "customer".  

There are two separated data records which are related to each other.  

While creating a new data record "customer" with the command "New", a second 

combination-mask including characteristics of "customer" and "invoice" is displayed. 

One fills both, two data records with which the data record "invoice" is associated with 

the data record "Customer" automatically are created, as recognizable also in the 

browser representation.  

If one fills only the fields of the first document model, no data record of the combined 

document model is created. 

 

If, for example, you want to search for a specific invoice from a customer, the function 

"Search" => "Documents" opens a combined mask. This combined mask contains the 

features of the first (superior) document type - in this case "Customer" - in the upper 

part, and in the lower part the features of the combined document type, in this case " 

invoice".  

If you enter search criteria in the two parts of the mask, the two desired data records are 

searched and displayed. 

"New with data" with combined document types 

This command is only available if a data record of the super ordinate document model 

is represented in the acting window and is selected.  

If the command is chosen, a multi-purpose mask that is filled already with the dates of 

the acting super ordinate data record appears. The fields of the combined data type are 

not filled since a new data record of the document model is supposed to be created.  

Searching for 

combined 

document types 
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In our example the fields of "Customer" are filled already, that from "Bill" still not. Now 

new "invoice"-Data will be entered without the "customer" dates being changed, an 

"invoice"-Data record that is associated with the available "customer" data record is 

created.  

If also the "customer"-data are changed, also a new "customer" data record which is 

associated with the new "Bill"-data record is created. 

 

7.7 Optional: Save encrypted files from Boxcryptor in PRO.FILE 

PRO.FILE supports the saving of encrypted files using the software solution Boxcryptor: 

Files encrypted with Boxcryptor can be saved to PRO.FILE, opened by authorized users 

and be saved back with encryption. 

 

 

Prerequisite: Business license of Boxcryptor 

For the usage oft he Boxcryptor encryption in connection with Pro.FILE, the Business 

License of Boxcryptor is required.  

 

This chapter describes the proceeding for working with encrypted files in PRO.FILE in the 

following sub-chapters:  

 The configuration settings for Boxcryptor at your computer 

 Initial saving of encrypted files in PRO.FILE 

 Change encrypted files from PRO.FILE 

 

Limitation of the usage options of PRO.FILE functions: 

When files encrypted with Boxcryptor are saved to PRO.FILE, the following limitations 

apply: 

 Due to the complex structures and references of CAD documents, the encryption is 

not supported by the PRO.FILE CAD integraitons. 

 OLE links within Office documents cannot be supported for the storage of 

encrypted files in PRO.FILE. 

 It is not possible to create NDF files from encrypted files in PRO.FILE. 

 Zipped files (folders, redline files) are not saved with encryption. 

 

7.7.1 The configuration settings for Boxcryptor at your computer 

To be able to save encrypted files in PRO.FILE, the encryption with Boxcrypter has to be 

configured on your computer. This includes the following: 

 Boxcryptor with Business license has to be installed on your computer. 
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 The Windows user folder (%USERPROFILE%) has to contain a folder named 

"PRO.FILE". 

 This folder "PRO.FILE" is acced to the Boxcryptor configuration as storage location. 

 The folder is thus displayed as a virtual drive, e.g. P:\PRO.FILE. 

The initial saving and intermediate saving of files is then made via this folder. 

 

7.7.2 Initial saving of encrypted files in PRO.FILE 

To save an encrypted file for the first time in PRO.FILE, this file has to be encrypted by 

Boxcrypter before the saving PRO.FILE in PRO.FILE. 

Encrypted files can be saved from the Boxcryptor folder (e.g. P:\PRO.FILE) via 

drag&drop in PRO.FILE. This is described in the chapter "Save files in PRO.FILE using 

drag & drop". 

 

 

Note: 

For the encryption via Boxcryptor, the file has to be saved locally in the Boxcryptor 

folder. Since this is the only way the encryption can be made, a direct saving to 

PRO.FILE without saving to the Boxcryptor folder first is not possible. Encrypted files 

can only be saved in PRO.FILE via drag&drop. 

 

The saving of folders in PRO.FILE 

When encrypted folders are saved, the following applies: 

 When folders are saved to PRO.FILE, the folder itself is not encrypted. 

 The files in that folder have to be encrypted by the user currently logged in to 

Boxcryptor. 

 When a folder with encrypted Boxcrypter *.bc files is saved in Pro.FILE, this folder is 

displayed in the Windows Explorer when extracted from PRO.FILE. 

 

 

Note: 

The Boxcryptor option for the encryption of file names must not be used, since 

PRO.FILE can otherwise not detect the file in the virtual drive. 
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7.7.3 Change encrypted files from PRO.FILE 

 

 

Note: 

The changing of encrypted files from PRO.FILE and the encrypted saving back to 

PRO.FILE requires Boxcrypter to be installed on the user computer and the storage 

folder for PRO.FILE being configured in Boxcryptor (see chapter "The configuration 

settings for Boxcryptor at your computer"). 

 

If an encrypted file is saved in PRO.FILE it can be edited and saved back with the 

normal PRO.FILE functions. The file thus remains saved and encrypted in PRO.FILE. 

 The encryption is made automatically by Boxcryptor during the saving back of the 

changed file to PRO.FILE. 

 A saving via drag&drop as during the initial saving oft he file to PRO.FILE is not 

required. 

During the saving process of the changed file in PRO.FILE, the encryption with 

Boxcryptor is made in the background. Depending on the file size, the saving process 

may take a little longer. 

 

ATTENTION: Versions of encrypted files 

When new files are to be saved for the first time with encryption to PRO.FILEm these 

have to be encrypted by Boxcryptor before. Therefore, the following has to be noted for 

the handling of versions: 

 When a version of an encrypted file is created in PRO.FILE via the "Create cersion" 

function of the PRO.FILE Windows Client, the new version of the file is encrypted as 

well. 

 When an encrypte file is opened from Pro.FILE and then a new version is created 

via a PRO.FILE Office integration, the new version of the file is NOT yet encrypted.  

 

Working with encrypted files and the Office integration 

The encryption of files for the saving in PRO.FILE is made by Boxcryptor. New files 

always have to be encrypted by Boxcryptor first before they are saved to PRO.FILE. 

As a consequence, new files that are created from already encrypted files via the 

functions "New from template" and "Version" of the PRO.FILE integrations but not yet 

encrypted by Boxcryptor are saved without encryption when saved directly to PRO.FILE.  
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This has the following reason: 

When document versions are created via the PRO.FILE Office integrations, the new 

version is saved by Office as new file on the computer. If this new file is then directly 

saved in PRO.FILE via the Office integrations, the file has then not yet been encrypted by 

Boxcryptor. The new version of the file is thus saved to PRO.FILE without encryption. 

Therefore, when document versions are created via the PRO.FILE integrations, you also 

have to go via the Boxcrypter folder – this also applies to documents created with the 

function "New from template". 

 Encrypt the new file created via "Version" or "New from template" locally with 

Boxcryptor. 

 Save this file via drag&drop from the Boxcrypterfolder (e.g. P:\Boxcryptor) in 

PRO.FILE as described in the chapter "Initial saving of encrypted files in PRO.FILE". 

 

7.8 What happens if I exit PRO.FILE while documents are still checked 

out? 

If documents are checked out for editing, a lock flag is set for the corresponding 

documents. 

If PRO.FILE is then closed without the opened documents having been saved back, 

PRO.FILE needs to know what is to happen to the open documents. 

For this reason, a message 

"The object is checked out 

and changes are not yet 

stored in PRO.FILE" informs 

the user of this. 

The lower part of the 

window offers you several 

options of proceeding: 

 

 Edit  

PRO.FILE switches to the application the document is edited with. PRO.FILE is not 

closed. 

 Discard  

The document is unlocked in PRO.FILE. Changes made since the last saving are 

discarded. If additional documents are still opened from PRO.FILE, they are also 

displayed in this window. If no further documents are opened, PRO.FILE is closed. 

 

Attention: loss of data 

If a document is unlocked with this function and the changes are discarded, only the 

status that was last saved to PRO.FILE remains. Recent changes that were not saved 

back to PRO.FILE are lost! 
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 Discard all 
If several documents are opened from PRO.FILE, they can all be unlocked at once, 

and the changes to any of the documents are discarded. The documents are not 

displayed individually. PRO.FILE is closed. 

 

 

Attention: loss of data 

If a document is unlocked with this function and the changes are discarded, only the 

status that was last saved to PRO.FILE remains. Recent changes that were not saved 

back to PRO.FILE are lost! Especially, when you have several documents opened, you 

should use this function with care! 

 

 Cancel  

The closing process is aborted. The PRO.FILE session remains open. 
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8 Working with parts in PRO.FILE 

When parts have been searched in PRO.FILE, the results are displayed in form or list 

display. 

If a part description is selected, the "Edit" menu and the context menu contain various 

functions specifically for the working with parts: 

 

 New: Creates a new part description. See chapter 

"Create new part". 

 Modify: Opens an existing part description in editing 

mode. The description can be changed and saved, 

provided that the user has the required permissions. 

See chapter "Modify part". 

 Duplicate: Functions for the creation of duplicates of a 

part description with different options for the handling 

of related objects. See chapter "Duplication of parts". 

 New version/revision: Function for the versioning of 

bills o materials – if the BOM versioning is used. 

 Delete: Deletes a part description from PRO.FILE, 

provided that the user has the required permissions. 

See chapter "Delete part". 

 Copy: Puts the part description into the PRO.FILE 

clipboard. The part can then be attached to another 

PRO.FILE object or, via the bill of materials editor, to a 

bill of materials. See chapter "Copy part master data". 

 Copy search criterion: Copies the search criteria, via which the part was found, to 

the PRO.FILE clipboard. 

 Copy node data: Function for the copying of entire bill of material nodes. See 

chapter "Copy node data". 

 Create link: Uses the object from the PRO.FILE clipboard to link it to the selected 

part. 

 BOM editor: Creation, administration and editing of bills of materials and BOM 

positions. See chapter "Parts: working with the Bill of Materials". 

 Lock/Unlock: Functions for locking or unlocking a part descriptions in order to 

prevent a part from being edited by other users. 

 Status change / Notify / Seen and approved/rejected: Functions for the status 

administration of part descriptions. The usage for part descriptions corresponds to 

the usage of these functions for document descriptions. See chapter "PRO.FILE 

status management: Support and Control your Workflow". 

 Keep in memory for Pocket: Function for the optional tool "PRO.FILE Pocket". See 

operation manual for PRO.FILE Pocket. 
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8.1 Create new part 

This command creates a new part in the database i.e. the part is described by the 

master data. 

 

 

Function call:  

"Start" => "New part" or "Edit" => "New part" 

 

 

Filling in the data entry is made faster and easier by using the selection functions. If 

these are available, this is indicated by the selection button at the end of a field.  

If a key characteristics list was created for a product group it will appear in the left 

column of the mask or in the corresponding items class field following the respective 

selection.  

This is where you can enter product group-specific characteristics.  

Once all entries were completed the part window will appear in which all entries are 

displayed.  

If an items class list was selected the key characteristics list that belongs to the part will 

also be displayed. 
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8.2 Modify part 

Parts which are locked by another user cannot be modified. Certain parts automatically 

assigned by the system, such as the database number, the part number, the designer 

and the creation date cannot be modified either. 

 

 

Function call:  

"Edit" => "Modify" 

 

If the selected part is used in an assembly, the parts usage window appears, as well as a 

message which has to be confirmed. 

 

 

The data entry form will be filled in according to the new entries when the part is 

modified.  

If there is a specifications table for a specific product group, it will be displayed in order 

to be modified.  

If modifications are made to the first level of the item class, all other characteristics of 

the item class are deleted. 

<OK> is used to confirm the entry and, if necessary, open the specifications table to 

gather information specific to the product.  
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The next 

confirmation opens 

the modification log 

mask, in which notes 

for the modification 

log are entered 

 

An entry is not necessarily compulsory (depending on the configuration), but is 

recommended. A thorough documentation of all changes provides a comprehensible 

"history" of the development of the product. 

 

8.3 Delete part  

This command deletes a part from the database. 

 

 

Function call:  

"Edit" => "Delete" 

 

If CAD data was saved for a part, it is impossible to delete the part within PRO.FILE. All 

CAD data belonging to a particular part must be deleted in the originating CAD system 

before the part can be removed.  

If PRO.FILE is called from the CAD system, a part with CAD data can be deleted if the 

CAD data is originated in the same CAD system.  

Before the deletion is carried out, a query must be confirmed as a precaution. 

 

If a part is built into one or more assemblies, a message window appears as well as a 

parts usage list with all assemblies where the part is currently used.  

Here you can check on whether deletion is permitted and what objects will be effected. 

(see Modify)  

If one or more assemblies are deleted, the individual single parts built into them will not 
be removed from the database. 
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8.4 Duplication of parts  

PRO.FILE offers several possibilities for the duplication of parts, such as with the bound 

documents of the duplicated parts and also the bills of materials that are to be taken on 

by the new duplicated part.  

The various functions that are available can be activated from the "Edit"-menu using the 

menu point "Duplicate" then the function required from the list that appears, when the 

part form or the part list is active. 

 

 

Function call:  

"Edit" => "Duplicate" 

 

For the various functions in this menu please see the following chapters: 

 

 

 Duplicate part only 

 Duplicate part with documents 

 Duplicate part with referencing 

of the existing documents 

 Reference part with bill of 

materials 

 Duplicate part with bill of 

materials and documents 

 

Duplicate part only 

 

Function call:  

"Edit" => "Duplicate" => "Part" 

 

If when duplicating a part, only the part is to be duplicated, and not the attached 

documents, it can be done in the following way:  

 The function "Duplicate" => "part" is called up.  

The part is now duplicated. In this way, neither the attached documents nor the bill of 

materials will be taken on.  
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Duplicate part with documents 

Parts can be duplicated so that the part description is changed as well. This is very 

useful when creating similar parts that are only very slightly different. 

 

 

Function call:  

"Edit" => "Duplicate" => "Part, Documents" 

 

The part that is to be duplicated should be highlighted, or activated in the display. After 

selecting the function "Edit" => "Duplicate" => "Part, Documents", the entry window will 

appear in which the desired changes can be entered.  

If the product group is attached to a characteristic bar, this will also be offered to be 

changed.  

The entered changed data is then confirmed with Next.  

Several system messages (information) will then be given, to assist the copying process.  

With the function "Duplicate part with documents"; the document that is attached to the 

part will be copied as well. The following points should be noted:  

As a rule, PRO.FILE will try to duplicate all attached documents. Depending on the 

saving mechanism of your CAD-system, it is not always possibke to duplicate all 

attached documents. However, these documents can be copied when PRO.FILE is 

accessed from within the CAD-system. 

 

 

Note: 

When duplicating parts only the attached documents that the user has the authority to 

see will be copied. 

 

Duplicate part with referencing of the existing documents  

 

 

Function call:  

"Edit" => "Duplicate" => "Part, Documents (referencing)" 

 

If when duplicating a part, the attached documents are not also to be copied but 

referenced instead, the process is done in the following way:  

 The function "Part, Documents (referencing)" is called up.  

 The duplicate part is created.  
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 The documents are then attached.  

The part is now duplicated. The attached documents are not copied; the new part refers 

to the existing documents.  

 

Reference part with bill of materials  

 

 

Function call:  

"Edit" => "Duplicate" => "Part, BOM (referencing)" 

 

The duplication of the part master record with the bill of materials is carried out here, 

although it is done without the attached documents being duplicated. The assigned bill 

of materials is then referenced, and placed together with the copied assembly part 

master record, without the affected parts being copied.  

The documents attached to the part are not copied. 

Duplicate part with bill of materials and documents  

 

 

Function call:  

"Edit" => "Duplicate" => "Part, Documents, BOM (referencing)" 

 

The duplication of the assembly part master record is carried out here. The assigned 

bills of materials are referenced, placed together with the copied assembly part master 

record, without the affected parts to be copied.  

The documents attached to the part are copied too. 

 

 

Note: 

When duplicating parts, only the attached documents that the user has the authority to 

view will be taken on. 
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8.5 Copy part master data  

 

Function call:  

"Edit" => "Copy" 

 

"Copy" sends data to the PRO.FILE clipboard (similar to that in MS Windows). However, 

you are not able to paste information from the PRO.FILE clipboard into other Windows 

Applications.  

This function is particularly useful for editing BOMs but also when linking data records, 

etc. 

 

8.6 Copy node data 

 

Function call:  

"Edit" => "Copy node data" 

 

With this function bill of materials can be copied. With the function "Copy node data" 

Bill of materials are memorized. With the function "Create link" it will examine whether 

the part has already a BOM:  

 If it has a BOM, nothing is copied.  

 If the part does not have any BOM, the copied nodes with all values are attached 

to the new part. 

 

8.7 Parts: working with the Bill of Materials 

An assembly can consist of parts of the same or of a different product type or of several 

subassemblies. 

Bill of materials which can be divided up into overviews and parts’ usage verification, 

are created to manage the hierarchical structure. (See menu View).  

The data which determine the position of the part in the hierarchy are managed 

separately from the assembly part and are allocated to it. 

 

Function call:  

"Edit" => "BOM Editor" 
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Bill of Materials creation process 

These functions can also be performed 

using the Drag & Drop function under 

Microsoft Windows (Cf. Drag & Drop 

section under Microsoft Windows).  

The function Copy copies a selected object 

to the PRO.FILE clipboard. 

 

These functions can also be performed using the Drag & Drop function under Microsoft 

Windows (Cf. Drag & Drop section under Microsoft Windows).  

The function Copy copies a selected object to the PRO.FILE clipboard. 

 

8.7.1 Add positions to the bill of materials 

To add positions to the bill of materials: 

 select the part in PRO.FILE that is to be the mother part of the BOM, and 

 select the function "Editor bill of materials" from the "Edit" menu. 

In the BOM editor, different functions are available to add new positions to the BOM. 

The functions differ in the 

method of selecting the parts to 

be included in the BOM: 

 The functions "Insert" and 

"Attach" add parts that have 

been memorized by the 

PRO.FILE clipboard. 

 The functions "Fast Insert" 

and "Fast Attach" offer a 

search form to select the 

desired parts from a list to 

include them in the BOM. 

 

 



Operation PRO.FILE advanced Parts: working with the Bill of Materials 

PRO.FILE Release 8.7 
June 2017 Page 191 of 241 

To handle a part memorized in the PRO.FILE clipboards you can use: 

 Insert:  
The part is inserted into the BOM at the same hierarchical level as the selected 

BOM position.  

or  

 Append:  
the part is appended to the active part one level below the selected BOM position.  

The functions "Fast Insert" and "Fast Attach" are used to quickly add several parts to the 

BOM. If one of these functions is selected, a search form is opened. The results of the 

search are presented in a list, from which you can select the desired parts to be added. 

The difference of the two functions is again the level, on which the new parts are added. 

 

 

Note: 

If an assembly from the PRO.FILE clipboard is to be added to a BOM that already 

exists on a higher level, an error message is displayed, since this would mean that the 

part is used in itself. 
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The procedure for the functions "Fast Insert" and "Fast Attach" is as follows: 

 Select the position in the BOM, where you want to insert or attach a new part. 

 Select the function "Fast Insert" or "Fast Attach" from the context menu. 

1. A search form for parts is 

displayed: 

Enter the desired search 

criteria and start the search. 

 

2. From the list of search results 

select the parts that you want to 

add to the BOM. You can use the 

<CTRL> or <SHIFT> key to 

select several records.  

Confirm your selection with 

<OK>. 

 

3. All selected parts are now inserted (or attached) 

in the BOM. For each selected part, the entry 

form for the BOM positions is displayed. The 

title bar of the entry form displays the part 

currently handled.  

Confirm your entries with <OK>. 

 

The search for parts, as described in step 1, is then restarted to add further parts 

according to your search criteria. As long as you want to add further parts, you can go 

through the cycle over and over again. 

If you do not want to add further parts, click on <Cancel> in step 1. The function "Fast 
Insert" or "Fast Attach" is then closed. 
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8.7.2 Indenting, outdenting, moving up and down 

This function moves a selected part within the hierarchical structure. 

 

 

Function call: 

Tab "Edit" => Group "Change position" "Move right", 

Tab "Edit" => Group "Change position" "Move left", 

Tab "Edit" => Group "Change position" "Move up", 

Tab "Edit" => Group "Change position" "Move down", 

 

 

Before the function is carried out the list of modifications is displayed. If a part whose 

root element comprises of further assemblies is to be indented or outdented, all parts 

"under" it will also be indented or reverse-indented. The position number indicates what 

belongs to which root elements. 

 

Position number: 

The individual positions within the hierarchy levels are separated by a dot and generally 

listed by tens, although this is adjustable.  

If a part is already in the first or last hierarchy level, it cannot be indented or outdented, 

and an error message will be displayed. 
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8.7.3 Numbering 

This command can only be used with a building block BOM; the switch to the building 

block BOM occurs automatically. 

 

Function call:  

Tab "Edit" => Group "Change position" => "Renumber" 

 

 

The starting point and the size of increment in the numbering must be entered. 

 

8.7.4 Changing information on the position 

This command modifies the BOM data. This function can also raise or lower the 

necessary number of parts. 

 

Function call:  

Tab "Edit" => Group "Change position" => "Change position" 
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If this function is used for 

several selected positions, 

the position numbers and 

the variant numbers 

cannot be changed.  

If the entries are 

confirmed, another form 

appears into which the 

remarks for the list of 

modifications can be 

added.  

The default values for the 

position entries are set via 

the PRO.FILE 

Management Console. 

 

8.7.5 Delete Position 

Remove a BOM item from the current assembly. 

 

Function call:  

Tab "Edit" => Group "Change position" => "Delete position" 

 

If the selected part has been built into other parts or assemblies all the places where it 

has been added will be listed (the parts usage) after the delete command is initiated.  

If a part with any appended parts has been added to any assemblies which have been 

locked by another user, a message will be displayed that the part is locked.  

Finally, it is possible to add entries to the list of modifications.  
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8.8 Link parts 

PRO.FILE generally recognizes four different groups of data (entities or object groups): 

 Parts 

 Documents 

 Projects 

 Transmittals 

Parts and documents can both exist independently of other object groups;  

There is often a connection between a document and a part (e.g. test specifications, 

setting sheets etc. are necessary for the completion of a part). At this point an allocation 

can be made via the function Link 

 

Function call:  

Tab "Edit" => Group "Create link" => "Create link" 

 

Linking process: 

 

These functions can also be executed using the Drag & Drop function in Microsoft 

Windows.  

Several memorized objects can also be linked to several selected objects in a list. 
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9 Locking and unlocking of PRO.FILE objects 

If you want to edit a document or any other PRO.FILE object and want to save the 

changes back to PRO.FILE, this object has to be locked from other users from the 

moment the changes begin. 

 When a data record is being edited, it is automatically locked by PRO.FILE 

 Only by using the function "Lock" you can make sure, that other users are not 

making changes to the same document at the same time.  

 With the function "Unlock" the document is made available again to other users for 

editing. 

For detailed information see the following sub-chapters: 

 Locking and unlocking of part descriptions 

 "Lock" the document  

 The "Unlocking" of documents  

 

The locking of a document makes sure that the document is not modified by other users 

in the meantime: 

 A locked document can be opened by other users via the function "Display". 

However, these other users cannot save back any changes to the locked document 

to PRO.FILE. 

 If the document has been opened and not locked, other users may make changes 

to the document in the meantime and save those changes back to PRO.FILE. In this 

case, it will no longer be possible for you to save your own changes back to 

PRO.FILE.  

 

 

Note:  

A document is locked automatically, if it is opened for editing. A manual locking is not 

required in this case. 
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9.1 Locking and unlocking of part descriptions 

For the work in a team it may be necessary to lock a part description, so that it cannot 

be edited by other users temporarily. This lock can be removed at any time, provided 

that the user has the required permissions. 

 

Function call: 

"Edit" => "Lock/Unlock" 

 

Locked parts cannot be deleted, changed or moved to a different status. Before the part 

is actually locked or unlocked, a dialog is displayed. 

 

 

Note:  

If the function "Lock/Unlock" is applied to several selected part descriptions, the 

change of the lock status (lock unlocked parts or unlock locked parts) is checked for 

the first selected part descriptions. All other parts having a different lock status than this 

first part remain untouched. 

 

An automatic (temporary) lock is made if the data record is being edited. If the system is 

closed unexpectedly, the lock flag remains. It can then be later removed via the function 

"Lock/unlock". 
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9.2 "Lock" the document  

If a document is locked, it cannot be edited by another user! 

 

Function call: 

"Edit" => "Lock/Unlock" 

 

1. Mark the object to be locked in PRO.FILE. 

2. Select the menu "Edit" from the menu bar. 

3. Select the function "Lock/Unlock". 

 With the display of status information in this list PRO.FILE checks: 

 whether the user has the permission to edit the document. 

 whether the active documents are up to date and have not been modified by a 

different user since their opening. 

 whether the active document does not already have a lock flag.  

 If any of these checks returns a negative result, the document cannot be locked! 

4. Confirm with <Yes>. 

 

 By the command "Lock", the access permission to edit the document is checked for 

the current user, and the document is locked for all other users in the database. 

Once the CAD document is locked, it can be modified. The changes are then saved 

back to PRO.FILE via the function "Save". 

 

To lock a 

document 

manually Proceed 

as follows 
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9.3 The "Unlocking" of documents  

In analogy to the function "Lock" you can unlock documents that have been locked by 

you by using the function "Unlock". 

 

Note: 

You can only unlock documents that have been locked by you. The right to unlock 

documents that have been locked by other users can only be given to administrators. 

 

 

Function call 

"Edit" => "Lock/Unlock"  

 

1. Select the document to be unlocked in PRO.FILE. 

2. Select the menu "PRO.FILE" from the menu bar. 

3. Select the function "Lock/Unlock"  

4. Confirm your selections with <OK>. 

 

 The lock flag for the selected CAD document is now removed. 

 

9.4 More information: the dependent tab "Status information" 

When working in a list or form, it is very helpful to be able to identify locked parts in a 

system message in the status bar of the PRO.FILE window. 

The dependent tab "Status" provides users with further information on the current data 

record. This includes workflow status, project designation, information on who locked 

the data record and when, and information on who retrieved an attached document 

and when 

An automatic lock (temporary) occurs when a record is being edited. If the system is 

uncontrollably left, the lock details remain. It can be released again, with the use of the 

function Lock/Unlock.  

If the function is used on several marked records, the condition changes are made 

according to the first record. The record that does not have the same lock condition 

remains unchanged. 

 

To unlock a 

document Proceed 

as follows 
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10 Copy and link PRO.FILE Objects 

As already explained in the previous chapters, links can be established between different 

types of data objects.  

 

Link process 

Linking a document description to a part 

description: 

Linking a part description to a document 

description: 

 

 

 

 

 

Such links can also be created via drag&drop (see chapter "Note: Document 

management using drag & drop"). 

It is also possible to link several copied objects to several selected objects in a list. 

 

  



Operation PRO.FILE advanced Linking of PRO.FILE objects 

PRO.FILE Release 8.7 
June 2017 Page 202 of 241 

10.1 Linking of PRO.FILE objects 

To create links between PRO.FILE objects, proceed in two steps: 

 Copy the object reference to the PRO.FILE clipboard 

 Creating a link between PRO.FILE objects 

For details see the following chapters. 

 

10.1.1 Copy the object reference to the PRO.FILE clipboard 

 

 

Function call 

"Edit" => "Copy"  

 

The function "Copy" puts the selected object into the PRO.FILE clipboard (similar to the 

Windows clipboard, but the information cannot be used in other systems). 

 

10.1.2 Creating a link between PRO.FILE objects 

To link PRO.FILE objects (that have been copied to the PRO.FILE clipborad) to another 

PRO.FILE object, the function "Create link" is used. 

 

Function call 

"Edit" => "Create link"  

 

The copied object(s) is/are then linked to the selected object and are displayed in the 

structure. 

 

10.2 Versions and link types: static and dynamic links 

The versioning of documents and parts affects the links between the PRO.FILE objects. 

If a link refers to a versioned object, the question is: 

 Should the link be static to a specific version of the document/part, or 

 Should the link always be updated and point to the new version of the 

document/part? 
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In order to meet the different requirements, the link type between two PRO.FILE objects 

can be changed from "static" to "dynamic" and vice versa. 

 

The difference between static and dynamic links 

 Dynamic link: The document that is versioned is updated in the structure. 

 Static link: Only the current version (not future versions) are linked in the structure 

Which object types in PRO.FILE allow static and dynamic links? 

Static AND dynamic links are possible for the following object type combinations: 

 Projects and documents 

 Projects and parts 

 Documents and documents 

 Parts and documents 

 

How to recognize the current link type 

The link type is indicated by different icons for the linked objects. Static links are always 

indicated by a "lock": 

 

Static link: The link refers to a specific version of the documents (or part). 

 

Dynamic link: The link refers to the newest visible version of the document (or 

part). 

 

10.2.1 Document-Document links 

In the document structure, there are two basic types of links: 

 Manually created links ("Copy" -> "Create link") 

 Links established by a CAD integration 

The first links are, by default, dynamic. This means, when a version of a document is 

created, the link to this document is automatically switched from the old version to the 

new version. The user can change such a link from dynamic to static. In this case, the 

switching of the link is not made automatically. 

CAD links are not automatically switched, when a new document version is created. 

These links have to be updated within a CAD integration. These links are static. 

10.2.2 Links between transmittals and documents 

Links between transmittals and documents are always static. 
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A transmittal is assigneed a specific version of a document: the version the transmittal is 

sent with. When a new version of the document is created, the link of the previous 

version to the transmittal remains unaffected thereof. 

10.2.3 How to change the link type 

In the tabs "Browser" and "Where used" the function "Change link type (dynamic <-> 

static)" can be called from the "Edit" menu. 

To change the link type Proceed as follows 

 Select the 

linked object 

in the 

structure, for 

which you 

want to 

change the 

link type. 

 

 Select the command "Change link type" => "Dynamic – Static"either from the 

"Edit" menu or the context menu. 

 Confirm the change of the link type with <Yes>. 

 The linked 

object is now 

displayed with 

the changed 

link symbol in 

the browser. 

 

 

The link type has thus been changed 
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11 PRO.FILE status management: Support and Control 

your Workflow 

PRO.FILE enables a company to control and supervise workflow according to what is 

necessary, such as the process of product development or the process of release.  

In this way, the organisation of work processes can be shown in PRO.FILE through the 

description and setting of separate statuses that each describe a process. A part or 

document can be moved from within the set status into a specified order, parallel, or 

sequential, and transported from one status to another.  

With the status management of PRO.FILE it can be made sure that a part or document 

that is set for viewing, noting, or editing, reaches the colleague that it is intended for 

and only the colleague that it is intended for, and that it contains all the necessary 

information.  

The following picture shows a typical life-cycle of a part from design to manufacturing to 

archival of the part and its related documents. 

 

The PRO.FILE status management contains the following points:  

 Modeling of the processing ways of parts, documents and projects  

 Release procedure  

 Integration of e-mail  

 User and access rights  

By using user and access authorities, you can be sure that only certain users and user 

groups have the right to carry out the status change, while others have the rights to 

view, examine, edit etc. documents and parts for all statuses. 
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11.1 Transfer of a document, part or project into another status 

This feature allows you to transfer a part, document or project from one status to 

another status. 

 

 

Function call: 

"Edit" => "Change status" 

 

After calling this function, a selection menu will appear where you can select the desired 

target status. 

 

  

 

Note: 

Should several objects that have different statuses, need to be moved using the Status 

change top-down, then the status change will only be carried out for those objects for 

which this status change is allowed. 

 

11.1.1 Status change depending on several users 

A status change can be configured to depend on several users or group branching. All 

the users who are authorized to make this change of status have to confirm the change 

(sign-off) before it can be carried out. 
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An additional dialog box will be displayed after the next status is selected. The right side 

of the dialog box lists all users who have to agree to the change in status. The left side 

lists the users who have already agreed (signed-off). Users who have not yet agreed are 

able to determine whether the change of status takes place.  

Reset can annul the agreement of the users. Cancel terminates the sign-off process.  

If a user has agreed to a status change with multiple sign-off approval, then no other 

status can follow. The selection dialog box for the next subsequent status will not be 

displayed. 
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11.2 The functions "Seen and approved" or "Seen and rejected" 

The functions Seen and Accepted or Seen and Rejected cause an entry to be made in 

the status log which expresses either acceptability or rejection of a processing step.  

This function documents the process of authorization and the checking procedure 

without determination of a status definition in advance. 

 

 

11.3 Problems with status changes 

An error message will appear if a change in status is not possible.  

The error message includes, for example, an ID number as well as the designation and 

the PRO.FILE ID of the part. 

 

There are several possible causes for this. In particular, the workflow definition in the 

administration functions and the way the user rights are regulated should be checked as 

well as the possible existence of a lock message.  

The current status is shown in the dependent tab "Status information" like the Lock 

function.  

If one or more errors occur during this action, they will be shown in an error window. 

The error window is made up of two columns, error message, and brief information 

relating to the affected object.  

The actions "Edit, Copy" and "View, List" are usable for the data in the window. 
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11.4 Status change top-down 

If an assembly or other structure consisting of linked parts, documents or projects is to 

be transferred into another status, it can be quite tedious to select each object 

individually. 

For this purpose, the function "Status change top-down" is available. All objects linked to 

the mother object are then transferred into the same target status. 

 

Function call:  

"Edit" => "Status change top-down" 

 

In the following table you can decide which linked objects should be transferred into the 

next subsequent status. 

 

The selection for parts is on the left hand side, the selection for documents is on the 

right. The following settings are available:  

 None:  
No parts or documents are included in the workflow.  

 First level:   
Only those parts or documents of the first, subordinate level are included.  

 All:  
All parts or documents in the structure are included in the workflow. 

 

 

Note: 

Should several objects that have different statuses, need to be moved using the Status 

change top-down, then the status change will only be carried out for those objects for 

which this status change is allowed. 

 

The user selection regarding the depth of documents and parts for "Status change top-

down" is saved in the database when PRO.FILE is closed. After a new start of PRO.FILE 

the saved setting is displayed again when the function "Status change top-down" is used. 
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Attention: Status change Top-Down without transmittals 

Transmittals are not part of the status handling. When a status change top-down is 

applied to a project, the linked transmittals are ignored. 

 

11.5 Real-time simulation of the function "Status change top-down" 

The function "Check status change top-down" gives users the possibility to simulate a 

change of status before performing the actual status change.  

This allows them to verify whether the desired change of status can actually be carried 

out as planned. 

 

 

Function call: "Edit"  

=> "Check status change top-down" 

 

Often related documents are in different workflow statuses, under circumstances also in 

statuses with lock entry or the user has no access rights. Then the "Status change top-

down" cannot be performed correctly.  

In the following table you can decide which linked objects should be transferred into the 

next subsequent status. 

 

After the selection is confirmed, PRO.FILE simulates the status change and displays a list 

of problems that would occur if the status change were performed for real. 

 

Problems during the planned workflow can be checked and eliminated. 
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11.5.1 Problems during Status change top-down 

With the pure simulation, a disturbance of the data structure can be excluded for the 

actual status change. 

 

Note: 

The function "Check status change top down" is a pure simulation. No actual status 

change is performed. 

 

11.6 Notify 

Messages can be sent to the user with the help of a report generator and a mail 

interface. The user who has been informed is documented in the status log.  

Further information on the operation of the mail interface can be found in the manual 

of the PRO.FILE Mail Connector for Lotus Notes or Microsoft Outlook. 

The function "Notify" is available for documents, parts and projects. 
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12 Transmittal: digital dispatch list with PRO.FILE 

The functions for using "transmittals" in PRO.FILE are described in the following 

chapters: 

 What is a transmittal 

 Working with "Transmittals" 

 Further Functions for transmittals 

 Link between transmittals, documents and projects 

 Delete a transmittal 

 Functions to lock/unlock a transmittal 

 How to send a transmittal 

 

12.1 What is a transmittal? 

With PRO.FILE the user can access an object type called "Transmittal". Transmittals are 

distribution lists containing documents that are stored in PRO.FILE. Transmittals are used 

to record the distribution of documents with customers, external service providers and 

suppliers.  

Large projects use transmittal to record drawing and document numbers along with their 

version and revision states, documenting the project’s progress and responsibilities. 

Transmittals record the actual document versions at the time of distribution.  

PRO.FILE manages transmittals as independent objects that allow assignment of CAD 

file and document versions.  

You can display the structure of any transmittal using the browser. You can modify the 

structure as long as the transmittal has not been sent.  
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The transmittal object features a distribution date, twenty string and five numeric 

database fields. These can be configured by the administrator in the PRO.FILE 

Management Console. 

12.1.1 Informal or referencing: What types of transmittal do exist? 

If documents are linked to a transmittal, the editing state of the documents at the time of 

transmittal sending is documented. 

The question now is, whether the linked documents can be changed after the sending – 

or whether changes can only be made to a new version/revision of the documents. 

There are two types of transmittals serving both of the above options. You can decide at 

different locations, which type of transmittal you want to use: 

 

 Referential transmittal  

In case of a referential transmittal, all documents of the document structure are 

linked to the transmittal after sending. These linked documents can only be 

modified by creating a new version or revision. The sent state of the files is thus 

fixed in PRO.FILE and cannot be changed.  

 

 

Note: Referential transmittal  

In order to change a document sent with a referential transmittal, a new version or 

revision of the document has to be created. 

 



Operation PRO.FILE advanced Working with "Transmittals" 

PRO.FILE Release 8.7 
June 2017 Page 214 of 241 

 Informal transmittal  

In case of an informal transmittal, the files of the sent documents are packed in a 

zip file. This zip file is saved in PRO.FILE. A document description is automatically 

created in PRO.FILE and linked to the transmittal. This document description cannot 

be modified. The original documents themselves are also linked to the transmittal – 

however, they can be changed after sending. The sent state of the files remains 

fixed in the zip file. 

 

12.2 Working with "Transmittals" 

Before you can attach documents or CAD files to a transmittal, you must create a 

transmittal description first.  

A form is displayed for entering transmittal meta data. After completion, the entire 

record will be displayed in the current window.  

Transmittals may be modified as long as they have not been sent. Once sent, you will 

no longer be able to modify the transmittal. 

 Step 1: Creating a transmittal 

 Step 2: Link documents to be transferred to the transmittal 

 Step 3: Lock transmittal and send it 

 

12.2.1 Step 1: Creating a transmittal 

Data is transferred from PRO.FILE to the recipient via transmittals. This means that a 

transmittal has to be created in the first step for the transfer. 

If you already have a transmittal that you want to use for the transfer, you can skip this 

first step and continue with "Step 2: Link documents to be transfered to the transmittal". 

 

 

Function call: Create a transmittal 

"Start" => "New transmittal" 

 

Proceed as 

follows 
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Proceed as follows 

1. Create a new 

transmittal, either via 

the function  

"Cockpit" => Icon 

"Create Transmittal" 
or via  

Menu: "Start" => 

"New objects" => 

"New transmittal". 

2. Enter the required 

information for the 

description of the new 

transmittal. 

3. Confirm with 

<Finish>. 

 The transmittal has 

been created. 

 

 

 

Note: Automatic linking in case of activated project 

If a project is activated (visible in the PRO.FILE title bar) while the transmittal is created, 

the new transmittal is automatically linked to this activated project. 

 

12.2.2 Step 2: Link documents to be transferred to the transmittal 

The document is transferred to the recipient via a transmittal. The document therefore 

has to be linked to the created transmittal. Proceed as follows  

1. Start a search for the document to be transferred via "Selection" => "Documents". 

2. If the document 

is displayed in 

list view, please 

select it.  

(If it is displayed 

in form view, it 

is already 

selected). 
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Note: Transfer of several documents – select several documents 

Of course you can transfer several files simultaneously from PRO.FILE to PROOM. To 

do so, select all the documents you want to transfer. The files from all selected 

document descriptions are then copied to PROOM. 

 

Select the transmittal for transfer: 

3. Open the context menu for the 

selected document (right mouse 

button) and select the function 

"Transmittal". 

All transmittals to which documents 

can be linked are now listed in the 

sub-menu. 

 

 

 

Note: Only non-locked transmittals can be selected 

For the linking, you can only select transmittals that have not yet been sent or locked 

for sending.  

 

4. Confirm the security question, 

whether the document is to be 

linked to the transmittal with 

<Yes>. 

 

5. The document is 

now linked to the 

transmittal. The 

link is visible in 

the structure view 

of the transmittal 

and in the 

"Where used" list 

of the document. 

 

6. If you want to add more documents, repeat this process. 

 

12.2.3 Step 3: Lock transmittal and send it 

You can now start the transfer of the selected files.  

1. Select the transmittal to be transferred. 
Proceed as 

follows 
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2. Select the function 

"Lock before sending" 

from the "Edit" or 

context menu. 

3. The transmittal is now 

locked and ready for 

sending. 

 

4. Select the function "Send" => "E-Mail" from the "Edit" or context menu. 

 A dialog for entering the recipient and 

the message text is displayed 

 

5. Enter the internal recipient (=name of the PRO.FILE user) or the external recipient (e-Mail 

address). 

6. Add a message text. 

7. Click <OK> to send the transmittal. 
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12.3 Further Functions for transmittals 

Prior to sending a transmittal, commands for creating, editing and modifying are offered 

by PRO.FILE.  

You can select a transmittal by using the "Transmittal" command from the "Search" 

menu. PRO.FILE will then display a form that allows for entering search criteria.  

When a transmittal form is activated, a special menu for the handling of transmittals is 

available. 

 Create: 
Create a new 

transmittal as described 

in the previous chapter 

"Step 1: Creating a 

transmittal". 

 Modify: 
Change the transmittal 

description. Changing is 

only possible as long as 

the transmittal has not 

been sent or locked for 

sending.  

 Duplicate: 
Using the "Duplicate" command, you can copy a transmittal including its structure. 

PRO.FILE will offer you the opportunity of modifying the transmittal description 

before the duplication process is complete. 

 Duplicate: The transmittal is duplicated with the recently linked versions of the 

attached documents. 

 Duplicate with newest versions: The PRO.FILE transmittal is duplicated with 

the newest versions of the attached documents that are visible for the user. 

Please note that there may be newer versions that the user is not allowed to 

see. 

 Duplicate with newest, released versions:  

The PRO.FILE transmittal is duplicated with the newest versions of attached 

documents that are in a released status and are visible for the user.  

This does ignore versions that are newer but not released or that are released 

but not visible to the user. 

 

 Delete:  

Deletes a transmittal that is not locked or has not been sent yet. See chapter 

"Delete a transmittal". 

 Lock before sending / Unlock before sending:  

A transmittal can only be sent if it is locked. If you want to modify a locked 

transmittal before sending you can unlock it again.  

See chapter "Functions to lock/unlock a transmittal". 
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 Send:  

To send a transmittal, you have to select the sending method: Via e-mail, via 

report or as data transfer to PROOM.  

See the following chapters "How to send a transmittal" and "Via transmittal: Data 

exchange from PRO.FILE to PROOM". 

 Select linked documents:  

If there are many documents linked to a transmittal, you can use this function to 

start a search that only relates to documents linked to this transmittal.  

The displayed search form is the usual search form but the result is limited to 

documents linked to the selected transmittal. 

 Copy:  

With this function, a transmittal is "copied" in order to link it to a project. See 

chapter "Link between transmittals, documents and projects". 

 Create link:  

This function is used to link "memorized" documents to the transmittal. See chapter 

"Step 2: Link documents to be transferred to the transmittal". 

 Show message:  

If a message has been entered during the sending of the transmittal, this message 

can be viewed with this function at a later time. If no message has been entered or 

the transmittal has not yet been sent, no message can be displayed and an error 

message is shown instead. 

 Lock/Unlock:  

This function locks the transmittal so that it cannot be modified by other users. The 

procedure is identical to the locking of other PRO.FILE objects. The lock can be 

removed by using the same function again.  

For more information see the chapter "Locking and unlocking of PRO.FILE 

objects". 

 

12.4 Link between transmittals, documents and projects  

In order to work with transmittals within the PRO.FILE structures there are two 

possibilities for linking: 

Link a document to a transmittal: 

PRO.FILE offers "Create link" and "Delete Link" commands for maintaining the structure 

of transmittals.  

 "Link" results in the insertion of a document or CAD file that has been previously 

copied to the PRO.FILE Clipboard. You may remove documents or CAD files from 

the transmittal as long as the transmittal is not locked or has not been sent  

 Once the transmittal has been sent, it can no longer be modified. Already 

distributed transmittals are write-protected.   

A detailed error message will inform you about the error.  

To directly link a document from the PRO.FILE document list to a transmittal see the 

previous chapter "Step 2: Link documents to be transferred to the transmittal". 
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Link a transmittal to a project: 

You can "Copy" one or several transmittals and "link" them to one or several projects: 

1. Start a search for the transmittal to be linked via "Search" => "Transmittal". If the 

transmittal is displayed in list view, please select it. (If it is displayed in form view, it 

is already selected). 

2. Open the context menu for the selected transmittal (right mouse button) and select 

the function "Copy". 

3. Now select the project, the memorized transmittals has to be linked to. If the project 

is displayed in list view, please select it. (If it is displayed in form view, it is already 

selected). 

4. Open the context menu for the selected project (right mouse button) and select the 

function "Create Link". 

 The transmittal is linked to the project.  

 The link is shown in the "Browser"-tab for the project as well as in the "Where used"-

tab of the transmittal. 

 

 

Note:  

Transmittals can only be linked to projects. 

 

12.5 Delete a transmittal 

You may delete a transmittal that has not been sent from the database using the 

function "Delete" from the "Edit" menu. 

 

Once sent, you will no longer be permitted to delete a transmittal. 

 

12.6 Functions to lock/unlock a transmittal 

 The function "Lock before sending" protects transmittals from access and 

modification and makes them ready for sending. Only locked transmittals can be 

sent. 

 The function "Unlock before sending" is used to make a locked transmittal available 

again for changes or attaching further documents. 

 "Unlock before sending" is only available until the transmittal has been sent. It is 

then no longer possible to unlock it. 

Proceed as 

follows 
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12.7 How to send a transmittal 

By sending a transmittal, the transmittal is stored and can no longer be modified nor 

deleted. In this way, a transmittal protocols the status of the attached documents beyond 

doubt. 

No usage data is sent with a transmittal. A transmittal only contains references to the 

meta data. 

A transmittal has to be locked before sending. It is not possible to send an unlocked 

transmittal. 

 

After locking, the transmittal can be sent using the function "Send" from the "Edit" menu. 

If you use the function, you can then enter the internal recipients (PRO.FILE users) or 

external users (e-mail addresses). You can also add a message text. 

 

If the screen is confirmed with <OK>, the transmittal is sent. 

From this moment, the transmittal is marked with a sending date. The transmittal can no 

longer be changed. 

 

12.7.1 Using the report interface (option) for transmittals 

Via the report icon in the browser display, the title sheet of the transmittal can be 

displayed. It is also possible via this icon to display the sent files and protocols of the 

sending process. This function is not available in the PRO.FILE standard but has to be 

configured customer-specifically. 

 

12.8 Via transmittal: Data exchange from PRO.FILE to PROOM 

Starting with PRO.FILE 8.3 Servicepack 7, PRO.FILE contains functions for the exchange 

of files between pf and PROOM. It is thus possible to publish files from PRO.FILE directly 

in a project space in PROOM. After the selection of the documents to be transferred, 
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these are linked to a transmittal. This transmittal is sent to a publication place in 

PROOM, and the linked files are uploaded there. 

See the following chapters: 

 Step by step: Data from PRO.FILE to PROOM 

 Dependent tab: Information on the sending 

 Manage PROOM access 

 

 

Note: What is PROOM? 

PROOM is the web-based portal with virtual project spaces for easy uploads and 

downloads of files of several gigabytes in size.  

PROOM is the Microsoft Cloud Service Partner Excellence Award winning solution of 

2011 and uses Microsoft's cloud solution Windows Azure, so that companies can 

exchange XXL files quickly and easily.  

PROOM offers: 

 Work in the team! – Concentrated collaboration directly in the virtual project 

space 

 Simple exchange of large files via mouse click 

 High data security 

 Individual access permission concepts 

 Access anywhere anytime 

 Integrated activity log 

 Significant time saving 

 Simple to use 

 Adjustable to corporate design 

PROOM is suited for all business and private customers who want to 

 exchange large files quickly and easily, 

 access their files securely from anywhere, 

 keep an overview of who has uploaded which files, but also who has downloaded 

them and when. 

For detailed information see www.proom.de  

 

  

http://www.proom.de/
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12.8.1 Step by step: Data from PRO.FILE to PROOM 

 Four steps are required to upload files saved in PRO.FILE into a project space in 

PROOM. Just follow the instructions in the following sub-chapters: 

 Step 1: Creating a transmittal 

 Step 2: Link documents to be transfered to the transmittal 

 Step 3: Lock transmittal and send to PROOM 

 Step 4: The "Publish" dialog 

 

12.8.2 Step 1: Creating a transmittal 

Data is transferred from PRO.FILE to PROOM via transmittals. This means that a 

transmittal has to be created in the first step for the transfer. 

If you already have a transmittal that you want to use for the transfer, you can skip this 

first step and continue with "Step 2: Link documents to be transfered to the transmittal". 

 

 

Function call: Create a transmittal 

"PRO.FILE" => "Start" => "New transmittal" 

 

1. Create a new transmittal, e.g. via the functions 

2. "Cockpit" => Icon "Create Transmittal" 

3. Menu: "Start" => "New transmittal" 

4. Enter the required 

information for the 

description of the new 

transmittal. 

5. Confirm with 

<Finish>. 

 

 The transmittal has been created. 

 

Proceed as 

follows 
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12.8.3 Step 2: Link documents to be transfered to the transmittal 

The document is transfered from PRO.FILE to PROOM via transmittal. The document 

therefore has to be linked to the created transmittal.  

1. Start a search for the document to be transferred to PROOM via "Search" => 

"Documents". 

2. If the 

document is 

displayed in 

list view, 

please select 

it.  

(If it is 

displayed in 

form view, it is 

already 

selected). 

 

 

 

Note: Transfer of several documents – select several documents 

Of course you can transfer several files at the same time from PRO.FILE to PROOM. 

To do so, select all the documents you want to transfer. The files from all selected 

document descriptions are then copied to PROOM. 

 

Select the transmittal for transfer:  

3. Open the context 

menu for the 

selected document 

(right mouse 

button) and select 

the function 

"Transmittal". 

4. All transmittals to 

which documents 

can be linked are 

now listed in the 

sub-menu. 

 

 

 

Note: Only non-locked transmittals can be selected 

For the linking, you can only select transmittals that have not yet been sent or locked 

for sending.  

 

Proceed as 

follows  
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5. Confirm the 

security question, 

whether the 

document is to be 

linked to the 

transmittal with 

<Yes>. 

 

 

6. The document is 

now linked to the 

transmittal. The 

link is visible in 

the structure view 

of the transmittal 

and in the "Where 

used" list of the 

document. 

 

7. If you want to add more documents, repeat this process. 

 

12.8.4 Step 3: Lock transmittal and send to PROOM 

You can now start the transfer of the selected files into a desired PROOM project space.  

1. Select the transmittal to be transferred to PROOM. 

2. Select the 

function "Lock 

before sending" 

from the "Edit" or 

context menu. 

3. The transmittal is 

now locked and 

ready for sending. 

 

 

Proceed as 

follows 
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4. Select the function "Send" => "PROOM" 

from the "Edit" or context menu. 

 

5. The publication dialog is displayed, as described in the following "Step 4: The 

"Publish" dialog". 

 

12.8.5 Step 4: The "Publish" dialog 

You now have to specify which publication place in PROOM is to be selected with which 

publication and transmittal options for transfer.  

For this purpose, the publication dialog is displayed.  

1. Select the 

PROOM folder, 

into which you 

want to transfer 

the data.  

You can select 

project spaces 

and folders. 

2. Select the 

transmittal type. 

3. Select the desired 

options, as 

described below.  

4. Confirm the transfer with the <Publish> button. 

 

The files listed in the publication dialog are now uploaded into the selected PROOM 

folder. The transfer is then finished. 

 

  

Proceed as 

follows 
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Options and selection possibilities in the publication dialog 

The following settings can be made in the publication dialog: 

1. PROOM folder:   

Via the selection list of this field, you 

specify the folder/project space in 

which the files are to be published.

   

PROOM accesses have the icon , 

project spaces have the icon , 

folders have the icon . 

 

2. Manage accesses:  
If required, you can configure multiple accesses to different PROOM project 

spaces. This is done via the button <Manage accesses> and is described in the 

following chapter "Manage PROOM access".  

 

3. Comment field :  
With this field you can transfer 

information into the comment field 

of PROOM.  

You can select the document type, a 

field from the document description 

and the document date. 

 

 

 The result of your selection can be seen in the file list in the column "Description". 

4. Delete date:  

The deletion date specifies the date at which the transferred files are automatically 

deleted in PROOM. If no date is specified, the files are not deleted.  

 

5. Validity time interval:  

The time specified via the fields "Validity time interval" and "to" specify, from when 

and until when the PROOM users are allowed to see the files. At all other times, 

the files are invisible for the users – except the project space managed, who can 

always see them. 

 

After the expiry of this time, the files are not deleted but only become invisible.  

 

If the field "to" is not filled, the files are permanently visible.  

 

The time specified in "from" can be in the future. Example: With the validity range 

from 12/28/2019 to 01/03/2020 you can make the files visible only during the 

change to the next decade. The files are then visible from 12/28/2019 0.00 a.m. 

to 01/03/2020 11.59 p.m.  

 

  



Operation PRO.FILE advanced Dependent tab: Information on the sending 

PRO.FILE Release 8.7 
June 2017 Page 228 of 241 

6. Reference type:  

Select via the radio button, whether the transmittal is a referential or informal 

transmittal. 

In the standard, "referential" must be selected.  

Detailed information on the transmittal type can be found in the previous chapter 

"Informal or referencing: What types of transmittal do exist?".  

 

7. Document type (ZIP):  

This selection is only possible for informal transmittals. For informal transmittals, 

the status of the transferred files is frozen in a ZIP file and archived in PRO.FILE. 

The document type to be assigned to this ZIP file can be specified with this 

selection.   

 

12.9 Dependent tab: Information on the sending 

For each transmittal via which files are transferred into a PROOM project space, 

information on the transfer can be viewed in the dependent tabs "PRROM document 

data" and "PROOM data":  

"PROOM document data" 

This tab displays the following 

information: 

1. The "description" as it is 

entered during the sending of 

the transmittal in the 

publication dialog. 

2. The "Start date of the 

transmission" at which the 

upload of the file to the 

PROOM project space was 

started. 

3. The "End date of the 

transmission" at which the 

upload of the file to the 

PROOM project sauce was 

finished.  
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"PROOM Data" 

This tab displays the transfer 

information entered in the 

publication dialog upon the upload 

if the file to PROOM: 

1. Into which "PROOM folder" 
has the file been uploaded? 

2. Was the "Document type" 

indicated in the comment field 

for the description? 

3. Which "Document field" from 

the document description was 

used in the comment field for 

the description of the transfer? 

4. Was the "Document date" used 

in the comment field for the 

description? 

5. Was a "Delete date" assigned, 

at which the transferred files 

are to be deleted in PROOM? 

6. "Valid from": From which date 

on are the files visible in 

PROOM? 

 

7. "Valid to": Until which date are the files in PROOM displayed? (After expiry of this 

date, the files become invisible and can only be accessed by the project space 

manager. 

8. Which "Transmittal type" was used (informal or referential)?  

 

9. If the transmittal type is "Informal" the transferred files are archived as ZIP file in 

PRO.FILE. Under which "Document type (ZIP)" is this file archived? 

10. Which "Status" does the transmittal have? 

11. At which "Start date of job" has the upload of the files to PROOM been started? 

12. At which "End date of job" has the upload of the files to PROOM been successfully 

been finished? (For very large files, the start and end date may be different. The 

end date always shows the successful finish of the order). 
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12.10 Manage PROOM access 

In the publication dialog for the upload of files from PRO.FILE to PROOM project 

spaces you can manage your PROOM access.  

This can be done via the button <Manage access>. 

 

 

A click on the button opens 

the windows for the access 

management. 

To configure a new PROOM 

access, Proceed as follows 

 

 

1. Select the desired PROOM access in the field "Name of access". 

 

 

Note: 

Direct accesses to PROOM can only be created by the administrator in the PRO.FILE 

database. 

 

2. By selecting the access, the field "URL" is filled automatically. 

3. Enter your login name for the selected PROOM access in the field "Login name". 

4. Verify your login by entering your "Password" in the field of the same name. 

5. Via the button <Test> you can check whether the access data has been entered 

correctly and access is thus possible. 

6. Confirm your entries via the button <Transfer to list>. 

7. If the new access is displayed in the "List of accesses", you can use it in the future for 

data transfers. 

8. Finish your access management changes with the button <Save>. 
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Changing an existing PROOM access 

1. To modify one of your existing 

PROOM accesses select it in the "List 
of your accesses". 

2. Click on the <Modify> button. 

3. Change the access name, login 

name or password – as required. 

4. Confirm your entries via the button 

<Save>. 

 

 

Deleting an existing PROOM access 

1. To delete on of your existing PROOM accesses select it in the "List of accesses". 

2. Click on the button <Remove>. 

3. The access is permanently deleted and removed from the list of accesses. 

 

 

Attention: 

A deleted access cannot be restored. If you have deleted an access by accident, you 

have to create it anew. 
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13 Optional: The PROOM Integration in PRO.FILE 

 

Note: Licenses for PROOM required 

To use the PROOM integration in PRO.FILE, you need a PROOM Enterprise License. 

 

PROOM is a Cloud solution for the document exchange in technical comoanies – it is 

used for the simple and secure exchange of files with partners, cusomters and suppliers. 

PROOM uses modern, cloud-based project rooms with permission and access control. 

See the chapters: 

 Settings for the PROOM access 

 Upload documents from PRO.FILE to 

PROOM 

 Create PROOM folder during file 

upload 

 Download files from PROOM to 

PRO.FILE 

 Start the PROOM Web UI 

 

 

13.1 Settings for the PROOM access 

A user can have access to different PROOM project rooms. In order for the data 

exchange via the PROOM integration in PRO.FILE to be accessible, the access to these 

project rooms has to be configured in a first step via the login data of the user. 

See the following chapters: 

 Initial settings for the PROOM access 

 Change the settings for the PROOM access 

 

13.1.1 Initial settings for the PROOM access 

To use the PROOM integration in PRO.FILE, the access to the project rooms you are 

authorized for has to be configured. 

 

Function call: 

"Tab "PROOM" => "Area PROOM" => Function "Settings" 
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1. Select the function "Settings" from the "PROOM" tab. 

 

2. Enter your login data for PROOM in the following dialog.  

 

 

 Access: 
From the dropdown list, select the PROOM access you want to use. 

 

 

Note 

The available access options are provided by your PRO.FILE administrator in the 

PRO.FILE Management Console. 

 

 URL: 
The URL of the the selected PROOM access is entered automatically. 

 Login name: 
User name (e-mail address) for the login to the selected PROOM project room. 

 Password: 
The password for the login to the selected PROOM project room. 

 

3. Click on the button <Test> to check whether your access data is correct. 

 If the access data is correct proceed with the next step. 

4. Click on <Transfer to list> 

 The selected access is shown in the list of configured accesses. 

 

Proceed as 

follows 
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 To add an additional access to a PROOM project room repeat the above steps. 

 Access to a PROOM project room is now configured. 

 

For the adjustment of the access data, see the following chapter "Change the settings 

for the PROOM access". 

 

13.1.2 Change the settings for the PROOM access 

The exchange of data between PRO.FILE and PROOM via the PROOM integration is 

made based on the configured accesses to the user's PROOM project rooms. 

 

1. Select the function "Settings" from the "PROOM" tab. 

 

 

2. Select the access entry to be changed from the "List of your accesses".  

3. Click on the button <Modify>. 

 The access data is now displayed in the left-hand area of the window. 

4. Make the desired adjustments to the specified information. 

5. Confirm you changes via the button <Transfer to list >. 

 

The changing of your access settings is thus completed. 

 

13.2 Upload documents from PRO.FILE to PROOM 

Documents from PRO.FILE can be transferred to PROOM for the secure exchange with 

business partners, customers and suppliers within a PROOM project room. 

The user can upload one or more unstructured documents from PRO.FILE to a PROOM 

project room. The user needs the corresponding permissions for this in PROOM. 

 

 

Function call: 

"Tab "PROOM" => "Area PROOM" => "Uplaod" 

 

For the upload of documents from PRO.FILE to a PROOM project room Proceed as 

follows 

To change these 

settings Proceed 

as follows 
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1. Select the document you want to upload to PROOM from a list in PRO.FILE. 

2. Select the function "Upload" from the "PROOM" tab. 

 

3. In the following list, 

select the target folder 

within the project 

room in PROOM. 

4. Confirm you selection 

with <Upload>. 

 

 The upload of the files from PRO.FILE to PROOM is started. 

 The dialog window remains open until all files are transferred. 

 

13.3 Create PROOM folder during file upload 

You can create a new folder immediately when uploading files to PROOM. 

1. Opemn the selection window for the transfer of files. 

2. Click on the folder you want to create a sub-folder for. 

3. Click on the button <Create PROOM folder>. 

4. Enter a name for the PROOM folder. There must not be any other folder of the 

same name. 

5. Click <OK>. 

 A new folder is created in PROOM. 

6. By double-clicking the new folder, the folder is selected as target location for the 

files to be uploaded. 

 

  

Proceed as 

follows 
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13.4 Download files from PROOM to PRO.FILE 

Via the PROOM integration in PRO.FILE the user can select several documents in a 

PROOM project room and transfer them to PRO.FILE. 

 

 

Function call:: 

Tab "PROOM" => "Area PROOM" => Function "Download" 

 

1. Select the function "Download" from the "PROOM" tab. 

 

2. Select the 

desired 

PROOM 

project room. 

3. Select the files 

in PROOM to 

be saved to 

PRO.FILE. 

 

4. Click on <Download>. 

 For each selected file, the PRO.FILE Checkin wizard for the creation of a new 

document description is started. 

 

13.5 Start the PROOM Web UI 

The Web UI of the configured PROOM project rooms can be accessed directly from 

PRO.FILE. 

 

 

Function call: 

Tab "PROOM" => "Area PROOM" => Function "PROOM" 

 

1. Select the function "PROOM" from the "PROOM" tab 

 

 

Proceed as 

follows 

Proceed as 

follows 
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2. If access is configured for several PROOM project rooms, you can select the 

desired project room and confirm your selection with <OK>.  

 The PROOM Web UI is displayed in your web browser. 
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14 Annex: Update of the PRO.FILE WindowsClients 

PRO.FILE update via AutoUpdate 

The PRO.FILE installation is often updated while operations in PRO.FILE are still being 

carried out by some users. 

For various reasons, it may happen that, despite silent deployment, some client 

computers cannot be updated. For such situations you can configure the AutoUpdate 

for PRO.FILE users. In this case, the user gets the opportunity to trigger a PRO.FILE 

update via the corresponding button: 

 

1. In the window above, click on the button <Update>. 

2. The program ProfileUpdate.exe is started and PRO.FILE is closed to perform the 

update. 

3. The PRO.FILE update program shows a message that all running programs should 

be closed. 

4. The update script is started. 

5. When the update is completed, the program shows a message that the computer 

should be restarted.  

The update of the PRO.FILE Windows Client is thus completed.  

 

 

Note: Permissions 

For the running of the update script the user need administrator permissions. For this 

reason, PRO.FILE checks whether the user has this permission. If the user does not 

have the required permissions, the button <Update> is not displayed. In this case, 

please contact your administrator. 

 

 

For the update of 

your PRO.FILE 

Windows Client 

installation 

proceed as 

follows 
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